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Contact Us!

Oracle8/ Personal Edition Administrator’s Guide, Release 2 (8.1.6) for Windows 98
Part No. A85313-01

This document describes how to contact Oracle Corporation if you have issues with the
documentation or software. It also provides a list of useful resources for Oracle partners and
developers.

Read the section... If you...

"How to Contact Oracle Technical Publications" on page xii Have issues with Documentation

"How to Contact Oracle Support Services" on page Xiii Have issues with Software

"Resources for Oracle Partners and Developers" on page xvii Want to join an Oracle partner or application

developer program

Xi



How to Contact Oracle Technical Publications

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this
publication. Your input is an important part of the information used for revision.

« Didyou find any errors?

« Isthe information clearly presented?

« Do you need more information? If so, where?

« Are the examples correct? Do you need more examples?

«  What features did you like most about this guide?

« Do you have suggestions for improvement? Please indicate the chapter, section, and page
number (if available).

You can send comments regarding documentation by sending an email to win98doc@in.oracle.com.

You can send your feedback about the products included in your CD and the features you would like
to have for the database, Oracle8i Navigator or other products to win98pe@in.oracle.com.

If you would like a reply, please provide your name, address, email-id and telephone number.
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How to Contact Oracle Support Services

Please copy this form and distribute within your organization as necessary.

Oracle Support Services can be reached at the following telephone numbers and Web sites. The hours
of business are detailed in your support contract and the Oracle Customer Support Guide in your kit.

Oracle Support
Services In... Call...

United States of + (650) 506-1500 for customers with support contracts.

America + (650) 506-5577 to obtain a support contract.

Europe +44 1344 860 160 or the local support center in your country.

All other The telephone number for your country listed at the following Web site:
locations

http://wwmv. oracl e. com support/contact _us/sup_hot _
phone. ht m

Oracle Support Services telephone numbers are also listed in the Oracle
Customer Support Guide in your kit.

Please complete the following checklist before you call. If you have this information ready, your call
can be processed much quicker.

O Your CPU Support Identification Number (CSI Number) if applicable.

O The hardware name on which your application is running.

xii



O The operating system name and release number on which your application is
running.

O The release numbers of the Oracle Server and associated products involved in
the current problem. For example, Oracle8i Personal Edition release 8.1.6.0.0

« To verify the release number of the Oracle Server, connect to the database
using a tool such as SQL*Plus. The release number is displayed. For
example:

Qonnected to:

Qacl e8i Personal Edition Release 8.1.6.0.0 - Production
Wth the Java option

PL/SQ Release 8.1.6.0.0 - Production

O The third-party software version you are using.

« To verify an application version, from the application’s Help menu, select
About...
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O The exact error codes and messages. Please write these down as they occur.
They are critical in helping Oracle Support Services to quickly resolve your
problem. Note whether there were no errors reported.

O A description of the issue, including:

«  What happened? For example, the command used and its result.

« When did it happen? For example, during peak system load, or after a
certain command, or after an operating system upgrade. In addition, what
was happening when the problem occurred?

«  Where did it happen? For example, on a particular system, or within a
certain procedure or table.

XV
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What is the extent of the problem? For example, production system
unavailable, or moderate impact but increasing with time, or minimal
impact and stable.

Has anything changed? For example, if this is an operation that used to
work and now fails, what is different? Can you undo any recent changes, to
verify whether they are relevant to the issue?

Can the problem be reproduced? This is a critical question for support
analysts. For example, did the problem recur on the same system, under the
same circumstances? Can the problem be reproduced on another system?

If you are able to restart the server or database, does restarting the database
or rebooting the server or client machine (if applicable) make a difference?




O Keep copies of the Oracle alert log, any trace files, core dumps, and redo log
files recorded at or near the time of the incident. Oracle Support Services may
need these to further investigate your problem.

To help analyze problems:

« Archive or delete old alert logs. When the database is started without an
alert log, a new one is created. In some cases, if you force the problem to
recur with a new alert log, the timestamps for the recorded events may
indicate which events are relevant.

« Archive or delete old trace files. To check whether the file was modified,
right-click and select Properties. The Properties dialog box displays the
modification date.

Resources for Oracle Partners and Developers

This section provides information on partner programs and resources for Oracle database
administrators and application developers.

Information Source Description

Oracle Corporation Home Page This Web site is the starting point for general information on

http://ww. oracl e. com Oracle Corporation.

Alliance Online Oracle provides leading-edge technology, education, and
technical support that enables you to effectively integrate
Oracle into your business. By joining the Oracle Partner
Program, you demonstrate to customers that you are
committed to delivering innovative Oracle-based solutions
and services.

http://alliance.oracle.com

The greater your commitment to Oracle, the more we can
help you grow your business. It’s that simple. The value you
derive is associated directly with your level of commitment.
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Information Source

Description

Oracle Education

http://education. oracl e. com

Customers come to Oracle Education with a variety of
needs. You may require a complete curriculum based on
your job role to enable you to implement new technology.
Or you may seek an understanding of technology related to
your key area of responsibility to help you meet technical
challenges. You may be looking for self-paced training that
can be used as an ongoing resource for reference and
hands-on practice. Or, you may be interested in an overview
of a new product upgrade. Whatever your training need,
Oracle Education has the solution.

Oracle Technology Network
http://technet. oracle.conl

The Oracle Technology Network is your definitive source
for Oracle technical information for developing for the
Internet platform. You will be part of an online community
with access to free software, Oracle Technology
Network-sponsored Internet developer conferences, and
discussion groups on up-to-date Oracle technology.
Membership is free.

Oracle Store

http://oracl estore. oracl e. com

This is Oracle’s online shopping center. Come to this site to
find special deals on Oracle software, documentation,
publications, computer-based training products, and much
more.

Oracle Support Services’ Support Web Center

http://ww. oracl e. conl support/

Oracle Support Services offers a range of programs so you
can select the support services you need and access them in
the way you prefer: by telephone, electronically, or face to
face. These award-winning programs help you maintain
your investment in Oracle technology and expertise.

Here are some of the resources available in the Support Web
Center:

OracleMetaLink

http://ww. oracl e. com support/
el ec_sup/index. htm

OracleMetaLink is Oracle Support Services' premier Web
support service. It is available to Oraclemetals customers
(Gold, Silver, Bronze), 24 hours a day, seven days a
week.

OracleLifecycle

http://wwv. oracl e. com support/
sup_serv/lifecycl e/index. htnl

OracleLifecycle is designed to deliver customized,
industry-focused, full life-cycle support solutions that
enable industry leaders to use Oracle technology to
make smart business decisions, achieve operational
excellence, and succeed in their markets.
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Information Source

Description

ExpertONLINE

http://ww. oracl e. com support/
sup_serv/online/index. htm

Oracle Support Services has launched a new line of
services called ExpertONLINE. These services provide
online database administration for companies looking
to supplement their existing DBA staff or fill a DBA
role. Services range from ExpertDETECT, a monitoring,
diagnostic, and recommendation service, to ExpertDBA,
a full online database administration service.

Virtual Support Analyst (VSA)

http://ww. oracl e. conl support/
sup_serv/vsa_start. htn

VSA is Oracle’s Internet e-mail service; it is available to
U.S. customers with an Oraclemetals support agreement.
With VSA, you can initiate a request for assistance
through e-mail, bypassing the queues you may
encounter when using telephone support. VSA also
enables you to access Oracle’s bug database.

Customer Service

http://wwv. oracl e. com support/
cus_serv/index. htm

This site provides resources to make your interactions
with Oracle as easy as possible. Among the things you
can do are:

Learn what is a CPU Support Identification (CSI)
number

Update your technical contact information

Find out whom to contact for invoice and collection
issues

Request product update shipments
Access a glossary of Oracle Support Services terms

U.S. Customer Visit Program

http://ww. oracl e. com support/
cus_serv/cus_visit.htm

This U.S.-based program has been established to help
our customers understand and obtain maximum benefit
from the support services they have purchased.

The visit typically offers a customized orientation
presentation, a comprehensive overview and
demonstration of Oracle’s electronic services, and
helpful tips on working more effectively with Oracle
Support Services.

Support Web Center Library

http://ww. oracl e. conf support/
I'i brary/index. htm

This site contains articles, guides, and other
documentation to help you leverage the wealth of
knowledge and reference material that Oracle Support
Services produces.
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Before You Begin

This guide is your primary source of introductory, post-installation, configuration,
and administration information for Oracle8i Personal Edition.

Specific topics discussed are:

« Prerequisites

« Intended Audience

« How This Guide Is Organized

= Documentation and Code Conventions

XXi



Prerequisites
This guide assumes that you are familiar with the following:
«  Windows 98, and have installed and tested it on your computer system

«  Object-relational database management concepts

Additional Information: If you are not familiar with
object-relational database management concepts, see Oracle8i
Concepts.

Intended Audience

This guide is necessary for anyone installing, configuring, or administering Oracle8i
Personal Edition for Windows 98.

Note: This guide describes only the features of Oracle8i Personal
Edition that apply to the Windows 98 operating system.

How This Guide Is Organized

This guide is organized as follows:

Chapter 1, "Oracle8i Differences among Windows 98, Windows NT and UNIX"

Provides a list of differences between Oracle8i on Windows 98, Windows NT
and on UNIX.

Chapter 2, "Database Tools Overview"

Provides a list of preferred and optional tools you can use to perform common
database administration tasks..
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Chapter 3, "Multiple Oracle Homes and Optimal Flexible Architecture™

Describes how to use multiple Oracle homes and an Optimal Flexible
Architecture (OFA) configuration for placement of database files. Read this
chapter before installing Oracle8i Personal Edition for Windows 98.

Chapter 4, "Installing, Migrating, and Upgrading Databases"

Describes what to do if you have existing databases on your system and want to
install the latest release of Oracle8i Personal Edition.

Chapter 5, "Post-Installation Configuration Tasks"
Describes or references the configuration tasks you may need to perform before
using such products as Oracle8i Navigator.

Chapter 6, "Post-Installation Database Creation"

Describes how to create a database after installation with either the Oracle
Database Configuration Assistant or the BUILD_DB.SQL script.

Chapter 7, "Administering a Database"
Describes how to administer a database.

Chapter 8, "Monitoring a Database"
Describes how to monitor the Oracle8i Personal Edition database.

Chapter 9, "Backing Up and Recovering Database Files"

Provides recommendations and procedures for backing up and recovering
database files.

Chapter 10, "Developing Applications™
Describes Windows 98-specific issues for application developers.

Appendix A, "Directory Structures"

Describes the default directory structures created when you install Oracle
components.

Appendix B, "Oracle8i Database Specifications for Windows 98"

Describes Oracle8i database initialization parameters, how to edit them, and
parameters without Windows 98-specific values. This appendix also explains
how to calculate database limits.
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XXV

Appendix C, "Oracle8i Configuration Parameters and the Registry"

Describes the use of the registry for various Oracle components. In addition,
this chapter lists the recommended values and ranges for configuration
parameters.

Appendix D, "Net8 Configuration"
Describes configuration for the Windows 98 platform.

Appendix E, "Error Messages"

Lists the error messages, causes, and corrective actions that are specific to the
operation of Oracle8i Personal Edition for Windows 98.

Glossary
Provides brief descriptions of terms used throughout this guide.



Documentation and Code Conventions

The following conventions are used in this guide:

Convention

Example

Meaning

All uppercase plain

C:\ORACLE\ORAS81

Indicates command names, SQL reserved
words, and keywords, as in ALTER
DATABASE. All uppercase plain is also
used for directory names and file names.

Italic

. Used to indicate a variable:
file name
«  Used to indicate the title of a guide.

Indicates a value that you must provide.
For example, if a command asks you to
type file name, you must type the actual
name of the file.

Square brackets [ ]

XA\[PATHNAME]\ORACLE\
HOME_NAME

Encloses optional items. For example,
when you create an OFA-compliant
Oracle home directory, you can place an
optional pathname before the \ORACLE
pathname.

Square brackets also indicate a function
key, for example [Enter].

Choose Start >

Choose Start > Programs > Oracle -
HOME_NAME > Network Administration
> Net8 Assistant

How to start a program. For example, to
start Net8 Assistant, you must click the
Start button on the taskbar and then
choose Programs, Oracle - HOME_NAME
> Network Administration > Net8
Assistant.

C\>

C:\ORACLE\ORADATA>

Represents the Windows 98 command
prompt of the current hard disk drive.
Your prompt reflects the subdirectory in
which you are working. Referred to as the
MS-DOS command prompt in this guide.

Backslash (\) before a
directory name

\ORADATA

Indicates that the directory is a
subdirectory of the root directory.

XXV



Convention

Example

Meaning

ORACLE_HOME and  Go to the ORACLE_BASE\ORACLE _

ORACLE_BASE

HOME\RDBMS\ADMIN directory

In previous releases when you installed
Oracle8 Personal Edition, all
subdirectories were located under a top
level ORACLE_HOME directory, that by
default was:

C. \ ORAW N95 for Windows 95/98

or whatever you may have called your
Oracle home.

In this Optimal Flexible Architecture
(OFA)-compliant release, all
subdirectories are no longer under a top
level ORACLE_HOVE directory. There is
now a new top-level directory called
ORACLE BASE that by default is

C. \ ORACLE. If you install Oracle8i
Personal Edition release 8.1.6 on a clean
computer (that is, there is no other Oracle
software on the computer), the default
settings for the first Oracle home
directory is C:\ORACLE\ORAG&L. If you
run Oracle Universal Installer again and
install release 8.2.x, the second Oracle
home directory is called \ ORA82. These
Oracle home directories are located
directly under ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

See Chapter 4, "Multiple Oracle Homes
and Optimal Flexible Architecture" for
additional information on OFA
compliances and for information on
installing Oracle products in non-OFA
compliant directories.

%ORACLE_HOME%

SQL> @%ORACLE_
HOME%\ADMIN\DB_
NAMENADHOC\CATALOG.SQL

In SQL*Plus commands, you may see
%ORACLE_HOME%. SQL*Plus is able to
locate your Oracle Home directory using
the %ORACLE_HOME% variable. This
convention can be used in Server
Manager, SQL*Plus, Export Utility, and
Import Utility.
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Convention Example Meaning

HOME_NAME OracleHOME_NAMETNSL.istener Represents the Oracle home name.

The home name can be up to sixteen
alphanumeric characters. The only special
character allowed in the home name is the
underscore.

HOMEID HOMEO, HOME1, HOME?2 Represents a unique registry subkey for
each Oracle home directory in which you
install products. A new HOMEID is
created and incremented each time you
install products to a different Oracle home
directory on one computer. Each
HOMEID contains its own configuration
parameter settings for installed Oracle
products.

Symbols period . Symbols other than brackets and vertical

comma bars must be entered in commands
' exactly as shown.

hyphen -

semicolon ;

colon :

equal sign =

backslash \

single quote ’

double quote

parentheses ()
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1

Oracle8/ Differences among Windows 98,
Windows NT and UNIX

The following table lists the major differences among Oracle8i Personal Edition for
Windows 98, Oracle8i on Windows NT and on UNIX. For Oracle database
administrators moving from a UNIX platform to Windows 98/NT, this information
may be helpful in understanding the Windows 98/NT features that are relevant to
Oracle.
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Feature On UNIX...

On Windows 98/NT...

Services/Database instance UNIX daemons are similar to

See: Chapter 7, "Administering a services on Windows NT.

Database"

On Windows 98:

There is no service available on
Windows 98. Multiple instances of
Oracle databases can be run using
OSTART. See Chapter 7, on how to use
OSTART.

On Windows NT:

Oracle registers a database instance as a
service (OracleServiceSID).

To connect to and use an Oracle
instance, an Oracle service is created
during the database creation process
and associated with the Oracle database.
Once a service is created with the Oracle
database, the service can run even while
no user is logged on. This feature
enables server security while running
the Oracle database.

To Access Services:

By default, services run under the
SYSTEM account.

1. Choose Start > Settings > Control
Panel > Services to access the
Services dialog box.

OracleServiceSID and other Oracle
services appear here.
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Feature On UNIX... On Windows 98/NT...

Processes and Threads Each Oracle background process  All Oracle background, dedicated
exists as a separate process, for server, and client processes are threads
example, ora_dbw0_V816. of the master ORACLE process.

All the threads of the ORACLE process
share resources on Windows 98/NT.
This multithreaded architecture is
highly efficient, allowing fast context
switches with low overhead.

To View Processes on Windows 98:

You can use PVIEWER.EXE (Process
Viewer of Microsoft C++ Developer
Studio) to view processes and threads.

To View Processes on NT:

Use the Oracle Administration Assistant
for Windows NT to view processes or
kill individual threads.

1. Choose Start > Programs > Oracle -
HOME_NAME > Database
Administration > Oracle
Administration Assistant for
Windows NT.

2. Right-click the SID, for example
V816, and choose Process

Information.
File Sizes UNIX file system (UFS) or Oracle can be installed on FAT and
, o . j lled file system (JFS). NTFS! file systems. By default, Oracle

See: Appendix B, "Oracle8i journa L2 Ile systems. by ult,
Databaig Specifications for Maximum file size supported by runs under the SYSTEM account, which
Windows 98" most vendors is now 32 GB. does not have access to NTFS volumes,

The Oracle block sizes vary unless it is granted.

between 2-8K. The maximum file size for FAT is 4 GB;

for NTFS, 16 Exabytes (EB).

The Oracle block size is based on the
parameter DB_BLOCK_SIZE set in
init.ora file. The maximum number of
blocks per data file is 4 million on
Windows NT. The maximum number of
data files per database depends on block
size.

When calculating database limits, the
total maximum capacity of the database
remains the same regardless of the way
the bits are split up.
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Feature

On UNIX...

On Windows 98/NT...

Initialization Parameters:
Multiple Database Writers

See: Appendix B, "Oracle8i
Database Specifications for
Windows 98"

You can specify more than one
database writer process with the
initialization parameter
DB_WRITERS_PROCESSES.

Multiple database writers can
help, for example, when a UNIX
port does not support
asynchronous 1/0.

DB_WRITERS_PROCESSES, which
writes dirty buffers to disk, is not
supported. Windows 98/NT supplies its
own 1/0 slaves and uses them to see if
170 is complete.

Multiple DB_WRITERS_PROCESSES
might cause synchronization problems.

Direct Writes to Disk
See: Oracle8i Concepts

On all three platforms,
bypassing the file system buffer
cache ensures the data is written
to disk.

Oracle uses the O_SYNC flag to
bypass the file system buffer
cache. The flag name depends on
the UNIX port.

Oracle bypasses the file system buffer
cache completely.

Memory Resources
See: Oracle8i Concepts

The resources provided by the
default kernels are often
inadequate for a medium or large
Oracle database.

The maximum size of a shared
memory segment (SHMMAX) and
maximum number of semaphores
available (SEMMNS) may be too
low for Oracle recommendations.

Fewer resources are needed for
interprocess communication (IPC)
because the operating system is
thread-based and not process-based.
These resources, including shared
memory and semaphores, are not
adjustable by the user.

Install Accounts and Groups

See: Chapter 7, "Administering a
Database"

Uses the concept of a DBA group.
The root account cannot be used
to install Oracle. A separate Oracle

account must be created manually.

On Windows 98 any user can install
Oracle database, where as, on Windows
NT Oracle must be installed by a
Windows NT user name in the
Administrator’s group. The user name
is automatically added to the Windows
NT local group ORA_DBA, which
receives SYSDBA the privilege. This
allows the user to log into the database
with the INTERNAL account and not be
prompted for a password.

Password Files:

Password files are located in the
ORACLE_BASE\ORACLE_
HOME\DATABASE directory and are
named PWDSID.ORA, where SID
identifies the Oracle8i database instance.
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Feature On UNIX... On Windows 98/NT...

Dynamic Link Libraries (DLLs) Shared libraries are similar to the  Oracle DLLs form part of the executable
shared DLLs on Windows 98/NT. at run time, and, therefore, are smaller.
Object files and archive libraries DLLs can be shared between multiple
are linked to generate the Oracle  executables. Relinking by the user is not
executables. Relinking is supported, but executable images can be
necessary after certain operations, modified using the ORASTACK utility.
such as installation of a patch.

See: Oracle8i Concepts

Modifying Executable Images:

Modifying executable images on
Windows 98/NT reduces the chances of
running out of virtual memory when
using a large SGA or an SGA with
thousands of connections?. However,
Oracle Corporation recommends doing
this under the guidance of Oracle
Support Services.

Installation Many manual setup tasks You do not need to manually:
required on UNIX are not

required on Windows 98/NT. « setenvironment variables

See: Oracle8i Installation Guide for

Windows 98 « create a DBA group for database

administrators

= create a group for users running
Oracle Universal Installer

«  create an account dedicated to
installing and upgrading Oracle
components
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Feature On UNIX... On Windows 98/NT...
Multiple Oracle Homes and Multiple Oracle homes on ORACLE_HOME directories can be
OFA Windows NT is comparable to located under a single ORACLE_BASE

installation capabilities on UNIX.
Environment variables can be set
to specify Oracle homes.
ORACLE_BASE is associated with
a UNIX user’s environment.

Using multiple Oracle homes
and Optimal Flexible
Architecture (OFA) provides
many advantages when
administering large databases.
OFA is implemented on
Windows 98/NT and UNIX in
the same way. However,
differences exist with regard to ~ Symbolic links are supported.

the following: Although everything seems to be
in one directory on the same hard
drive, files can be on different
hard drives if they are
symbolically linked or have that
directory as a mount point.

Symbolic Links

«  The top-level names of the
OFA directory tree differ
between Windows 98/NT
and UNIX. However, the
main subdirectory and file
names are the same on both
operating systems.

« ORACLE_BASE directory.

=« No support for symbolic
links on Windows 98/NT.

See: Chapter 3, "Multiple Oracle
Homes and Optimal Flexible
Architecture”

directory. ORACLE_BASE is defined in
the registry (for example, in HKEY_
LOCAL_MACHINE
\SOFTWARE\ORACLE\HOMEQ). Do
not set ORACLE_HOME in the
environment (software run from another
Oracle home will not work reliably). In
fact, beginning in release 8.1.6, the
Oracle Universal Installer will reset it.

The goal of OFA is to place all Oracle
software under one ORACLE_BASE
directory and to spread the files across
different physical drives as your
databases increase in size. Oracle
Corporation recommends that you use
one logical drive to store your database
administration files and that you place
other files, as needed, on other logical
drives in an ORADATA\DB_NAME
directory.

For example, for a database named
PROD, there are four logical drives:

. C:\ contains an Oracle home and
the database administration files.

« F:\ contains the redo log files. (The
F:\ drive could also represent two
physical drives that have been

striped to increase performance.)?

«  G:\ contains one of the control files
and all of the tablespace files. (The
G:\ drive could also use a RAID
Level-5 configuration to increase

reliability.)*
. H:\ contains the second control file.
Symbolic Links

Symbolic links like those on UNIX are
not supported, although Microsoft has
announced the intention to support
them in a near-future release.
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Feature On UNIX... On Windows 98/NT...

Automatic Startup/Shutdown Automatic Startup On Windows 98:

See: Oracle8i Administrator’s Several files and scripts in There is no automatic startup or
Guide and Chapter 7, different directories are used to shutdown of database available while
"Administering a Database" in start an instance automatically. running on Windows 98.

this guide.

If the registry key HKEY_LOCAL _
MACHINE\SOFTWARE\HOMEID\
DATABASE_STARTUP is set to AUTO,
Scripts are run on computer then if no database instance is available
shutdown, allowing applications  while starting up SQL*Plus or
such as Oracle to be shut down SVRMGR, the instance whose SID is set
cleanly. to ORACLE_SID key will startup. If you
want to change the value of
DATABASE_STARTUP parameter, you
can use ORAAUTO or Oracle8i
Navigator (see Navigator help on how
to modify registry keys for more
information).

On Windows NT:

Automatic Startup

Automatic Shutdown

Set the registry parameter ORA_SID_
AUTOSTART to TRUE (the default)
using an Oracle tool such as ORADIM.

1. Enter the following with
parameters at the MS-DOS
command prompt:

C\> CRAD M PARAMETERS

2. Tostart the listener automatically,
set the service startup type to
automatic.

Automatic Shutdown

1. Set the registry parameters ORA _
SHUTDOWN and ORA _SID_
SHUTDOWN to stop the relevant
OracleServiceSID and shut down.

2. Setthe registry parameter ORA_
SID_SHUTDOWNTYPE to control
the shutdown mode (the default is
I, or Immediate).
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Feature

On UNIX...

On Windows 98/NT...

Diagnostic and Tuning Utilities

See: Chapter 2, "Database Tools
Overview" and Chapter 8,
"Monitoring a Database"

Performance utilities are not
included with the operating
system. Utilities such as sar and
vmstat are used to monitor Oracle
background and shadow
processes. These utilities are not
integrated with Oracle.

Task Manager on Windows NT
displays currently running
processes and their resource
usage, similar to the UNIX ps -ef
command or OpenVMS SHOW
SYSTEM. However, Task Manager
is easier to interpret and the
columns can be customized.

On Windows 98:

Performance utilities include Task
Manager, Control Panel, the Registry,
PVIEWER.EXE (Process Viewer of
Microsoft’s C++ Developer Studio) can
be used to monitor processes and
threads.

On Windows NT:

Performance utilities include Oracle
Performance Monitor, Task Manager,
Control Panel, Event Viewer, the
registry, User Manager, and Microsoft
Management Console (only included
with Windows 2000).

Oracle is integrated with several of these
tools. For example:

. Oracle Performance Monitor
displays key Oracle database
information.

This tool is the same in appearance
and operation as the Windows NT
Performance Monitor, except it has
been preloaded with Oracle8i
database performance elements.

«  Event Viewer displays system alert
messages, including Oracle
startup/shutdown messages and
the audit trail.
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Feature On UNIX...

On Windows 98/NT...

Raw Partitions Raw partitions are supported.

Raw partitions are not supported on
Windows 98.

On Windows NT:

Data files for tablespaces can be stored
on a file system, or on raw partitions. A
raw partition is a portion of a physical
disk that is accessed at the lowest
possible level.

Use the Windows NT Disk
Administrator application to create an
extended partition on a physical drive.
An extended partition points to raw
space on the disk that can be assigned
multiple logical partitions for the
database files.

An extended partition avoids the
four-partition limit on Windows NT by
allowing you to define large numbers of
logical partitions to accommodate
applications using the Oracle8i
database. Logical partitions can then be
given symbolic link names to free up
drive letters.

5w N P

NTFSisavailable on Windows NT only.

On Windows 98 maximum 10 concurrent users are allowed.
Disk stripping is not supported on Windows 98.

RAID isnot available for Windows 98.
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2

Database Tools Overview

Oracle8i Personal Edition for Windows 98 includes various tools to perform
database functions. This chapter describes the preferred tools to perform common
database administration tasks.

Specific topics discussed are:
« Choosing a Database Tool
« Starting Database Tools

« Using SQL*Loader

« Using Windows 98 Tools
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Choosing a Database Tool

Choosing a Database Tool

Database tools is a collective term for tools, utilities, and assistants that you can use
to perform database administration tasks. Some database tools perform similar
tasks, though no one database tool performs all database administration tasks. The
following sections indicate which database tools can be used on particular
operating systems and the preferred tools to use for common database
administration tasks.

Note: This chapter describes tasks that use SQL*Plus command
line syntax. In this guide, all Server Manager text and examples
have been replaced with SQL*Plus equivalents. Although Server
Manager continues to ship with 8.1.x releases, Oracle Corporation
strongly recommends that you migrate to SQL*Plus as soon as
possible. See your SQL*Plus documentation for information on
using SQL*Plus to perform database administration tasks.

Note that for all previous Oracle8 8.0.x releases, the Server Manager
executable was SVRMGR30. For 8.1.6, the Server Manager
executable is SVRMGRL. The "L" indicates line mode.

Oracle8i Navigator can be installed from Oracle8i Personal Edition
for Window 98 CD-ROM of release 8.1.6. It can be installed by
selecting Typical Installation or through Custom Installation.
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Choosing a Database Tool

Database Tools and Operating System Compatibility

This table lists database tools and the operating system(s) on which each can be
used:

Database Tools Windows 98

Application Development

SQL*Plus (SQLPLUS)* Yes
Object Type Translator (OTT) Yes
Database Administration

Oracle Database Configuration Assistant Yes

Migration Utilities

Oracle Data Migration Assistant Yes
Oracle Utilities from the MS-DOS Command

Line

Migration Utility (MIG) Yes
DBVERIFY (DBVERF) Yes
Export Utility (EXP) Yes
Import Utility (IMP) Yes
OCOPY Yes
Password Utility (ORAPWD)? Yes
Recovery Manager (RMAN) Yes
SQL*Loader (SQLLDR) Yes
TKPROF (TKPROF) Yes
Network Administration

Net8 Assistant Yes
Net8 Configuration Assistant Yes

Windows 98 Tools
Registry Yes

1 The ORADEBUG utility can be used through SQL*Plus to send debug commands to Oracle
processes. See "Using the ORADEBUG Utility" on page 7-13.

2 ORAPWD does not work on password files for remote databases.

Database Tools Overview 2-3



Choosing a Database Tool

Preferred Database Tools

This table lists common database administration tasks and the various database
tools you can use to perform them. Oracle Corporation recommends you use the

tools listed in the "Preferred Database Tool" column of the table. After choosing a
tool to perform a task, go to "Starting Database Tools" on page 2-5 for instructions

on how to start the tool.

Database Administration Task

Preferred Database Tool

Other Database Tools

Create a database

Oracle Database Configuration Assistant

Delete a database

Oracle Database Configuration Assistant

Start a database

Oracle Start Utility (OSTART)

SQL*Plus

Shut down a database

Oracle Stop Utility (OSTOP)

SQL*Plus and KNLSTOP
together

Change internal database
passwords

ORAPWD

Migrate a database
. From release 7.3.x to release 8.1.6

Oracle Data Migration Assistant!

Migration Utility (MIG)

Upgrade a database

. From release 8.0.x to release 8.1.6

Oracle Data Migration Assistant

Run provided scripts in
SQL*Plus

Export data Export Utility (EXP)

Import data Import Utility (IMP)

Load data SQL*Loader (SQLLDR)

Back up a database = Recovery Manager (RMAN)
. OCOPY?

Recover a database

. Recovery Manager (RMAN)
. OCOPY

Authenticate Database
Administrators and Users

SQL*Plus

Create database objects®

Oracle8i Navigator

SQL*Plus

! Oracle Data Migration Assistant can only be used to upgrade release 7.x, 8.0.x or 8.1.5 databases to release 8.1.6. It cannot be
used to upgrade an earlier Oracle7 database release to a later Oracle7 database release. See your Oracle7 for Windows 95

documentation for information on how to upgrade from an earlier Oracle7 release to a later Oracle7 release.

Do not back up files while you are shutting down the database, otherwise your backup will be invalid. You cannot use an

invalid backup to restore files at a later date. See Oracle8i Backup and Recovery Guide for more information.

% See Oracle8i Administrator’s Guide for guidelines on creating databases objects. This guide provides equations for estimating
the space requirements for clusters, non-clustered tables, and indexes. Windows 98 uses the same fixed header, transaction

header, and row header constants described in this guide.
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Starting Database Tools

Starting Database Tools

This section describes how to start each of the database tools in the following
categories:

« Starting Database Tools in Multiple Oracle Homes
« Starting Database Tools

« Starting Oracle Utilities from the Command Line

» Starting Windows 98 Tools

You will be referred back to this section for database tool startup procedures as you
use this guide.

Starting Database Tools in Multiple Oracle Homes

If you have multiple Oracle homes on your computer from previous releases, see
"Multiple Oracle Home Functionality in Different Releases" on page 4-3 and
"Multiple Oracle Home Environments" on page 4-5 for a description of the
differences between pre-8.1.6 Oracle homes and release 8.1.6 and later Oracle
homes.

Starting Tools from Release 8.0.4 and later 8.0.x Multiple Oracle Homes

If you are using multiple Oracle homes functionality, the command to start a tool
includes a HOME_NAME, where HOME_NAME indicates the name of a different
Oracle home. Note that the first Oracle home created on your computer does not
have HOME_NAME appended to the group. For example:

To start SQL*Plus from the first Oracle home, choose:
Start > Programs > Oracle > Application Development > SQL Plus
To start SQL*Plus from an additional Oracle home, choose:

Start > Programs > Oracle - HOME_NAME > Application Development > SQL Plus
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Starting Database Tools

Starting Tools from Release 8.1.6 Personal Edition for Windows 98 Multiple

Oracle Homes

In release 8.1.6, all Oracle homes, including the first Oracle home you create on your
computer, have a unigue HOME_NAME. For example, the command to start
Database Configuration Assistant is as follows:

Start > Programs > Oracle - HOME_NAME > Database Administration > Database
Configuration Assistant, where HOME_NAME is the name of the Oracle home. For
example, either HOME1 or HOME?2 in the following figure:

P |\ iaca - HOME

L= hecha - HOME X
E;h-ﬁﬁw * | =) Oracla intallation Fraduciz
= L=l
QE"’ "B O Pt
_u'“"rlh“.:th'-
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Starting Database Tools

Starting Database Tools

This table describes how to start most tools, and where to go for further information
on using these products:

Tool Choose Start > Programs > Oracle - HOME_NAME > For More Information, See...

Oracle Data Migration Utilities > Data Migration Assistant «  Oracle8i Migration

Xs!giﬁgr? «  Oracle8i Installation Guide for
Windows 98

Oracle Database = Database Administration > Database Configuration « "Using Oracle Database

Configuration Assistant Configuration Assistant” on

Assistant

page 6-3

. Oracle8i Installation Guide for
Windows 98

Net8 Assistant

Network Administration > Net8 Assistant Net8 Administrator’s Guide

Net8
Configuration
Assistant

Network Administration > Net8 Configuration Net8 Administrator’s Guide

Assistant

Starting Oracle Utilities from the Command Line

This table describes how to start Oracle utilities from the MS-DOS command line,
and where to go for further information on using these products:

Oracle Utilities

To Start... For More Information, See...

DBVERIFY (DBV)

Enter the following at the MS-DOS command prompt: Oracle8i Utilities
C\> DBV

DBVERIFY starts and prompts you for a file name
parameter. To obtain a list of parameters, enter the
following at the MS-DOS command prompt:

C\> DBV HELP=Y
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Oracle Utilities To Start... For More Information, See...

Export Utility Enter the following at the MS-DOS command prompt «  Oracle8i Utilities, which

(EXP) followed by your user name and password: describes how to use the Export
C\> BXP Utility

Oracle8i Error Messages for

EXP starts and prompts you for parameters. To obtain * -
information on error messages

a list of these parameters, enter the following at the
MS-DOS command prompt:

C\> BEXP HELP=Y

Note: When running the Export Utility, the default
values for the following parameters under Windows
NT are:

BUFFER 4 KB
RECORDLENGTH 2 KB

Note: To export an entire database, you must use the
user name SYSTEM. Do not use INTERNAL or SYS.

Import Utility Enter the following at the MS-DOS command prompt «  Oracle8i Utilities, which
(IMP) followed by your user name and password: describes how to use the

C\> MW Import Utility

IMP starts and prompts you for parameters. To obtain *
a list of these parameters, enter the following at the
MS-DOS command prompt:

C\> | M HELP=Y

Note: When running the Import Utility, the default
values for the following parameters under Windows
NT are:

BUFFER 4 KB
RECORDLENGTH 2 KB

Oracle8i Error Messages for
information on error messages

Migration Utility  Enter the following at the MS-DOS command prompt: Oracle8i Migration

(MIG) C\> MG
To obtain a list of parameters, enter the following at
the MS-DOS command prompt:
C\> MG HELP=Y
OCOPY Enter the following at the MS-DOS command prompt: "Backing Up Files with OCOPY"

C\> COPY on page 9-3
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Oracle Utilities

To Start...

For More Information, See...

Password Utility

Enter the following at the MS-DOS command prompt:

"Creating Password Files" on

(ORAPWD) C\> CRAAVD page 7-5
Note that the password file is a hidden file. To see it in
afile list, from the Windows NT Explorer, choose
View > Options > View > Show All Files
Recovery Enter the following at the MS-DOS command prompt: Recovery Manager (RMAN) in
Manager RVAN PARAMETERS command line mode on
(RMAN) c\> P page 11-2 and Oracle8i Backup
and Recovery Guide for
instructions on using this tool
SQL*Plus Enter the following at the MS-DOS command prompt: SQL*Plus User’s Guide and
(SQLPLUS) C\> SAPLLS Reference
"Starting and Shutting Down a
Database with SQL*Plus" on
page 7-2, for examples of
starting and stopping the
database with SQL*Plus
SQL*Loader Invoke SQL*Loader at the MS-DOS command prompt Oracle8i Utilities, which
(SQLLDR) followed by certain keywords. Enter the following describes how to use
and SQL*Loader displays a Help screen with the SQL*Loader
available keywords and default values: Oracle8i Error Messages for
C\> SQLDR information on error messages
"Using SQL*Loader" on
page 2-10
TKPROF Enter the following at the MS-DOS command prompt: Oracle8i Tuning
(TKPROF)

C\> TKPRCF
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Starting Windows 98 Tools

This table describes how to start Windows 98 tool, and where to go for more
information on using this product:

Windows 98 To Start... For More Information, See...

Tools

Registry «  Enter the following at the MS-DOS command «  "Registry" on page 2-12
prompt on Windows 98: «  Appendix C, "Oracle8i
C\> REGEDI T Configuration Parameters

The registry editor window appears. and the Registry

. Your Microsoft Windows 98
documentation

Using SQL*Loader
This section describes Windows 98-specific information for using SQL*Loader
(SQLLDR).

Windows 98 Processing Options

These are the possible values for the Operating System Dependent (OSD) file
processing specifications string option, referred to in the "SQL*Loader Control File
Reference" chapter of Oracle8i Utilities.

Processing Option Description

il Stream record format in which each record is terminated by a newline character. The
maximum record size is 48 KB.

"FIX n" Fixed record format in which each record is exactly n bytes long. If the record is
terminated by a newline character, the newline character must be the nth byte. Note
that the Oracle8i Utilities guide refers to this control file option as "RECSIZE".
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Processing Option

Description

"VAR XXXX"

Load variable length records. Specify the OSD "VAR recsizehint" in the control file for
this option to take effect. The xxxx gives an estimate of the average record size to
SQL*Loader so that it can approximate buffer sizes accurately and not waste
memory. The default length is eighty characters. The xxxx does not specify how
many leading bytes of length are included in each record. It only acts as a hint to
SQL*Loader. Each record must always be preceded by five ASCII bytes containing
the length of the remainder of the record. For example, a record must look like the
following:

00024This is a 24 byte string

Any whitespace, carriage returns, or linefeeds at the end of the record are ignored
unless specifically included in the byte count in the length field.

1 Two double quote characters with no space in between.

Direct Path Option

SQL*Loader includes a direct path option that bypasses Oracle8i for Personal

Edition redo log and data verification features, thereby decreasing loading time.
Use the direct path option with data files known to be error free.

Control File Conventions

When preparing a SQL*Loader control file (.CTL), you must follow certain syntax
and notational conventions. When specifying datatypes in the SQL*Loader control
file, note that the default sizes of native datatypes are specific to Windows 98. You
cannot override these defaults in the control file.

Native Datatypes Default Field Length
DOUBLE 8
FLOAT 4
INTEGER 4
SMALLINT 2

See: Oracle8i Utilities for a complete list of options and
instructions on using SQL*Loader.
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Using Windows 98 Tools
The following Windows 98 tool can be used to administer an Oracle database:

« Registry

Registry

The Oracle database stores its configuration information in a structure known as the
registry. You can view and modify this configuration information through the
registry editor. The registry contains configuration information for your computer,
and must not be accessible for editing by inexperienced users. Only experienced
administrators should view and change this information.

The registry editor displays configuration information in a tree-like format
consisting of four keys (or folders). These keys are shown in the tree view in the
left-hand window. In the right-hand window, the parameters and values assigned
to that key are displayed.

What Database Parameters Are Configured?

When you install products from your CD-ROM, configuration parameters are
automatically entered in the registry. These parameters are read each time your
Windows 98 computer is restarted and whenever an Oracle product is launched.
These parameters include settings for:

« Oracle home directory

« Language

« Company name

«  Oracle home subdirectories for individual products
« Individual products such as SQL*Plus

The following figure shows some of the Oracle database configuration parameters
in the registry:
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See Appendix C, "Oracle8i Configuration Parameters and the
Registry" for definitions of Oracle database configuration
parameters and specific instructions on using the registry to modify
Oracle database configuration parameters.
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Multiple Oracle Homes and Optimal Flexible
Architecture

This chapter describes the concepts of multiple Oracle homes and Optimal Flexible
Architecture (OFA) for Oracle8i Personal Edition for Windows 98.

Specific topics discussed are:

« Introduction to Multiple Oracle Homes and OFA

«  Multiple Oracle Homes Overview

«  Which Products Are Multiple Oracle Home-Enabled?
« Changing the Value of PATH

« Exiting Oracle Universal Installer After Entering Name and PATH
« Setting Variables in the Environment or the Registry
« Optimal Flexible Architecture Overview

« Differences Between Directory Trees by Release

« Directory Tree of a Sample OFA-Compliant Database
« OFA Directory Naming Conventions

« OFA and Multiple Oracle Home Configurations
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Introduction to Multiple Oracle Homes and OFA

Introduction to Multiple Oracle Homes and OFA

When you install an Oracle database, you are installing one of the largest
applications that your computer can support. Using multiple Oracle homes and
OFA provides many advantages when administering large databases. The following
advantages are the most important:

Databases are easier to administer because of the structured organization of
directories and files, and the consistent naming used for database files.

A reduction of performance bottlenecks and improved safeguards against disk
failures, because input/output (1/0) can be distributed across a number of
disks.

Software upgrades can be tested in an Oracle home in a separate directory from
the Oracle home where your production database is located.

Multiple Oracle Homes Overview

This section provides an overview of multiple Oracle homes. It includes the
following topics:

What Is an Oracle Home?

Benefits of Using Multiple Oracle Homes

Multiple Oracle Home Functionality in Different Releases
One-Listener Support of Multiple Oracle Homes

Multiple Oracle Home Environments

What Is an Oracle Home?

An Oracle home corresponds to the environment in which Oracle products run.
This environment includes the following:

Location of installed product files (for example, C:\ORACLE\ORAS81)
PATH variable pointing to the products’ binary files
Registry entries

Program groups

Oracle homes also have a name associated with them, which you specify along with
their location during installation.
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Benefits of Using Multiple Oracle Homes

The main benefit of using multiple Oracle homes is that you can run multiple
releases of the same products concurrently. For example, you can test a release 8.x.x
database patch before you run your production database release 8.x.x against it.

Multiple Oracle Home Functionality in Different Releases

Modifications to multiple Oracle home functionality have occurred since it was
introduced in release 8.0.4. This table helps you determine the capabilities of your
Oracle home depending on the release you are using.

Release Oracle Home Functionality

Before 8.0.4 Releases of Oracle for Windows 95 prior to release 8.0.4 only supported single Oracle homes,
allowing you to install and run Oracle products in a single Oracle home. Different releases of
Oracle products could be installed in the same Oracle home provided they had different first
or second-digit release numbers. For example, you could install release 7.2 products and
release 7.3 products and release 7.x and 8.x products in the same Oracle home. However, you
could not install multiple third-digit releases of the same products. For example, you could
not install release 7.3.2 and release 7.3.3 of the same Oracle products on the same computer;
one installation would overwrite the other.

8.0.4 You can install one or more releases of Oracle products in multiple Oracle homes. For
example, with multiple Oracle homes, you can install releases 8.0.x and 8.1.3 products or 7.x
and 8.0.x products in different Oracle homes on the same computer.

You can also install different releases of Oracle products in the same Oracle home provided
they have different first or second-digit release numbers. For example, you can install release
7.2 products and release 8.0.x products in the same Oracle home.

8.15t08.16 Releases 8.1.5 and 8.1.6 have the same multiple Oracle home functionality as release 8.0.4 and
later, but with these restrictions:

« You cannot install releases 8.1.5 or 8.1.6 into an Oracle home that was created using the
old Installer. (The old Installer was called Oracle Installer and was used for pre-8.1.5
installations; the new Java-based Installer is called Oracle Universal Installer.)

« You cannot install releases of Oracle prior to release 8.1.5 into an Oracle home that was
created by release 8.1.5 or 8.1.6.

« Releases 8.1.5 and 8.1.6 must be installed in separate Oracle homes. You cannot have
more than one release per Oracle home.

« Inrelease 8.1.6 Personal Edition for windows 98, multiple oracle home support for
RDBMS has been added.
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Release Oracle Home Functionality

8.15t08.1.6 You can use a release 8.1.6 listener to spawn a connection to a release 8.1.x, 8.0.x, or 7.3.X
database. However, in a mixed environment, you cannot enable the use of shared sockets.

Some restrictions exist in using 8.1.6 listeners to spawn connections to earlier versions of the
database. These include:

« You should enable process mode external procedures for release 8.1.6 if you want to
spawn a connection to a release 8.0.4 databases.

«  You must install the release 8.0.4.0.3 (or later) patch for Net8.
« You cannot enable shared sockets.

WARNING: Multiple Oracle homes functionality only works
with releases 8.0.4 and later. For example, if you have release 7.3.3
products already installed on your computer, it does not work.
You cannot install release 7.3.4 products in a separate Oracle
home.

One-Listener Support of Multiple Oracle Homes

You can use one listener for spawning connections to databases for multiple Oracle
homes. You only need to add all the System Identifiers (SIDs) to the SID_LIST
section in the ORACLE_BASE\ORACLE_
HOME\NNETWORK\ADMIN\LISTENER.ORA file.

Because the SID is unique to a system across different Oracle homes, the listener can
spawn the database thread for a specific SID in the correct Oracle home, and the
ORACLE_HOME parameter (used in UNIX environments only) is not needed in the
LISTENER.ORA.

Note: There may be multiple LISTENER.ORA files on your
computer, one for each Oracle home. To ensure that you use the
correct LISTENER.ORA file, check the Oracle home name in the
listener service.

3-4 Oracle8ij Administrator’s Guide for Windows 98



Multiple Oracle Homes Overview

Multiple Oracle Home Environments

This section describes the differences among multiple Oracle home environments
since multiple Oracle homes were first introduced in release 8.0.4.

Release 8.0.4 and later 8.0.x Oracle Home Environments

If you have release 8.0.4 or later 8.0.x Oracle homes on your computer, note these
differences between the first Oracle home you installed and more recent Oracle
homes you may install:

Element First Oracle Home Each Additional Oracle Home
Program Groups Oracle for Windows 98 Appends the Oracle home name to the program
Oracle home name is not appended group. For example: Oracle for Windows 98 - HOME_
NAME
to the group.
Registry Entries  Located in HKEY_LOCAL_ Subkeys for each Oracle home are added below the

MACHINE\SOFTWARE\ORACLE HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
subkey (HOMEO, HOME1, HOMEZ2, and so on). For
more information on the registry keys and subkeys,
see Appendix C, "Oracle8i Configuration Parameters
and the Registry".

System Identifier Automatically named ORCL Having more than one instance of database was not
(SID) name for supported on Windows 98 platform.
starter database
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Release 8.1 Oracle Home Environment
Release 8.1 Oracle homes are slightly different from pre-8.1 Oracle homes.

Element First Oracle Home Each Additional Oracle Home
Program Groups Oracle - HOME_NAME Oracle - HOME_NAME
Registry Entries  Located in HKEY_LOCAL Subkeys for each Oracle home are added in

MACHINE\NSOFTWARE\ORACLE\HOMEO the HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLEsubkey.
For example, the next subkeys after
HOMEOQ are HOME1, HOME2, HOMES3,
and so on. For more information on the
registry keys and subkeys, see Appendix C,
"Oracle8i Configuration Parameters and
the Registry".

System Identifier For 8.1.5 and 8.1.6, you must type in the global Having more than one instance of Personal
(SID)! name and  database name and SID name of your choice  Edition database on Windows 98 platform
DB_NAME when prompted during installation. is supported in Release 8.1.6.

! For Releases 8.1.5 and 8.1.6, the SID can be a maximum of 64 alphanumeric characters in length. For all releases prior to
8.1.5, the SID was a maximum of 4 alphanumeric characters.

Which Products Are Multiple Oracle Home-Enabled?

You can install all products on the CD-ROM into your first Oracle home on a "clean”
computer (that is, there is no other Oracle software on the computer) without any
conflict.

If you create more Oracle homes, and install the same products that you installed
into the first Oracle home, conflicts can arise that cause your original database to
function incorrectly if the products are not multiple Oracle home-enabled (multiple
Oracle home products.)

To avoid such problems, check the following product classifications before installing
multiple versions of the same product on your computer. Oracle products are
classified as follows:

« Products Supporting Multiple Oracle Homes
« Products Supporting a Single Oracle Home
« Products Not Supporting Multiple Oracle Homes

« Products Not Associated with an Oracle Home
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Products Supporting Multiple Oracle Homes

You can install multiple Oracle home products multiple times in different Oracle
homes. All products are multiple Oracle home products unless they are listed in:

« "Products Supporting a Single Oracle Home" on page 3-7 or

« "Products Not Supporting Multiple Oracle Homes" on page 3-7

Products Supporting a Single Oracle Home

You can install single Oracle home products into any Oracle home, but only once per
computer. When installing groups of products, if any of the products in the following
list are included in the group and already exist on the computer, do not install them
a second time:

« Oracle Objects for OLE
« Oracle Open Database Connectivity (ODBC) Driver
« All products that depend on any of these products

Products Not Supporting Multiple Oracle Homes

All Oracle7 products and all release 8.0.3 products are non multiple Oracle home
products. You can only install these products into an old-style Oracle home
(pre-8.0.4 Oracle home is an old-style Oracle home).

Products Not Associated with an Oracle Home

Products not associated with an Oracle home have no restrictions into how many
Oracle homes you install them. They include the following:

« Oracle Universal Installer
« Java Runtime Environment

When you install these products, Oracle Universal Installer requires that you install
them into any Oracle home. However, these files are actually installed in the
directory X:\PROGRAM FILES\ORACLE, where X: is the hard drive where
Windows 98 is installed.
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Changing the Value of PATH

Unless you specify otherwise at installation time, the Oracle home in which you
installed products most recently is the first directory listed in your PATH (primary
home). As such, it has priority over the other Oracle home entries in your PATH.

If you invoke a product from the MS-DOS command prompt, the release of the
product invoked is the one in the Oracle home listed first in your path, unless you
specifically invoke a different release of the product by one of the following
methods:

« Specifying the full directory path name to the release of the product you want
to use at the MS-DOS command prompt.

« Changing to the directory that contains the executable you want to use.

« Changing your PATH so that the first entry points to the binary files for the
product release you want to use.

You can change the value of PATH by using one of the following methods:
« Using Oracle Home Selector
« Atthe System Level

You can assign a new value at the system level. The new value exists until you
change the value of PATH again.

« Atthe MS-DOS Command Prompt

You can assign a new value at the MS-DOS command prompt. The new value
reverts to its previous value when you quit the session.
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Using Oracle Home Selector

Oracle Home Selector is a graphical user interface (GUI) tool that enables you to

edit your environment path to make an appropriate Oracle home directory your

primary home. This tool can only be used when you have multiple, active Oracle
home directories on a single computer.

To change the value of PATH using Oracle Home Selector:
1. Choose Start > Programs > Oracle Installation Products > Home Selector.
The Oracle Home Selector window appears.

2. Select the Oracle home that you want as the primary Oracle home from the
drop-down list.

3. Click OK.

At the System Level
To change the value of PATH at the system level:

On Windows 98
1. Openthe AUTOEXEC.BAT file.
2. Edit the value of the PATH statement.

3. Reboot your computer.

Multiple Oracle Homes and Optimal Flexible Architecture 3-9



Exiting Oracle Universal Installer After Entering Name and PATH

At the MS-DOS Command Prompt
To change the value of PATH at the MS-DOS command prompt:

At the MS-DOS command prompt, enter:
C\ > SET PATH=PATHNAME YRATHY

where PATHNAME is the full path to the binary files for the products you want to
use. This change is valid for the current session only. If you want to change the
value of your PATH more permanently, use Oracle Home Selector or change the
value of PATH at the system level. Both methods are described above.

Exiting Oracle Universal Installer After Entering Name and PATH

If you have to exit Oracle Universal Installer unexpectedly after you have entered
the name and path for an Oracle home (for example, because there is no more disk
space in the path you specified), you cannot specify a different path until you delete
the HOMEID key and the IDx key corresponding to that Oracle home from the
registry. To do this:

1. Read the value of the ORACLE_HOME_NAME parameter for each HOMEID
subkey in the HKEY_LOCAL_MACHINE\NSOFTWARE\ORACLE key until
you find the value that matches the name of the Oracle home you need to
delete.

2. Delete the HOMEID subkey you just located.

3. Delete the appropriate IDx subkey in the HKEY_LOCAL_
MACHINENSOFTWARE\ORACLE\ ALL_HOMES key, where x has the same
value as the ID in HOMEID. For example, if the HOMEID subkey for the home
name you want to delete is HOMEL, then the appropriate IDx subkey is ID1.

See Also: Appendix C, "Oracle8i Configuration Parameters and
the Registry"” for more information on the registry keys and
subkeys.
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Setting Variables in the Environment or the Registry

Variables set in the environment always override the value of equivalent variables
set in the registry. The following section describes the consequences of setting two
of the most commonly-used environment variables, ORACLE_HOME and TNS_
ADMIN.

ORACLE_HOME

Oracle Corporation recommends that you never set the ORACLE_HOME
environment variable because it is not required for Oracle products to function
properly. If you set the ORACLE_HOME environment variable, Oracle Universal
Installer will unset it for you. Oracle products find the value of ORACLE_HOME at
the location specified by the ORACLE_BASE\ORACLE_
HOME\BIN\ORACLE.KEY file. If there is a need to set ORACLE_HOME in the
environment for another reason, care must be taken to only run software from that
Oracle home when the variable is set.

When you run an Oracle program from the MS-DOS command prompt, the first
executable by that name found in the directory path runs. For example, C:\>
SQLPLUS. Alternately, if you specify a full directory path, the specified program
runs. For example, C:\ORACLE\ORAS81> SQLPLUS.

If you modify the value of PATH using any of the three methods described in the
previous section, "Using Oracle Home Selector", "At the System Level", or "At the
MS-DOS Command Prompt", you can change the choice of which version of a
program is run from the MS-DOS command prompt. In sum, modifying the value
of PATH indicates from which Oracle home to run executables, at the MS-DOS
command prompt, when no full directory path is specified.

Once an Oracle program starts, it looks for all environment variables in the
following order:

1. Inthe current environment
2. Inthe registry key for the Oracle home from which the program is running.

The program knows where it’s running from by calling Window 98 to obtain the
executable’s path name, and then parsing the path name to get the directory
from which it’s running. In the ORACLE_BASE\ORACLE_HOME\BIN
directory where the executable resides, there is a file called ORACLE.KEY. This
file specifies where in the registry to look for variables when programs from
that particular Oracle home are run.
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For example, if you run C:\ORACLE\ORAS8I\BIN\SQLPLUS.EXE,
SQLPLUS.EXE looks in C:\ORACLE\ORAB8I\BIN\ORACLE.KEY to find out
where to look for its registry variables. If the ORACLE.KEY file does not exist
(for version 7.x and some version 8.0 Oracle homes), Oracle uses HKEY _
LOCAL_MACHINENSOFTWARE\ORACLE to locate the registry variables.

In a typical case, there are no Oracle variables (that is, ORACLE_HOME) set in
the environment. Any programs run from a release 8.0.4 Oracle home look in
the ORACLE.KEY file in that Oracle home and find their variables (including
ORACLE_HOME) in the correct registry key. Likewise for release 8.1.6, the
Oracle home that gets priority depends on the PATH, but regardless of the
PATH setting, all the software works correctly.

Consequences of Setting ORACLE_HOME

If you set ORACLE_HOME in the environment, then software run from another
Oracle home will not work reliably. The conflict occurs when you set ORACLE _
HOME to point to one Oracle home directory, then attempt to run programs from a
second Oracle home. These programs first check for any environment variable
settings (such as ORACLE_HOME), before checking the registry through the
ORACLE.KEY file. Since ORACLE_HOME is set, the programs in the second Oracle
home attempt to use files in the first Oracle home, causing a conflict.

For example, assume you have release 8.0.4 installed in C:\ORAWING95, and release
8.1.6 installed in C:\ORACLE\ORAZ81, and ORACLE_HOME is set to
C:\ORAWINO95 in the environment. If you run a program from
C:\ORACLE\ORAB8I\BIN, that program first looks in the environment for all
variables before looking at its ORACLE.KEY file. So, a program run from your
release 8.1.6 Oracle home runs with ORACLE_HOME=C:\ORAWIN95. Therefore,
anything that the program uses ORACLE_HOME for will be looked for in
C:\ORAWINO95, where it may not exist. Examples include message files ((MSB),
SQL scripts (.SQL), and any other files opened by the program and based on
ORACLE_HOME.
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TNS_ADMIN

Oracle software looks for TNS_ADMIN in one location in the registry (depending
upon the type of Oracle home installed). If you installed software into the default
Oracle home, then any software running from that Oracle home will look in HKEY _
LOCAL_MACHINENSOFTWARE\ORACLE. If you installed a new-style (8.0.4 or
later) multiple Oracle home, then the Oracle software looks in HKEY_LOCAL _
MACHINE\SOFTWARE\ORACLE\HOMEID. The ALL_HOMES key is used by
the installer and plays no role when translating variables.

The environment always overrides the registry, so if TNS_ADMIN is set in the
environment, that takes precedence over the TNS_ADMIN setting in the registry.
No variables should be set in the environment by the Oracle Home Selector except
for the PATH.

Optimal Flexible Architecture Overview

The Oracle Optimal Flexible Architecture (OFA) is a set of file naming and
placement guidelines for Oracle software and databases. It can also be thought of as
a set of good habits to adopt when organizing Oracle directories and files on your
computer. All Oracle products on the CD-ROM are OFA-compliant; that is, Oracle
Universal Installer places Oracle products in directory locations that follow the OFA
guidelines. Although using OFA is not a requirement, Oracle Corporation
recommends that you use it if your database will grow in size, or if you plan to have
multiple databases.

The aim of OFA is to prevent an entire class of problems that can occur when you
have different versions of Oracle software and multiple, growing databases on your
computer. OFA is designed to provide significant benefits in the following areas:

« Ease of maintenance of Oracle software and databases through standard file
organization

« Reliability through data spanning multiple physical drives
« Performance through decreased 1/0 contention for disks

For example, one of the many benefits of OFA is that Oracle Universal Installer
separates Oracle software executables from database files. Previously, database files
were placed in ORACLE_HOME\DATABASE, a subdirectory of the Oracle home
directory that also contained Oracle software. Using OFA, Oracle Universal Installer
puts Oracle software in ORACLE_BASE\ORACLE_HOME and database files in
ORACLE_BASE\ORADATA.
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Putting database files in a subdirectory of the Oracle home directory that also
contained Oracle software made upgrades unnecessarily difficult. Separating
software from data is essential, because over time, when you upgrade a database to
the latest release, the new Oracle software executables will be placed in a different
Oracle home directory. After the upgrade is judged to have been successful, you can
easily remove the old Oracle home directory and reclaim space because the
database does not reside there.

Benefits of an OFA-Compliant Database
An OFA-compliant database has the following benefits:

Easier database administration and management of database growth
The file system is organized to simplify the following tasks:

« Locating specific database files

« Adding database files as the database grows

Fewer performance bottlenecks

Disk contention decreases, because Oracle administration files, binary files, and
data files that used to be on one disk can now reside in separate directories or in
separate directories on separate disks.

Safeguards against disk failures

By spreading files across more than one disk, disk failures impact as little data
as possible.

Support for concurrent execution of application software

You can run multiple versions of application software simultaneously, enabling
you to test and use a new release of an application before abandoning the
previous version. Transferring to a new version after an upgrade is simple for
the database administrator and transparent for the user.
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Characteristics of an OFA-Compliant Database
An OFA-compliant database has the following characteristics:

Independent subdirectories

Categories of files are separated into independent subdirectories so that files in
one category are minimally affected by operations on files in other categories.

Consistent naming conventions for database files
Database files are named to realize the following advantages:
« Database files are easily distinguishable from all other files

« Files of one database are easily distinguishable from files of another
database

« Control files, redo log files, and data files are easily identifiable
« Clearly indicated association of data files to tablespaces
Integrity of Oracle home directories

You can add, move, or delete Oracle home directories without having to revise
programs that refer to them.

Distinguishes administrative information for each database

The ability to separate administrative information about one database from that
of another ensures a reasonable structure for the organization and storage of
administrative data.

Separation of tablespace contents

Tablespace contents are separated to realize the following advantages:
« Minimize tablespace-free space fragmentation

«  Minimize I/0 request contention

«  Maximize administrative flexibility

Tuning 1/0O loads across all disks

170 loads are tuned across all disks, including disks storing Oracle data in raw
devices, if needed.
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Differences Between Directory Trees by Release

OFA has necessitated changes to the Oracle database directory tree. This table lists
the differences:

Element

Pre-8.1.5 non-OFA-Compliant

Post-8.1.5 OFA-Compliant

Name of the
top-level directory
where Oracle is
installed.

When you install Oracle8i Personal
Edition all subdirectories are located
under a top-level ORACLE_HOME
directory that by default is
C\ORAWIN95.

See the following figure on page 3-17
for a depiction of the pre-8.1.5
non-OFA-compliant directory tree.

When you install Oracle8i Personal Edition all
subdirectories are no longer under a top-level
ORACLE_HOME directory. There is now a new
top-level directory called ORACLE_BASE that is
of the form X:\ORACLE where X is any hard
drive. If you install an OFA-compliant database
using Oracle Universal Installer defaults,
ORACLE_BASE is C:\ORACLE.

\ORACLE_HOME directories are located under
ORACLE_BASE. The \ORADATA and \ADMIN
directories, which contain the database files and
database administration files, are also located
under ORACLE_BASE.

See the following figure on page 3-17 for a
depiction of the 8.1.5 and 8.1.6 OFA-compliant
directory tree.

Database file names

Database files have the SID in the
database file name. For example, the
first control file is named
CTL1SID.ORA.

Database files no longer have the SID in the
database file name. For example, the first control
file is named CONTROLOL.CTL. There is no
need for the presence of the SID in the file name
because all the database files for a particular
database are placed in \ORADATA under a
directory called DB_NAME that is named for
that database.

Database file name
extensions

All database files have the same .ORA
extension.

The convention of having .ORA as the file name
extension for database files is no longer used.
Database file names now have more meaningful
extensions. These are .CTL for control files,
.LOG for log files, and .DBF for data files.
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The following figure provides a top-level overview of the old and new database
directory trees:

Pre-8.1.5 non-OFA-Compliant Oracle on Windows 98 Directory Tree
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Directory Tree of a Sample OFA-Compliant Database

The following is the complete hierarchical directory tree of a sample OFA-compliant

database:
X\ORACLE_BASE C:\ORACLE is the default ORACLE_BASE directory
\ORACLE_HOME1 \ORAB8L is the name of the first Oracle home by default
\BIN Subtree for Oracle binaries
\NETWORK Subtree for Net8
\ASSISTANTS Configuration assistants
\ORADATA Subtree for Oracle database files
\DB_NAME1 Subtree for DB_NAMEL1 database files
CONTROLO1.CTL Control file 1
CONTROLO02.CTL Control file 2
CONTROLO03.CTL Control file 3
DRO1.DBF interMedia related objects
SYSTEMO1.DBF System tablespace data file
RBS01.DBF Rollback tablespace data file
INDX01.DBF Index tablespace data file
TEMPO1.DBF Temporary tablespace data file
USERS01.DBF Users tablespace data file
REDOO01.LOG Redo log file group 1, member 1
REDO02.LOG Redo log file group 2, member 1
REDOO03.LOG Redo log file group 3, member 1
\DB_NAME2 Subtree for DB_NAME?2 database files
CTL DBF LOG Control, data, and redo log files
\DB_NAME3 Subtree for DB_NAMES3 database files
CTL DBF LOG Control, data, and redo log files
\ADMIN Subtree for database administration files
\DB_NAME1 Subtree for DB_NAMEL1 database administration files
\ADHOC Ad hoc SQL scripts
\ADUMP Audit files
\ARCH Archived redo log files
\BDUMP Background process trace files
\CDUMP Core dump files
\CREATE Database creation files
\EXP Database export files
\PFILE Initialization parameter file
\UDUMP User SQL trace files
\DB_NAME2 Subtree for DB_NAME?2 database administration files
\DB_NAME3 Subtree for DB_NAMES3 database administration files
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\ORACLE_HOME?2 Second Oracle home
N\

\ORACLE_HOME3 Third Oracle home
N\

OFA Directory Naming Conventions

OFA uses directory naming conventions that make it easy to identify the precise
Oracle home and database name that is associated with a set of files. This section
describes the naming conventions used for the top-level directories of an
OFA-compliant database directory tree:

« ORACLE_BASE Directory
« ORACLE_HOME Directory
« ADMIN Directory

« ORADATA Directory

« DB_NAME Directory

ORACLE_BASE Directory

ORACLE_BASE is the root of the Oracle directory tree. If you install an
OFA-compliant database using Oracle Universal Installer defaults, ORACLE_BASE
is X:\ORACLE where X is any hard drive. For example, C\ORACLE.

If you are installing Oracle8i Personal Edition for Windows 98 on a clean computer,
you may want to change ORACLE_BASE to an appropriate value before running
Oracle Universal Installer. Most users will not need or want to do this.

Before you run Oracle Universal Installer for the first time, change the value of
ORACLE_BASE at the system level. Only change the value of ORACLE_BASE
before you run Oracle Universal Installer for the first time because if there is an
existing ORACLE_BASE, and you change it, there will be a conflict of Oracle base
directories. If you create another ORACLE_BASE when the original ORACLE_BASE
already exists, certain tools and the database will not be able to find previously
created files because they will look for them in the new ORACLE_BASE instead of
the original ORACLE_BASE.

To change the value of ORACLE_BASE at the system level:
Windows 98:
1. Openthe AUTOEXEC.BAT file, using a text editor.
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2. Edit the value of the ORACLE_BASE statement.

3. Reboot your computer.

Note: An ORACLE_BASE registry key exists for every Oracle
home. Ideally, the value of the ORACLE_BASE registry key will be
identical for each Oracle home.

ORACLE_HOME Directory

\ORACLE_HOME is located beneath X:\NORACLE_BASE and contains
subdirectories for Oracle software executables and network files.

If you install Oracle8i Personal Edition for Windows 98 on a clean computer and
use the default settings, the first Oracle home directory that you create is called

\ORAS8L1.

ADMIN Directory

Database administration files are stored in subdirectories of ORACLE_BASE

\ADMIN\DB_NAME.

The following table describes the subdirectories for database administration files:

Subdirectories of \ADMIN\DB_NAME

Contain...

\ADHOC
\BDUMP
\CDUMP
\CREATE
\EXP
\PFILE
\UDUMP

Ad hoc SQL scripts for a given database
Background process trace files

Core dump files

Database creation files

Database export files

Initialization parameter files

User process trace files
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ORADATA Directory
Database files are stored in ORACLE_BASE\NORADATA\DB_NAME.

The following table describes the database files:

Files in \ORADATA\DB_NAME  Description

CONTROLO1.CTL Control file 1

CONTROLO02.CTL Control file 2

CONTROLO03.CTL Control file 3

SYSTEMO1.DBF SYSTEM tablespace data file
RBS01.DBF RBS tablespace data file

INDX01.DBF INDX tablespace data file
TEMPO1.DBF TEMP tablespace data file
USERS01.DBF USERS tablespace data file
REDOO01.LOG Redo log file group one, member one
REDOO02.LOG Redo log file group two, member one
REDOO03.LOG Redo log file group three, member one

DB_NAME Directory

DB_NAME is the unique name for a particular database and has the same value as
the DB_NAME parameter in the initialization parameter file. When you create a
database, DB_NAME can be no more than eight characters long and can contain
only the following characters:

« Alphabetic characters
= Numbers

« Underscores ()

« Pound sign (#)

« Dollar sign ($)
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OFA and Multiple Oracle Home Configurations

The following sections describe various OFA and multiple Oracle home
configurations.

Specifying an ORACLE_HOME Directory

To install an OFA-compliant database, you must specify an Oracle home directory
in the Path: field of Oracle Universal Installer of the form:

X\[PATHNAMEN\ORACLE\HOME_NAME

where:

X\ is any hard drive. For example, C:\.

[PATHNAME] is an optional directory pathname.

\ORACLE is a mandatory directory pathname unless you have changed

the value of the ORACLE_BASE registry key before
performing the installation. See "ORACLE_BASE Directory"
on page 3-19 for information on how to change the ORACLE_
BASE from the default value ORACLE.

HOME_NAME is the name of the Oracle home.

The following are examples of OFA-compliant Oracle home directories:
« CA\TEST\ORACLE\ORAS81
« D:\ORACLE\ORAS81

Default OFA Database

To install a default OFA database:
1. Install Oracle8i Personal Edition for Windows 98 release 8.1.6 on a clean
computer (one with no other Oracle software on the computer), and accept the

default Oracle Universal Installer settings for the first Oracle home
(C:\ORACLE\ORAB8L1) in the Path: field.

2. Complete the installation.

3. Run Oracle Universal Installer again and the same release a second time or
release 8.2.x (when it is available). Accept the default Oracle Universal Installer
settings for the first Oracle home (C:\ORACLE\ORA®82) in the Path: field.
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The default OFA database settings are as follows:

Setting Value

ORACLE_BASE is C:\ORACLE and is the same for all Oracle homes
Oracle home 1 is C\ORACLE\ORAS81

Oracle home 2 is C\ORACLE\ORAS82

This figure below illustrates the directory tree:
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Non-Default OFA Database, Case 1

To install a non-default OFA database, case 1:

1. Install Oracle8i Personal Edition for Windows 98 release 8.1.6 and change the
default Oracle Universal Installer settings for the first Oracle home from
C:\ORACLE\ORAS8L in the Path: field to X:\XYZ.

2. Complete the installation.

3. Run Oracle Universal Installer again and change the default Oracle Universal
Installer settings for the second Oracle home from C:\ORACLE\ORAS82 in the
Path: field to Y:\ABC.
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For case 1, the non-default OFA database settings are as follows:

Setting Value

ORACLE_BASE is X:\XYZ for the first Oracle home and is Y:\ABC for the
second Oracle home

Oracle home 1 is X:\AXYZ

Oracle home 2 is Y:\ABC

This figure illustrates the resulting directory trees:
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Non-Default OFA Database, Case 2

To install a non-default OFA database, case 2:

1. Install Oracle8i Personal Edition for Windows 98 release 8.1.6 and change the
default Oracle Universal Installer settings for the first Oracle home from
C:\ORACLE\ORABL1 in the Path: field to X:-AXYZ\ORACLE\ABC.

2. Complete the installation.

3. Run Oracle Universal Installer again and change the default Oracle Universal
Installer settings for the second Oracle home from C:\ORACLE\ORAS82 to
X:\PQR.

For case 2, the non-default OFA database settings are as follows:
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Setting Value

ORACLE_BASE is X'AXYZ\ORACLE and is the same for both Oracle
homes

Oracle home 1 is XAXYZ\ORACLE\ABC

Oracle home 2 is X:\PQR

This figure illustrates the resulting directory tree:
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Installing, Migrating, and Upgrading

Databases

This chapter describes the options available to you when you have existing databases
on your computer and want to install the latest release of Oracle8i Personal Edition.
In particular, it describes how to migrate an Oracle7 database or upgrade an earlier
Oracle8 database release to the current release of Oracle8i Personal Edition.

Specific topics discussed are:

Intended Audience

What to Do with Previous Oracle Database Releases
Multiple Oracle Homes Overview

Migrating, Upgrading, and Downgrading Overview
Export/Import Overview

Version 8 and Version 7 Client/Server Configurations
Migrating an Oracle7 Database to Oracle8i

Upgrading an Oracle8 Database Release 8.0.x to 8.1.6
Migration Issues for Net8 and SQL*Net

Moving Database Files to an OFA-Compliant Directory
Post-Migration Tasks

Intended Audience

Read this chapter if you have existing Oracle7 and/or Oracle8 databases on your
computer and you want to install Oracle8i Personal Edition for Windows 98 Release
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8.1.6. If you are installing Oracle8i Personal Edition on a computer that has no other
Oracle database releases, you do not have to read this chapter.

Additional Information: See Oracle8i Installation for Windows 98 if
you want to install Oracle8i Personal Edition on a computer
containing no other databases.

Note: The generic Oracle8i Migration guide is the primary source
of migration and upgrading information in the Oracle
documentation set. You are frequently referred to the generic guide
throughout this chapter, in particular to obtain information on what
you must do before and after migrating or upgrading. Information on
how to run the various migration and upgrade utilities is also
provided in the generic guide, but the focus is on UNIX. This
chapter provides information on using these utilities on Windows
98.

Note: The directory path examples in this chapter follow Optimal
Flexible Architecture (OFA) guidelines (for example, ORACLE _
BASE\ORACLE_HOMEN\). If you specified non-OFA compliant
directories during installation, your directory paths will differ. See
section "OFA and Multiple Oracle Home Configurations” on

page 4-21 for information.

What to Do with Previous Oracle Database Releases

If you already have Oracle7, and/or Oracle8 databases on your computer and want
to install Release 8.1.6, the following options are available to you.

4-2

Install Release 8.1.6 in a separate Oracle home on the same computer (this
procedure is known as using multiple Oracle homes).

Note: Itis not possible to install Release 8.1.6 products into an
existing Oracle home created using the pre-8.1.5 Oracle Installer.

Migrate Release 7.x to Release 8.1.6.

Upgrade Release 8.0.x to Release 8.1.6.
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« Upgrade Release 8.1.5 to Release 8.1.6.

« Use Export/Import utilities to physically copy data in the previous database
release to a new Release 8.1.6 database.

If you are not sure what option is best for you, read the following overview
sections:

«  Multiple Oracle Homes Overview on page 4-3
« Migrating, Upgrading, and Downgrading Overview on page 4-4

«  Export/Import Overview on page 4-5

Multiple Oracle Homes Overview

An Oracle home is a directory location where you can install software. Multiple
Oracle homes functionality enables you to preserve your previous Release 7.x or
8.0.x databases in locations separate from where you will install Release 8.1.6.
Installing a new database release in a separate Oracle home allows you to test it
before migrating or upgrading your production databases to the new release. There
have been modifications to multiple Oracle home functionality since it was
introduced in Release 8.0.4. In particular, note:

= You cannot install Release 8.1.6 into an existing Oracle home that was created
using the old Oracle Installer.

» Releases 8.1.6 and later must be installed in separate Oracle homes. You cannot
have more than one release per Oracle home.
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Migrating, Upgrading, and Downgrading Overview

This section explains the difference between migrating, upgrading, and
downgrading, and lists the Oracle database versions that can be migrated or
upgraded.

What Is Migrating?

Migrating is the process of transforming an installed version of an Oracle database into
a later version. For example, transforming an Oracle7 database to an Oracle8i
database is migrating the database system.

Additional Information: See “Migrating an Oracle7 Database to
Oracle8i” on page 4-12.

What Is Upgrading?

Upgrading is the process of transforming an installed version of an Oracle database
release into another release of the same version. For example, transforming an Oracle8
database Release 8.0.4 to Release 8.1.6 is upgrading the database system.

Additional Information: See “Upgrading an Oracle8 Database
Release 8.0.x to 8.1.6” on page 4-30.

What Is Downgrading?

Downgrading is the process of transforming an installed version of an Oracle database
from a later release back into an earlier release. For example, transforming an Oracle
database from Release 8.1.6 back into Release 8.0.4 is downgrading, and
transforming an Oracle database from version 8 back into version 7 is
downgrading.

Additional Information: Chapter 10, “Downgrading to an Older
Version 8 Release” for information about downgrading to Release
8.0, or Chapter 11, “Downgrading to Version 7” for information
about downgrading to version 7 of Oracle8i Migration.

Migrating and Upgrading Using Multiple Oracle Homes

You can easily migrate or upgrade databases across multiple Oracle homes. If you
use the graphical user interface (GUI) Oracle Data Migration Assistant, the earlier
database instance on your system is displayed in a list box. You select the Oracle
database instance you want to migrate or upgrade and the assistant takes care of
any multiple Oracle homes issues.
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If you use the command line tool MIG to migrate, or a U*.SQL script to upgrade,
you need to copy files from one Oracle home directory to another. You must also
ensure the PATH variable is set correctly so that any Oracle database tools you run
are started from the correct Oracle home directory.

Additional Information: See “Changing the Value of PATH” on
page 4-8.

Checklist of Database Release Numbers

Check that your Oracle database release can be migrated or upgraded directly to .
This table provides a list of the database releases you can migrate or upgrade and
the tools you can use to perform these tasks:

Oracle Database Release Use This Tool...

Release 7.3.4.x «  MIG or Oracle Data Migration Assistant can migrate databases
that are Oracle7, Release 7.3.4.x or later to Release 8.1.6

Release 8.0.4.0.0 to 8.1.x «  SQL scripts executed in SQL*Plus can upgrade databases Release
8.0.4.0.0 to Release 8.1.6

«  Oracle Data Migration Assistant upgrades from Release 8.0.4.0.0
or later to Release 8.1.6

Release 8.1.51t0 8.1.6 «  SQL scripts executed in SQL*Plus can upgrade databases Release
8.1.5 to Release 8.1.6

Export/Import Overview
An alternative method of migrating or upgrading is to:

1. Export your data from the source database using the Export Utility (EXP). This
will physically copy the data to the export dump file.

2. Create an Oracle8i database into which you will import the exported data.

3. Import the exported data into the new Oracle8i database using the Import
Utility (IMP).

The Export Utility puts all of the data in one large binary file that might require
large amounts of disk space.

Installing, Migrating, and Upgrading Databases 4-5



Version 8 and Version 7 Client/Server Configurations

Additional Information: See "Choose a Migration Method" in
Chapter 2, "Preparing to Migrate" of Oracle8i Migration for
information on when to use the Export/Import utilities for
migrating a database. See “Export Utility (EXP)” on page 3-3 and
“Import Utility (IMP)” on page 3-3 for information on how to start
these utilities. See "Exporting an Existing Database" on page 6-8
and "Importing a Database” on page 6-18 for information on using
these tools on Windows 98.

Version 8 and Version 7 Client/Server Configurations

Oracle7 and Oracle8i clients can communicate either with Oracle7 or Oracle8i
databases. This functionality gives you maximum flexibility when designing your
network and deciding when to:

« Migrate an Oracle7 Database to an Oracle8i Database
« Upgrade an Oracle8 Database to the Current Oracle8i Database Release

« Migrating an Oracle7 Database to Oracle8i

Note: Itis not possible to install Release 8.1.6 products into an
existing Oracle home created using the pre-8.1.5 Oracle Installer.

Consider the following database coexistence issues before you decide which of the
above options is most suitable for your requirements:

« Oracle7 Database Applications
« Different Client and Database Release Considerations

«  Multi-Versioning

Oracle7 Database Applications

4-6

Most Oracle7 applications can run on an Oracle8i database. Some applications
cannot run on an Oracle8i database unless you upgrade them to versions that

support Oracle8i databases. Contact your application vendor to check if your

third-party applications are supported with .

Additional Information: See Chapter 8, “Upgrading Your
Applications” of Oracle8i Migration.
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Different Client and Database Release Considerations

Consider the following client to database connection issues before you decide if
upgrading or migrating is appropriate for your environment:

« Oracle8i Client Release 8.1 to Oracle8i Database Release 8.1
« Oracle8 Client Release 8.0/0racle7 Client to Oracle8i Database Release 8.1

« Oracle8i Client Release 8.1 to Oracle8 Release 8.0/0racle7 Databases

Oracle8i Client Release 8.1 to Oracle8i Database Release 8.1

As the following diagram depicts, an Oracle8i Client Release 8.1 requires Net8
Client Release 8.1, and Oracle8i Release 8.1 database requires Net8 Server Release
8.1.
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The Oracle8 Client Release 8.1 and clients must be configured with a service name,
as described in “Using the Local Naming Method” in Chapter 5, "Configuring the
Network" of Net8 Administrator’s Guide.

Oracle8 Client Release 8.0/Oracle7 Client to Oracle8i Database Release 8.1

As the following diagram depicts, an Oracle8 Client Release 8.0 requires a
compatible release of Net8 Client, an Oracle7 Client requires SQL*Net Client, and
an Oracle8 database Release 8.1 requires Net8 Server Release 8.1 to connect
successfully to an Oracle8i database Release 8.1.
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While it is not necessary to reconfigure Release 8.0 and Release 7.x clients with a
service name, Oracle Corporation recommends doing so to take advantage of new
functionality. For example, in the TNSNAMES.ORA file:

net_servi ce_nane =
(DESCR PTI ON\=
(ADDRESS =. . .)
§ADRESS =..)
( CONNECT_DATA=
(SERVI CE_NAME=SALES)
)

This effect may be accomplished by manually replacing SID=SID with SERVICE _
NAME=SERVICE_NAME or using the Net8 Assistant’s compatibility mode. See
“Using the Release 8.0/2.x Compatibility Mode” in Chapter 3 "Upgrading and
Migrating" of Net8 Administrator’s Guide.

Consider the following questions for an environment with Oracle7 clients
connecting to an Oracle8 Release 8.1 database:

= Will my third party Oracle7 applications be able to take advantage of Net8 features?
No. You must rebuild or upgrade applications to work with Net8 libraries.

« Do my Oracle7 clients require Net8 Client to connect to a remote Oracle8i database?
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No. If an Oracle7 client needs to connect to a remote Oracle8i database, only
SQL*Net Client Release 2.x has to be configured on the Oracle7 client. Net8 is
backward compatible with SQL*Net Release 2.x. The only limitation is that the
new network features available with Net8 are unavailable with this connection
type.

« Do my Oracle7 clients require Net8 Client to connect to a local Oracle8i database?
Yes. If the Oracle7 client needs to connect to a local Oracle8i database, you have
SQL*Net Client Release 2.x, Net8 Client, and Net8 Server in the same system.

Note that Net8 Client and Net8 Server are already installed during the
installation of Oracle8i or Oracle8.

If you are using Oracle7 Release 7.3.4 and SQL*Net Release 2.3.4, you can
connect to the local Oracle 8 database without specifying a service name. Oracle
7 client automatically uses the Bequeath Protocol Adapter when connecting to
an Oracle 8 database.

Oracle8i Client Release 8.1 to Oracle8 Release 8.0/Oracle7 Databases

An Oracle8 Client Release 8.1 requires Net8 Client Release 8.1, an Oracle7 Server
requires SQL*Net Server, and an Oracle8 Server Release 8.0 requires Net8 Server

Release 8.0.
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The Release 8.1 clients must be configured with the SID of the database. For
example, the TNSNAMES.ORA would have the following effect:

net_servi ce_nane =
(DESCR PTI ON\=
(ADDRESS =. . .)
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§NIFESS =..)
( GONNECT_DATA=
(S| D=SALES)

)
This effect may be accomplished by manually editing the TNSNAMES.ORA file or

using the Net8 Assistant’s compatibility mode. See "Using Release 8.0/7.x Features
and Connecting To a Release 8.0/7.x Service" in Chapter 3, "Upgrading and
Migrating"” of Net8 Administrator’s Guide.

Additionally, the LISTENER.ORA on the database server must still be configured
with the description of the SID, as described in "Statically Configuring a Listener"” in
Chapter 5, "Configuring the Network" of Net8 Administrator’s Guide.

Consider the following questions for an environment with Oracle8 clients Release
8.1 connecting to an Oracle7 database.

« Do my Oracle8 clients require SQL*Net Client Release 2.x to connect to a remote
Oracle7 database?

No. If an Oracle8 client needs to connect to a remote Oracle7 database, only Net8
Client needs to be configured on the Oracle8 client. SQL*Net Release 2.x is
upwards compatible with Net8. The only limitation is that the new network
features available with Net8 are unavailable with this connection type.

« Do my Oracle8 clients require SQL*Net Release 2.x to connect to a local Oracle7
database?

Yes. If the Oracle8 client needs to connect to a local Oracle7 database, you need
both SQL*Net Server Release 2.x and Net8 Client on the same system.

Additional Information: For more detailed information on
installing, migrating, and upgrading SQL*Net and Net8, see:

Chapter 4, "Installing, Upgrading, and Migrating Net8" in Oracle
Net8 Administrator’s Guide.

Multi-Versioning

Oracle8i Personal Edition Server Release 8.1.6 for Windows 98 supports multiple
Oracle Homes. You can run different versions of Oracle databases on the same
computer system at the same time. However, each version can only access a
database that is consistent with its version. For example, if you have Version 7
Server and Version 8 of Oracle installed on the same computer system, the Version 7
Server can access Version 7 databases, but not Version 8 databases, and the Version 8
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Server can access Version 8 databases but not Version 7 databases. The only way for
a Version 8 database to read Version 7 database files is to perform a migration. You
should be aware that after migration the Version 7 Server will no longer be able to
read the migrated databases.

Migrate an Oracle7 Database to an Oracle8i Database

You can migrate your Oracle7 database to an Oracle8i database and have both
Oracle7 and Oracle8i clients connecting to the Oracle8i database. You can not
migrate your Oracle7 database to an Oracle8i database in the same Oracle home.
See “Migrate an Oracle7 Database to an Oracle8i Database” on page 4-11 for
instructions. The following figure illustrates this network configuration:
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Upgrade an Oracle8 Database to the Current Oracle8i Database Release

You can upgrade your Oracle8 database, for example, Release 8.0.4, to Release 8.1.6
and have both Oracle7 and Oracle8 clients connecting to the Release 8.1.6 Oracle8i
database. You can upgrade databases either in the same Oracle home or across
different Oracle homes. See “Upgrading an Oracle8 Database Release 8.0.x to 8.1.6”
on page 4-30 for instructions. The following figure illustrates this network
configuration:
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Migrating an Oracle7 Database to Oracle8i

This section describes how to migrate an Oracle7 database to the current Oracle8i
database release. You can choose either of the following tools to perform a
migration:

» Oracle Data Migration Assistant
L ] MIG

Oracle Corporation recommends that new users use Oracle Data Migration
Assistant to migrate databases because it is the easiest method to perform a
migration. If you want to perform a migration manually using command line tools,
use MIG.

Before you start a migration using the assistant or MIG, read the following sections:

Ten Issues That Can Affect Oracle7 to Oracle8i Migration

The following table lists and describes the ten issues you should be aware of that
can affect Oracle7 to Oracle8i migration.
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Issues That Affect Migration

Description

1.

Running out of space

« Version 8 binaries may require as much as three times the disk space
required by version 7 binaries. This requirement may cause you to
run out of disk space during migration. It is very important that you
read "System Considerations and Requirements" and "Prepare the
Version7 Source Database for Migration" in Oracle8i Migration to find
out more about this and other requirements before you migrate.

« During migration, the data dictionary requires 50% more space to
hold both Oracle7 and Oracle8i data dictionaries. Actual usage can be
verified by running MIG in CHECK_ONLY mode.

2.

Duration of migration is
unrelated to database size

The time it takes to migrate is not dependent on the size of the database,
but on the number of objects in the data dictionary. For example, actual
migration for a 3 1/2 GB database with 25,473 objects on a Sun E6000 with
20 CPUs, with datafiles stripped on the file system on 128 KB slices can
take 1 1/2 hours. Remember to allow extra time for backing up and
restoring database in case of problems.

3.

Avoiding problem areas

«  Check for usage of ROWIDs in both user columns as well as
application code (including triggers & packaged procedures). These
may require to be converted to use the DBMS_ROWID package.

«  Check the names of any Oracle7 database objects (for example, tables
and columns) that use names that are key words or reserved words
for Oracle8i. Usage of key words and reserved words can cause
unexpected failures during migration. See Appendix C, "Oracle
Reserved Words" of Oracle8i SQL Reference for a list of reserved words.

«  Certain version 7 initialization parameters are obsolete in version 8.
Remove all obsolete parameters from the Release 7.x INITSID.ORA
file that start a version 8 instance. Obsolete parameters may cause
errors if used with a version 8 database. Also, alter any parameter
whose syntax has changed in version 8. See Appendix B, "Changes to
Initialization Parameters" of Oracle8i Migration for lists of new,
changed, and obsolete parameters.

4.

Compatibility

Make sure that all Oracle product versions, operating system versions,
and third-party software versions are certified against Oracle8i.
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Issues That Affect Migration

Description

5.

Invalid objects and lost
statistics

Migration leaves all objects (packages, triggers, views, and so on) invalid
except for tables. All other objects must be made valid again by
recompilation. This can either be done manually (preferably by building a
dependency tree before migration from dependency), otherwise this is
done automatically as the objects are first accessed. The latter will of
course slow down initial access. All estimated or calculated statistics are
lost during migration. These need to be recalculated to ensure proper
functionality of the Cost Based Optimizer. Some bitmapped indexes will
get invalidated. Check all bitmapped indexes in the DBA_INDEXES table
and recreate any that are marked as status unusable.

Editing the registry

If you edit the registry for any reason during the migration process, you
need to reboot your computer.

Read-only tablespace
confusions

Oracle7 read-only tablespaces are readable by Oracle8i and do not require
any conversion. But to prevent Oracle8i rowid conversions to take place
every time a table is accessed, the tablespaces in read-only mode should be
made read-write. Perform full table scans on all tables in the tablespace.
After the full table scans are complete, you can put the tablespaces in
read-only mode again.

The point of no return

You can return the database to an Oracle7 version up until the ALTER
DATABASE CONVERT command is run. If a failure occurs during ALTER
DATABASE CONVERT (when it is converting the physical file headers of
the datafiles), you must restore the database from backup and rerun the
migration. Do not open the database between running the migration and
executing the ALTER DATABASE CONVERT command.

Preventing large restores

To avoid restoring the entire database due to any failures during the
ALTER DATABASE CONVERT, put all tablespaces, except SYSTEM and
ROLLBACK into read-only or offline normal mode. This causes the
ALTER DATABASE CONVERT command to only convert the datafile
headers for SYSTEM and ROLLBACK. If any errors occur, you need only
restore the datafiles for the SYSTEM and ROLLBACK and rerun the
migration. If the migration is successful, the headers for the rest of the
datafiles will be converted when they are read-write or online.

10.

Testing

Most migration problems can be avoided if a test migration is performed
first. Performing a test migration helps raise any problems that can occur
as well as letting you see the amount of time it takes to migrate. See "Test
the Migration Process" in Chapter 2, "Preparing to Migrate" in Oracle8i
Migration.

4-14

Installing Appropriate Versions of SQL*Net

When migrating from Oracle7 Server Release 7.3.x to Oracle8i Release 8.1.6, install
the appropriate version of SQL*Net in the 7.3.x Oracle home before using Oracle
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Data Migration Assistant or MIG. Migration will be unsuccessful if you do not
install the appropriate versions of SQL*Net.

Migrating Using Oracle Data Migration Assistant

Oracle Data Migration Assistant helps you migrate data from an Oracle7 database
to an Oracle8i database. During installation of Oracle8i Personal Edition, you are
prompted to migrate a database with this assistant if Oracle Universal Installer
detects that an earlier database release exists on your computer. If you do not want
to migrate a database, uninstall the existing Oracle database, before installing the
new database.

What To Do Before Using Oracle Data Migration Assistant
Complete the following steps before you use this assistant:
« Read Chapter 4, "Migration Using the Oracle Data Migration Assistant” in

Oracle8i Migration for background information before starting the migration
process.

IMPORTANT: Version 8i binaries may require as much as three
times the disk space required by version 7 binaries. This
requirement may cause you to run out of disk space during
migration. It is very important that you read "System
Considerations and Requirements"” and "Prepare the Version7
Source Database for Migration™ to find out more about this and
other requirements before you migrate.

« Ensure SQL*Net Server Release 2.x or later is installed.
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To migrate a database using Oracle Data Migration Assistant:

1. Choose Start > Programs > Oracle - HOME_NAME > Migration Utilities >
Oracle Data Migration Assistant.

The following window appears:
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2. Respond to instructions in each Oracle Data Migration Assistant window, and
click Next when you are ready to continue to the next window. When you get to
the last window, click Next to start the migration of the database. More
documentation on this product can be accessed by clicking Help.

Migrating Using MIG
This section describes how to use MIG to migrate your Oracle7 database to an
Oracle8i database.

Note: Information on how to run MIG (sometimes referred to as
the Migration Utility) is provided in Oracle8i Migration, but the
focus is on UNIX. This section provides information on using MIG
on Windows 98.
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To migrate an Oracle7 database using MIG:
Step 1: What To Do Before Using MIG

Step 2: Shut Down the Oracle7 Database
Step 3: Back Up the Oracle7 Database

Step 4: Install MIG from CD-ROM

Step 5: Run MIG

Step 6: Create Oracle8i Database Files

Step 7: Remove Oracle7 Software (Optional)

Step 1: What To Do Before Using MIG

Complete the following steps before you use MIG:

« Review Migration Concepts

« Use Appropriate SQL*DBA or SQL*Plus Versions
« Check Database To Be Migrated Version Number
= Check Character Set

Review Migration Concepts

« Read Chapter 1, "Overview" and Chapter 2, "Preparing to Migrate” in Oracle8i
Migration for background information before starting the migration process.

« Read “System Considerations and Requirements” and “Prepare the Version7
Source Database for Migration” in Chapter 3 “Migrating Using the Migration
Utility” of Oracle8i Migration for information on tasks you must perform before
using MIG.

IMPORTANT: Version 8 binaries may require as much as three
times the disk space required by version 7 binaries. This
requirement may cause you to run out of disk space during
migration. It is very important that you read “System
Considerations and Requirements” and “Prepare the Version7
Source Database for Migration” to find out more about this and
other requirements before you migrate.
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Use Appropriate SQL*Plus Versions

When you are asked to enter commands at the SQL*Plus prompt, remember to use
the appropriate version of the tool for the version of Oracle7 Server you are

migrating:
Use... When Migrating From...
SVRMGR23 Oracle7 Release 7.3.x

Check Database To Be Migrated Version Number

Check that your database release can be directly migrated to Oracle8i Personal
Edition. MIG only migrates databases that are Oracle7 Release 7.3.x or later.

Check Character Set

1. Check the character set of your Oracle7 database, and compare it with the
character set in the NLS_LANG environment variable, or in the registry (if the
character set does not exist as an environment variable).

2. Start SQL*Plus at the MS-DOS command prompt. If you are migrating from:

Oracle7 Release... Enter at the MS-DOS Command Prompt...

7.3.X C.\ > SVRMER23

3. Connect to the Oracle7 database as INTERNAL, where PASSWORD is the
password of the database you want to migrate:

Oracle7 Release... Enter at the SQLDBA or SQLPLUS Command Prompt...

7.3.X SQ.> CONNECT | NTERNAL/ PASSVORD

4. Obtain the value of NLS_CHARACTERSET:

Oracle7 Release... Enter at the SQLDBA or SQLPLUS Command Prompt...

7.3.x SQL> SELECT VALUE FROM NLS DATABASE
PARAMETERS WHERE PARAMETER='NLS__
CHARACTERSET;
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The character set value is returned by the database. If the character sets are
identical, then you can proceed to run MIG.

If the character sets are different, before you run MIG, you must set the NLS_
LANG environment variable at the MS-DOS command prompt as follows:

AMERICAN_AMERICA .database character set

where database character set is substituted with the character set of your Oracle7
database. For example, if the character set of your Oracle7 database is JAI6EUC,
set the NLS_LANG environment variable as follows:

C\> SET NLS LANG-AMER CAN AMER CA JA16BUC

Messages output from MIG will now be in English. After MIG finishes, reset the
NLS_LANG environment variable to its original value.

Step 2: Shut Down the Oracle7 Database

Shut down the database. Do not use SHUTDOWN IMMEDIATE or SHUTDOWN
ABORT. If the database is not shut down before you start the migration, MIG stops
and issues an error message. Also, if the database is not cleanly shutdown, any
backup you make may be useless as it was taken while data was being written to
the data files.

1. Start SQL*Plus:

Oracle7 Release... Enter at the MS-DOS Command Prompt...
7.3.x C:\> SQLPLUS

2. Connect to the Oracle7 database as INTERNAL, where PASSWORD is the
password of the database you want to migrate:

Oracle7 Release... Enter at the SQLPLUS Command Prompt...
7.3.X SQ.> CONNECT | NTERNAL/ PASSVORD

The message Connected. appears if you successfully connected to the database.
3. Shut down the database:
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Oracle7 Release... Enter at the SQLPLUS Command Prompt...

7.3 SQL> SHUTDOMN

Step 3: Back Up the Oracle7 Database
Back up the entire Oracle home directory and all its subdirectories.

WARNING: If anything goes wrong with the Oracle7 database
during migration, you will need to restore the database from the
backup. Back up your database now as a precaution!

Ensure the database was cleanly shut down before you back up. Ensure you
back up the database files in the following list (and any other database files you
may have created). Also, back up any scripts you may have created.

. Datafiles SYS1SD.ORA, USR1SD.ORA,
RBS19D.ORA, TMP1SD.ORA
« Initialization parameter file INITSID.ORA

- Redo log files LOG19D.0ORA, LOG2SD.ORA,
LOG39D.ORA, LOG4ASD.ORA

(the last two redo log files are only available for
Oracle Release 7.3.4)

. Control files CTL19D.ORA and CTL29D.ORA

To obtain the list of database files you must back up:
a. Create a spool file called V7DBFILES.LOG:

Oracle7 Release... Enter at the SQLPLUS Command Prompt...

7.3.X SQ.> SPOOL V7DBFI LES. LOG

b. Enter the following commands at the SQL*DBA or SQL*Plus prompt where
the WHERE clause equals counteroffers, DB_FILES, or LOG_FILES. Note
that counteroffers must be lowercase. The list of database files is output to
V7DBFILES.LOG.

4-20 Oracle8i Personal Edition Administrator’s Guide for Windows 98



Migrating an Oracle7 Database to Oracle8i

Oracle7 Release... Enter at the SQLPLUS Command Prompt...

7.3.X SQL> SELECT MEMBER FROM V$LOGFI LE;
SQL> SELECT NAME FROM V$DATAFI LE;
SQL> SELECT VALUE FROM V$PARAMETER WHERE
NAME = 'control _files’;

c. Turn off the SPOOL command:

Oracle7 Release... Enter at the SQLPLUS Command Prompt...
7.3.x SQL> SPOOL OFF

See "Backing Up and Recovering Database Files" on page 12-1, Oracle8 Concepts,
Oracle8 Backup and Recovery Guide, and Oracle8i Administrator’s Guide for
information on how to back up a database.

Step 4: Install MIG from CD-ROM

You can install MIG in either of two ways depending if you want to install the
Release 8.1.6 software that includes MIG or just MIG.

Note: The following installation steps are a shorter version of the
complete installation instructions you can find in Oracle8i
Enterprise Edition Installation for Windows NT.

To install the , including MIG:

1.

Run Oracle Universal Installer.
The File Locations dialog box appears.

a. Enter the name of a new Oracle home in the Oracle Home Name: text box.
For example, enter MIGTO8L1.

b. Enter the location of the Oracle home directory where you want to install
the Oracle8i product. In this example, enter C:\ORACLE\ORAZS8L1 in the
Location: text box.

c. Click Next.
The Available Products dialog box appears.

Select Typical Installation, and click Next.
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The Upgrading and Migrating an Existing Database dialog box appears, telling you
that a previous Oracle database is detected on your computer. The dialog asks if
you want to migrate your older database to the current release using Oracle
Data Migration Assistant.

3. Check the check box to migrate the previous version of database and then click
Next.

4. The Location for Oracle Documentation dialog box appears, asking if you want to
install the documentation onto your hard drive or keep the documentation on
your CD-ROM.

Select a documentation option, and click Next.
The Summary window appears.

5. Click Install.
The Configuration Tools window appears.

DBMA window will pop-up. Click Cancel. Configration tool will show DBMA
Has failed, but that is OK.

6. Click Next.

The End of Installation window appears.

Click Exit.

MIG has been installed as part of Oracle Utilities.
If you just want to install MIG, perform the following steps:
1. Run Oracle Universal Installer.

The File Locations dialog box appears.

a. Enter the name of a new Oracle home in the Oracle Home Mans text box.
For example, enter MIGTO8L1.

b. Enter the location of the Oracle home directory where you want to install
MIG. In this example, enter C:\ORACLE\ORAS8L1 in the Location: text box.

c. Click Next.
The Available Products dialog box appears.

2. Select Oracle8i Personal Edition, then click Next.
The Installation Types dialog box appears.

3. Select Custom.
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The Available Product Components dialog box appears.
Click Oracle Utilities, of which MIG is a component.
Click Next.

The Summary window appears.

Click Install.

The Configuration Tools window appears.

Click Next.

The End of Installation window appears.

Click Exit to quit Oracle Universal Installer.

MIG is located in C:\ORACLE\ORASI\BIN.

Step 5: Run MIG
There are some tasks that you may have to perform before you run MIG.

1.
2.

Ensure that you have DBA privileges, which are necessary to run MIG.

Ensure that SQL*Net version 2.x is installed in the Oracle home directory of the
database you are migrating. If it is not installed, MIG will be unable to connect
to the Oracle7 database. You will receive the error ORA-12203: TNS: Unable to
connect to destination, if this is the case. If this product is not installed, install it
from the Oracle8i Personal Edition CD-ROM. See "Installing Appropriate
Versions of SQL*Net" on page 4-14 for more information.

Ensure that no other DBA (connected as INTERNAL or SYS) with the
RESTRICTED SESSION privilege connects to the database while MIG is
running. Normal users cannot connect to the database during this phase.

Do not start the Oracle7 database. MIG starts the Oracle7 database as part of its
processing.

Enter at the MS-DOS command prompt:

PersonalOracle7 Release... Enter at the MS-DOS Command Prompt...

7.3 C:\> ORAVER 73
C:\> ORAAUTCS OFF
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6. Set ORACLE_SID to the SID of the database you want to migrate. For example,
if the database you want to migrate is the starter database with the SID named
ORCL, enter the following at the MS-DOS command prompt. Note there are no
spaces around the equal sign (=) character.

C\> SET (RACLE S D=CRL

7. Run MIG. You can enter MIG HELP=YES at the MS-DOS command prompt for
a complete list of parameters that can be included with the MIG command. You
must include the PFILE parameter to specify the exact location of the version 7
INITSID.ORA file because MIG is in a different directory from the version 7
initialization parameter file. Ensure you specify the complete pathname of
ORACLE_HOME including drive letter.

C\> MG PH LEEQRAQLE HOMB DATABASE\ IN TS D GRA SPAOL=C \M G LGG

The MIG command creates the MIGSID.ORA file that is required in a later step
to create Oracle8i Personal Edition control files.

8. If the prompt for Oracle7 Password: appears, enter the same password as the
INTERNAL password for the Oracle7 database. This prompt displays because
the DBA_AUTHORIZATION registry parameter is not set properly or not set at
all for Oracle?.

MIG runs and displays the operations being performed. MIG can take
considerable time to run. Please wait until it has finished running.

Check the results after running MIG. If there are error messages, see Appendix
A, "Troubleshooting Migration Problems" of Oracle8i Migration for more
information before going to Step 9.

9. Stop the Oracle7 database at the MS-DOS command prompt when MIG has
completed successfully:

C\> KN\LSTCP

MIG creates a convert file that contains the information of the version 7 control
file. Later in the migration process, the convert file is used when you execute
the ALTER DATABASE CONVERT command to create a new control file for
version 8.

The default location of the convert file is ORACLE_BASE\ORACLE_
HOME\RDBMS where ORACLE_HOME is the version 8 Oracle home. The
default filename is CONVERT.ORA.
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WARNING: Do not open the Oracle7 database, which was shut
down by the version 8 MIG utility. To ensure data file version
integrity, the SCNs in the dictionary, the convert file, and file
header must all be consistent when the database is converted to
version 8. If the Oracle7 database is opened after running MIG,
the SCN check will fail when the database is converted to version
8, and an ORA-01211 error will be displayed, stating "Oracle7
data file is not from migration to Oracle8i." If the Oracle7
database is opened, you must rerun the Migration Utility, starting
at "Step 2: Shut Down the Oracle7 Database".

After successfully running MIG, perform a cold backup of the Oracle7 database.
This backup serves the following purposes:

If you want to return to the Oracle7 database after executing the ALTER
DATABASE CONVERT command, you can restore the backup and start the
version 7 database.

It can be used as the first version 8 backup for a version 8 recovery.

If an error occurs at version 8 database convert time (ALTER DATABASE
CONVERT or ALTER DATABASE OPEN RESETLOGS), you can restore this
backup, fix the problem(s), and continue the conversion process. However,
if you restore a backup performed before you ran MIG, you must rerun
MIG.

Additional Information: See Chapter 10, "Developing
Applications", Oracle8 Concepts, Oracle8 Backup and Recovery Guide,
and Oracle8i Administrator’s Guide for information on how to back
up a database.

Step 6: Create Oracle8i Database Files

If you have not already installed the Oracle8i software, do so now. Do not install
a database when prompted.

Edit the INITSID.ORA initialization parameter file:

1.

a.

Comment out the existing CONTROL_FILES entry by entering a hash (#)
mark in front of the line:

#OONTROL_FI LES = QRAALE_ HOMB DATABASE\ CTL1S D CRA

where:
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« ORACLE_HOME isthefull path name of your Oracle home directory where
the INITSID.ORA file exists

» CTL19D.ORA isthe file name of your Personal Oracle7 database control file.
SID isthe unique value identifying your Personal Oracle7 database instance

b. Add two new entries:
1. CONTROL_FI LE = ORACLE HOVE\ DATABASE\ NEWCONTROL. ORA
where:

« ORACLE_HOME isthefull path name of your Oracle home directory where
the INITSID.ORA file exists

«  NEWCONTROL.ORA isthe file name of your Oracle8i Personal Edition
database control file. SID is the unique value identifying your Oracle8i
Personal Edition database instance

2. DI SK_ASYCH | O = FALSE

See Oracle8 Reference for a complete description of the DISK_ASYNCH_IO
parameter and other initialization parameters.

c. Enter at the MS-DOS command prompt:
C\> CRAVRR 80

3. Check the file V7DBFILES.LOG that you created in "Step 3: Back Up the
Oracle7 Database" for the complete list and location of control files you must
delete.

4. Before starting SQL*Plus:

a. Ensure all Release 7.x data files and log files are accessible and in the correct
directories.

b. Ensure all Release 7.x control files are deleted or renamed.

c. Change any parameters that point to RDBMS72, or RDBMS73 to point to
RDBMS in the Release 7.x INITSID.ORA file.

d. Certain version 7 initialization parameters are obsolete in version 8.
Remove all obsolete parameters from the Release 7.x INITSID.ORA file that
start a version 8 instance. Obsolete parameters may cause errors if used
with a version 8 database. Also, alter any parameter whose syntax has
changed in version 8. See Appendix B, "Changes to Initialization
Parameters” of Oracle8i Migration for lists of new, changed, and obsolete
parameters.
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e. Ensure the COMPATIBLE parameter is set to 8.0.5.0.0 in the Release 7.x
INITSID.ORA file. Set the COMPATIBLE parameter to the following:

QOMPATI BLE=8.0.5.0.0
Additional Information: Some new features of Oracle8i Release
8.1.x require a compatibility setting of 8.1.0 or higher. See Chapter 8,

"Compatibility and Interoperability” of Oracle8i Migration for more
information.

Start the Oracle8i Personal Edition version of SQL*Plus at the MS-DOS
command prompt:

C\> SQPLWS

Connect to the Oracle8i instance as INTERNAL:

SQ> CONNECT | NTER\AL/ PASSWIFD

Start an Oracle8i instance without mounting the new Oracle8i database:
SQ > STARTUP NOMOUNT PH LEEGRAQLE HOMEL DATABASE\ IN TS D CRA

Warning: Starting in any other mode will corrupt the database!

Create new version 8 control files:
SQA> ALTER DATABASE GONVERT;

Warning: Successful execution of this command is the point of
no return to Oracle?. If you need to return to the Oracle7
database, please restore it from the backup you made in "Step 3:
Back Up the Oracle7 Database". If an error occurs during this
step, you must correct the condition(s) that caused the error(s).

This command uses the MIGSID.ORA file that was created earlier when you
ran MIG. All data files that are online are converted to Oracle8i Personal
Edition format, and new control files are built. Control files are considerably
larger in version 8 than in version 7. Control files in the tens of kilobytes size
range in version 7 could be expanded into the range of tens of megabytes
automatically during migration to version 8. This size increase could be
important if a control file is on a raw device or if its available disk space is
restricted.
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9. Open the Oracle8i database:
Q> ALTER DATABASE CPEN RESETLGSS,

All rollback segments that are online when the Oracle8i database is opened are
also opened and converted to the Oracle8i database format.

10. Create a spool file called CATOUT.LOG by entering the following at the
SQL*Plus prompt:

Q> SPOOL CATAUT, LOG

11. Run the following scripts in sequence:

Script Required by... Enter at the SQL*Plus Prompt...

U0703040.SQL All databases SQL> @ORACLE_HOVE% RDBMS\ ADM N\ U0703040. SQL

where %ORACLE_HOME% represents your drive letter and Release
8.1.6 Oracle home directory. This script can take over thirty minutes
to run depending on the size of your database. Check CATOUT.LOG
to verify that the operation was successful.

U0703040.SQL creates and alters certain system tables and drops the
MIGRATE user. Objects in the MIGRATE user’s schema are not
needed after the conversion is complete. You can also delete the
binary file (ORACLE_HOME\RDBMS\CONVERT.ORA) that is used
as part of the conversion process.

U0703040.SQL also runs the CATALOG.SQL and CATPROC.SQL
scripts, which create the system catalog views and all the necessary
packages for using PL/SQL.

Note: If the U0703040.SQL script runs for an inordinately long time,
it may be caused by a setting for LARGE_POOL_SIZE that is too
large for your installation. Use the VSPARAMETER view to check the
setting for LARGE_POOL_SIZE, and if it is too large, setitto a
smaller value in your INITSID.ORA file.

UTLRP.SQL All databases SQL> @©ORACLE_HOVE% RDBVS\ ADM N\ UTLRP. SQL

where %ORACLE_HOME% represents your drive letter and Release
8.1.6 Oracle home directory.

Oracle Corporation recommends you run this script to compile all
existing PL/SQL modules that were previously in an INVALID state,
such as packages, procedures, types, and so on. Doing this at this
stage is optional; however, it will ensure that the cost of
recompilation is incurred during installation time rather than later
on.
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12.

13.

14.

15.

16.

Oracle Corporation supplies other scripts with Oracle8i Personal Edition that
create additional structures you can use in managing your database and
creating database applications. These scripts are also located in ORACLE_
HOME\RDBMS\ADMIN. See the chapter "SQL*Scripts" in Oracle8 Reference for
a complete list and descriptions of available scripts.

Turn off the SPOOL command:
Q> SPaL OFF

Check the spool file CATOUT.LOG and verify that the scripts you ran compiled
every package and procedure successfully. Correct any problems you find in
this file.

Shut down the Oracle8i database in NORMAL mode to perform a clean
database shutdown. Do not use SHUTDOWN IMMEDIATE or SHUTDOWN
ABORT. Note that NORMAL is the default parameter.

Q> SHUTDOM

Performing a clean database shutdown flushes all caches, clears buffers, and
performs other Relational Database Management System (RDBMS)
housekeeping activities. These measures are an important final step to ensure
the integrity and consistency of the newly migrated Release 8.1.6 database.

Back up the Oracle8i database. See Chapter 10, "Developing Applications™ for a
list of tools to back up the database.

The Oracle7 database has now been migrated to the Oracle8i database and is
ready for use.

Note: After a migration, all objects have the status INVALID,
unless you have run the UTLRP.SQL script. To check the status of
objects, enter the following at the SQL*Plus prompt.

SQL> SELECT * FROM ALL_OBJECTS WHERE STATUS =
‘INVALID’;

Complete the procedures described in Chapter 5, "After Migrating the
Database" of Oracle8i Migration.
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WARNING: If you retain the old version 7 software, never start the
migrated database with the old version 7 software. Only start the
database with the executables in the new version 8 installation
directory.

Step 7: Remove Oracle7 Software (Optional)

You can remove Oracle7 software if you have successfully migrated to Oracle8i
Personal Edition and have a backup of the Oracle7 software. Oracle Installer warns
you of any product dependencies that might cause problems if particular products
are removed, and prompts you to confirm the deinstallation.

To remove Oracle7 software:
1. Stop all Oracle executible (e.g.Listner) if running.

2. Choose Start > Programs > Oracle for Windows 95 >ORACLE_HOME > Oracle
Installer to start Oracle Installer.

The Software Asset Manager window appears.

3. Select the Oracle7 product(s) you want to remove from the Installed Products
window of the Software Asset Manager window.

4. Click Remove.

Upgrading an Oracle8 Database Release 8.0.x to 8.1.6

This section describes how to upgrade an Oracle8 database Release 8.0.x to Release
8.1.6. You can choose either of the following database tools to upgrade:

« Oracle Data Migration Assistant
«  SQL scripts

Oracle Corporation recommends that new users use Oracle Data Migration
Assistant to upgrade databases because it is the easiest and quickest method to
perform an upgrade. If you already have upgrade scripts from a previous Oracle
database release, you can edit them to include the new upgrading scripts.
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Upgrading Using Oracle Data Migration Assistant

Oracle Data Migration Assistant helps you upgrade data from an Oracle8 database
Release 8.0.x to Release 8.1.6. During installation of Oracle8i Personal Edition, you
are prompted to upgrade a database with this assistant if Oracle Universal Installer
detects that a Release 8.0.x database exists on your system. If you do not want to
upgrade during the installation process, you can just install this assistant and use it
later.

Note: Oracle Data Migration Assistant cannot be used to upgrade
the following releases:

« Oracle? releases. For example, you cannot use the assistant to
upgrade from Release 7.1.3.3.6 to Release 7.3.3.0.0. If you need
to upgrade version 7 releases, see Oracle7 Server Migration Guide
and the upgrading documentation that came with your Oracle7
software.

Before you use this assistant, ensure the Oracle8 database to be upgraded meets
these requirements:

« the database you want to upgrade is at least Release 8.0.3.0.0
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To upgrade a database using Oracle Data Migration Assistant:

1. Choose Start > Programs > Oracle - HOME_NAME > Migration Utilities >
Oracle Data Migration Assistant.

The following window appears:
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2. Respond to instructions in each Oracle Data Migration Assistant window, then
click Next when you are ready to continue to the next window. When you get to
the last window, click Next to start the upgrade of the database. More
documentation on this product can be accessed by clicking Help.

Upgrading Using SQL Scripts

You can run SQL scripts in SQL*Plus to upgrade an Oracle8 database Release 8.0.x
to Release 8.1.6.

Warning: If you are using mutually referencing types,
downgrading back to your current release may not be supported
after you upgrade to Release 8.1.6. See the section "Downgrading
From Release 8.0.5 to Release 8.0.x" of the READMEMIG.DOC
located in the ORACLE_HOME\RDBMS directory for more
information.
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Upgrading consists of the following tasks:

Step 1: Shut Down the Release 8.0.x Database

Step 2: Back Up the Release 8.0.x Database
Step 3: Edit the COMPATIBLE Parameter in the 8.0.x INITSID.ORA File

Step 4: Install Oracle8i Personal Edition Release 8.1.6
Step 5: Run the SQL Scripts

Step 1: Shut Down the Release 8.0.x Database

1.

Start SQL*Plus at the MS-DOS command prompt:
C\> SQPLWsS

Connect to the Release 8.0.x database as INTERNAL, where PASSWORD is the
password of the database you want to migrate:

SQ > QONNECT | NTERNAL/ PASSWRD
The message Connected. appears if you successfully connected to the database.

Shut down the database in NORMAL mode. Do not use SHUTDOWN
IMMEDIATE or SHUTDOWN ABORT. If the database is not cleanly shutdown,
any backup you make may be useless as it was taken while data was being
written to the data files. Note that NORMAL is the default mode. Enter the
following at the SQL*Plus prompt:

Q> SHUTDOM

Step 2: Back Up the Release 8.0.x Database
Perform a full offline backup of the database.

1.

Back up the entire Oracle home directory and all of its subdirectories.

Warning: If anything goes wrong with the Release 8.0.x database
during upgrade, you will need to restore the database from the
backup. Back up your database now as a precaution!

Ensure the database is cleanly shutdown before you back up. Ensure you back
up the database files in the following list (and any other database files you may
have created). Also, back up any scripts you may have created.
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Data files SYS1SD.ORA, USR1SD.ORA, RBS19D.ORA,
TMP19D.ORA

Initialization parameter  INITSD.ORA

file

Redo log files LOG19D.ORA, LOG2SD.ORA

Control files CTL19D.ORA

To obtain the list of database files you must back up:

a.

Create a spool file called VBDBFILES.LOG. Enter the following at the
SQL*Plus prompt:

SQA> SPOL VBDBFI LES. LG5

Enter the following commands at the SQL*Plus prompt, where the WHERE
clause equals control_files, DB_FILES, or LOG_FILES. Note that control_
files must be lowercase. The list of database files is output to
V8DBFILES.LOG.

SQ> SHECT MEMBER FROM VBLOF LE,
SQ > SHECT NAME FROM VBDATAH LE
SQ> SHECT VALLE FROM VBPARAMETER WHERE NAME = "control _files’;

Turn off the SPOOL command:
Q> SPOOL GFF

See Chapter 10, "Developing Applications”, Oracle8 Concepts, Oracle8 Backup and
Recovery Guide, and Oracle8i Administrator’s Guide for information on how to
back up a database.

Step 3: Edit the COMPATIBLE Parameter in the 8.0.x INITSID.ORA File

Ensure the COMPATIBLE parameter is left unset if it has not been set in the
INITSID.ORA file. Leave the COMPATIBLE parameter unchanged if it has been
previously set.

Additional Information: Some new features of Oracle8i Release
8.1.x require a compatibility setting of 8.1.0. See Chapter 7
"Compatibility and Interoperability” of Oracle8i Migration for more
information.
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Step 4: Install Oracle8i Personal Edition Release 8.1.6

1.
2.

Ensure Oracle database has been shutdown and listner has been stopped.
The Autorun dialog box appears and prompts you to make a selection:

« Add/Remove Products

« Explore CD

« Browse Information

Click Add/Remove Products.

The Oracle Universal Installer Welcome dialog box appears.

Click Next. The Oracle License Terms dialog box appears.

Click "I accept the License Terms and Export Restrictions." If you do not accept
the terms, you cannot proceed with the installation.

The File Locations dialog box appears. Do not change the text in the Source... text
box. This is the location of files for installation.

a. Enter the name of a new Oracle home in the Destination Name: text box. In
this example, enter TEST81.

b. Enter the location of the Oracle home directory where you want to install
Release 8.1.6. In this example, enter C:\ORACLE\ORAB8L in the Path: text
box. You must install the Release 8.1 software into a directory that is
separate from your Release 8.0 Oracle home. Installing the Release 8.1
software into the same Oracle home as the Release 8.0 software is not
supported in Release 8.1.

c. Click Next.
The Available Products dialog box appears.
Select Typical Installation, and click Next.

The Upgrading and Migrating an Existing Database dialog box appears, telling you
that a previous Oracle database is detected on your computer. The dialog asks if
you want to migrate your older database to the current release using Oracle
Data Migration Assistant.

Check the check box to migrate the previous version of database and then click
Next.
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10.

11.

12.
13.

14.

The Location for Oracle Documentation dialog box appears, asking if you want to
install the documentation onto your hard drive or keep the documentation on
your CD-ROM.

Select a documentation option, and click Next.
The Summary window appears.

Click Install.

The Configuration Tools window appears.

DBMA window will pop-up. Click Cancel. Configration tool will show DBMA
Has failed, but that is OK.

Click Next.
The End of Installation window appears.

After installation is complete, copy the Release 8.0.x INITSID.ORA file from the
Release 8.0.x ORACLE_HOMEN\DATABASE directory to the Release 8.1.6
ORACLE_BASE\ORACLE_HOME\DATABASE directory.

Shut down and restart the computer.

Certain Release 8.0 initialization parameters are obsolete in Release 8.1. Remove
all obsolete parameters from any initialization parameter file that will start a
Release 8.1 instance; obsolete parameters may cause errors in Release 8.1. Also,
alter any parameter whose syntax has changed in Release 8.1. See Appendix B,
"Changes to Initialization Parameters” of Oracle8i Migration for lists of new,
renamed, and obsolete parameters.

If you are updating snapshots automatically by using the JOB_QUEUE _
PROCESSES initialization parameter, comment out this parameter in the
INITSID.ORA file. After upgrading your database, you can remove the
comments to use the parameter normally.

Step 5: Run the SQL Scripts

1.

Set ORACLE_SID to the SID of the Release 8.0.x database you want to upgrade.
For example, if the database you are upgrading is the starter database with a
SID of ORCL, enter the following at the MS-DOS command prompt. Note there
are no spaces around the equal sign (=) character.

C\> SET (RACLE S D=CRQL
Start SQL*Plus at the MS-DOS command prompt:
C\> SQAPLWB

4-36 Oracle8/ Personal Edition Administrator’s Guide for Windows 98



Upgrading an Oracle8 Database Release 8.0.x to 8.1.6

3. Connect to the Release 8.0.x Oracle8 instance as INTERNAL:
SQ> CONNECT | NTERNAL/ PASSWRD

4. Run STARTUP RESTRICT:
Q> STARTUP RESTR CT

Note: STARTUP RESTRICT only applies to a single instance, not
to the database.

5. Create a spool file called UPGRADE.LOG:
SQA> SPOOL WPGRACE LGG

6. Run the following scripts:

To Upgrade... Run Script?! Enter at the SQL*Plus Prompt...
8.0.4.00r8.0.41 U0800040.SQL  SQL> @®ORACLE_HOVE% RDBMS\ ADM N\ U0800040. SQL
0816 where %0RACLE_HOVE%orepresents your drive letter and Release 8.1.6

Oracle home directory.

1 The CATALOG.SQL and CATPROC.SQL scripts, which create the system catalog views and all the necessary packages for using
PL/SQL, are run whenever you execute any of these U*.SQL scripts.
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7.

10.

Note:

= You must use the version of the script supplied with the
Release 8.1.6 installation.

= You must run the script in the Release 8.1.6 environment.

« You only need to run one script, even if your upgrade spans
several releases. For example, if your current release is 8.0.4.0.0,
then you only need to run U0800040.SQL.

« Ifthe old release you had installed prior to upgrading was
higher than Release 8.0.5.0, see the READMEMIG.doc file in the
new installation for the correct upgrade script to run.

« Ifthe upgrade script runs for an inordinately long time, it may
be caused by a setting for LARGE_POOL_SIZE that is too large
for your installation. Use the VSPARAMETER view to check
the setting for LARGE_POOL_SIZE, and if it is too large, set it
to a smaller value in your INIT.ORA file.

Run the UTLRP.SQL script. This is a script that Oracle Corporation recommends
you run to compile all existing PL/SQL modules that were previously in an
INVALID state, such as packages, procedures, types, and so on. Doing this at
this stage is optional; however, it will ensure that the cost of recompilation is
incurred during installation time rather than later on. Enter at the SQL*Plus
prompt:

QA > @ERACLE HOMEA RDBVB\ ADM N UTLRP. SQL
Turn off the SPOOL command.
Q> SPOOL GFF

Check the spool file UPGRADE.LOG you created in Step 6. and verify that
every package and procedure compiled successfully. Correct any problems you
find in the file. If you are upgrading from Release 8.0.2, also check the
UPGRADEZ2.LOG spool file.

Run ALTER SYSTEM DISABLE RESTRICTED SESSION:
SA> ALTER SYSTEM D SABLE RESTR CTED SESS (N

Run UTLCONST.SQL to check for bad date constraints. If you already ran
UTLCONST.SQL after you migrated or upgraded to a previous version 8
release, you do not need to run it again. However, running the script many
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11.

12.

times will not damage your system; therefore, if you are unsure about whether
it has been run on your system, run it now.

SQ1> SPOOL UTLRESULT. LGG
Q1> @ERACLE. HOMEYA RDBVB\ ADM N\ UTLGONST. SQL
QA> SPaL OFF

A bad date constraint involves invalid date manipulation. An invalid date
manipulation is one that implicitly assumes the century in the date, causing
problems at the year 2000. The UTLCONST.SQL script runs through all of the
check constraints in the database and sets constraints as bad if they include any
invalid date manipulation. UTLCONST.SQL selects all the bad constraints at the
end. After you run the script, the UTLRESULT.LOG file includes all the
constraints that have invalid date constraints. UTLCONST.SQL does not correct
bad date constraints, but it does disable them. Either drop the bad constraints or
recreate them after you make the necessary changes.

Exit SQL*Plus:
SA>EXT
Ensure the COMPATIBLE parameter is left unset if it has not been set in the

INITSID.ORA file. Leave the COMPATIBLE parameter unchanged if it has
been previously set.

Additional Information: Some new features of Oracle8 Release
8.1.x require a compatibility setting of 8.1.0. See Chapter 7
"Compatibility and Interoperability” of Oracle8i Migration for more
information.

Your database is upgraded to Release 8.1.6.

Migration Issues for Net8 and SQL*Net

During migration from Oracle 7.x or Oracle 8.0.x to Oracle8i, the following issues
need to be addressed:

Location of Network Configuration Files

Listener Configuration

Changing LISTENER.ORA for Migrated Databases
Changes in Handling of TCP/IP Listening Address
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« Disabling Native Authentication

« Installing Appropriate Versions of SQL*Net

Location of Network Configuration Files

SQL*Net and Net8 8.1 use configuration files from ORACLE_
HOME\network\admin by default, while Net8 8.0 uses configuration files from
ORACLE_HOME\net80\admin by default. If you want all the Oracle products to
use configuration files from the same location, you can set the registry variable
TNS_ADMIN.

Additional Information:  Please refer to Appendix D, "Net8
Configuration”, for more information.

Listener Configuration

Before installing an Oracle8i server ensure that any existing Net8 or SQL*Net
listeners on the same computer are stopped. An existing listener may prevent the
Net8 8.1 listener from starting during the Oracle8i install due to listener endpoint
conflicts with an existing listener.

If Net8 8.1 listener could not be started during Oracle8i installation due to conflicts
in listening endpoints, you can start your Net8 8.1 listener by using the listener
control program:

From a command prompt:
Isnrctl start <listener_name>

where <listener_name> is LISTENER for typical install or the name given during
custom install.

Changing LISTENER.ORA for Migrated Databases

When you migrate Oracle 7 or Oracle 8.0 database to an Oracle8i database, the SID
of the database needs to be removed from the Oracle 7/8.0 home LISTENER.ORA
and added to Oracle8i home LISTENER.ORA file.

Changes in Handling of TCP/IP Listening Address

In Oracle8i, when the LISTENER.ORA contains the TCP/IP system name in
ADDRESS, the Listener listens on all addresses for the system. Therefore, even if a
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system has multiple interface cards with different TCP/IP host names, listening
using any of the host names ensures that the Listener will listen on all interface
cards. It is an error to configure multiple addresses for the same port in
LISTENER.ORA.

For Oracle 7 or Oracle 8.0, the Listener only listened for the TCP/IP host name
specified in LISTENER.ORA and you had to specify listening addresses for multiple
TCP/IP host names of a system. The default LISTENER.ORA created for Oracle
7/0Oracle 8.0 contained multiple addresses, for example,

LISTENER = (ADDRESS_LIST=

( ADDRESS=( PROTQOCL=TCP) ( HOST=syst ent) ( PORT=1521) )

( ADDRESS=( PROTQOCL=TCP) ( HOBT=127. 0. 0. 1) ( PORT=1521))
)

The above addresses are invalid for Oracle8i and the ADDRESS line containing
127.0.0.1 must be removed.

Disabling Native Authentication

For Oracle 7 and Oracle 8.0 default installation, native authentication is turned off.
Make sure that native authentication, has not been set to sglnet.ora for Oracle client
and Oracle server, in other words:

sgl net . aut henti cati on_servi ces = (NIS)

This should be commented if present in sglnet.ora file.

Installing Appropriate Versions of SQL*Net

When migrating from Oracle7 Server Release 7.3.x to Oracle8i Release 8.1.6, install
the appropriate version of SQL*Net in the 7.3.x Oracle home before using Oracle
Data Migration Assistant or MIG. Migration will be unsuccessful if you do not
install the appropriate versions of SQL*Net.

Moving Database Files to an OFA-Compliant Directory

The Oracle Optimal Flexible Architecture (OFA) is a feature of Oracle8i for
Windows 98 Release 8.1.6. It has been available for Oracle on UNIX for some years.
OFA is a set of file naming and placement guidelines recommended by Oracle
Corporation for Oracle software and databases. It can also be thought of as a set of
"good habits" to adopt when organizing Oracle directories and files on your
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computer. All Oracle products on the Oracle8i for Windows 98 are OFA-compliant;
that is, Oracle Universal Installer places Oracle products in directory locations that
follow the OFA guidelines.

One of the many benefits of OFA is that you can separate Oracle software
executables from database files. Previously, database files were placed in ORACLE_
HOMEN\DATABASE, (for example, C:\ORAWIN95\DATABASE) a subdirectory of
the Oracle home directory that also contained Oracle software. Using OFA, you can
put Oracle software in X;\ORACLE_BASE\ORACLE_HOME and database files in
X:\ORACLE_BASE\ORADATA\DB_NAME.

Additional Information: For more information on OFA and the
type of directory structure where you should place your database
files after migration or upgrade, see "Optimal Flexible Architecture
Overview" on page 3-13.

Post-Migration Tasks

Oracle8i Navigator uses the PO8 user account to connect to the local Oracle8i
Personal Edition database. Create the PO8 user account for the Oracle8i Navigator
to function properly.

To create the PO8 user account:

1. Start SQL*Plus from the MS-DOS command prompt:
C\> SQ*A us

2. Connect to the SYSTEM user account:
SQA> CGONNECT SYSTEM MANAGER

where MANAGER is the password for the SYSTEM account when Oracle8i
Personal Edition is initially installed. If you have changed this password, enter
the new one.

3. Enter the following SQL commands:

Q> CREATE USER PCB | DENTI F ED BY PGB;

SQA> GRANT [CRA TO PGB;

These commands create the PO8 user with the password POS8.
4. Exit SQL*Plus:

Q> BEXT
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Post-Installation Configuration Tasks

This chapter describes some of the configuration tasks you must perform before
using products like Oracle8i Navigator. Where appropriate, the chapter provides
references to other guides for those configuration tasks.

Specific topic discussed:

« Configuring Oracle 8i Navigator

Note: The directory path examples in this chapter follow Optimal
Flexible Architecture (OFA) guidelines (for example, ORACLE _
BASE\ORACLE_HOMEN\). If you specified non-OFA compliant
directories during installation, your directory paths will differ. See
"OFA and Multiple Oracle Home Configurations” on page 3-22 for
more information.

Post-Installation Configuration Tasks 5-1



Configuring Oracle 8i Navigator

Configuring Oracle 8/ Navigator

Step 1: Create a PO8 User Account

Oracle8i Navigator uses the PO8 user account to connect to the local Oracle8i
Personal Edition database. Create PO8 user account if you have migrated your
Personal Oracle7 Release 7.x or Personal Oracle8 Release 8.x to an Oracle8i Personal
Edition Release 8.1.6 database.

To create a POS8 user account:
1. Start Server Manager from the MS-DOS command prompt:

C\> SRR
2. Connect to the SYSTEM user account:

SVRVER> CONNECT SYSTEM MANAGER

where MANAGER is the password for the SYSTEM account when Oracle8i
Personal Edition is initially installed. If you have changed this password, enter
the new password.

3. Enter the following commands:

SVRMER> CREATE USER PGB | DENTI FH BED BY PCB;
SVRMER> GRANT DBA TO PCB;
4. Exit Server Manager:

SR> EXI T

Step 2: Changing the User Password

Change the password for each of these user names after you install Oracle8i
Personal Edition. Use the Oracle8i Navigator to change these passwords.

To change the user account passwords using Oracle8i Navigator:

1. Inthe Oracle8i Navigator window, right-click the user whose password you
want to change.

Choose Properties from the pop-up menu.

Type the new password in the New field.

Type the new password again in the Confirm field.
Click OK.

a A W DN
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By default, the Navigator stores the password for the PO8 account in the registry. If
you do not want the password stored in the registry, then disable the feature.

To disable the save password feature:
1. Select Local Database in the Oracle8i Navigator.
2. Right-click, and choose Properties from the pop-up menu.

3. Clear the check from the Save Password box, and click OK.

Step 3: Enable Two-Phase Commit

When the database is started, it does not automatically enable support for an
incoming connection that allows for the two-phase commit (a distributed feature).

To enable two-phase commit:

1. From the Taskbar, choose Start > Run.

2. Enter:
CRACONCT ON
3. Click OK.

To disable this feature:

1. From the Taskbar, choose Start > Run.

2. Enter:
QRACONCT CFF
3. Click OK.

Step 4: Configure a Database Connection

A connection is predefined for the local database. If you want to establish a
connection to a remote database, then create the database connection. Once you
have created a database connection to a remote database, select the database
connection in Oracle8i Navigator to establish an active database connection to a
remote database. After you have connected to a remote database, you can view and
copy objects located on a remote database. If the remote database is a master
replication site, then you can also perform replication.

To create a database connection to a remote database:

1. From the Oracle8i Navigator, select Database Connections.
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2. Right-click on Database Connections, and choose New from the pop-up menu.

The New Database Connections Properties sheet appears:
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Enter the name of the new database connection.
Enter the user name and password that you will use to connect to the database.

Remember that the privileges associated with the user name you specify will
affect how you can use the database with this database connection.

Click Configure.
Oracle Net8 Easy Config appears:

Post-Installation Configuration Tasks 5-5



Configuring Oracle 8i Navigator

M o E by CordaT 'whekooass
‘Wislcame fo Meis Easy Config!
LT Mal BaraLE Na Tt
Mgy Mg Serere Fsme

& Cruila —

" MpdPy

~ Dok Exizing Het Serecs Hames

 Toal %;I_::-I-\:.:.__I-_.:_'-.-Igil_.l;l':'-_:-'-‘-l'-L-F"J.-.'u.' Com

G | Eaila | s _-:-_l:l

6. Enter a service name (database connection), and click Next.

The next page appears:
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7. Select the networking protocol you want to use to connect to the remote
database, and click Next.

The next page appears:
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8. Enter the host machine name of the database you want to connect to, and
specify the port number which the host machine network listener is using. Then
click Next. You may need to consult with your network administrator for this
information.

The next page appears:
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9. Specify the ‘Service Name’ if you are using Oracle8i 8.1.x database or, specify
the SID of the remote database you want to connect to if you are using Oracle8i
8.0.x database, and click Next.

The SID is a unique identifier for an Oracle database instance. You may need to
consult with your database administrator for this information.

The next page appears:
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10. Click Test.

The Connection Test page appears:
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Oracle Net8 Easy Config tests the connection using the information you have
provided, and returns a message of either success or failure. If your connection
test is not successful, then an error message code appears. Use the online help
to research the code to help you correct the problem.

11. If you want to test with a different user connection, click Change Login. Enter
username, password and click Test.

12. Click Close.

You will be taken back to the previous screen, click Next. The next page
appears.

13. Click Finish or click Back to return to previous pages and make modifications to
your connection information, if needed.

14. Select the service (connection) name that you just created from the drop-down
list in the New Database Connection Properties sheet:
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15. Click OK.

The new database connection is added to the Database Connections folder in
Oracle8i Navigator. To connect to the remote database specified by the
connection, single-click the database connection name (in this case ‘samplel’). A
list of database objects appears in the right side window of the Navigator.
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Step 5: Create a Project

A project is a collection of different database objects. You choose which objects you
want to include in a project. For example, you may want to create a project called
Clients. You might include tables or views containing customer names, addresses,
past items purchased, past sales, and payables. You may create these tables or views
yourself, or you may copy an object from another database. You may include other
objects such as spreadsheets. See the Oracle8i Navigator online help for detailed

instructions on how to create a project.
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Post-Installation Database Creation

This chapter describes how to create a database with Oracle Database Configuration
Assistant or the BUILD_DB.SQL script after installing Oracle.

Specific topics discussed are:

« Before You Create a Database

« Creating a Database Using Tools

« Using Oracle Database Configuration Assistant
« Using BUILD DB.SQL
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Before You Create a Database

Before you create a database, consider the following requirements described below.

Naming Conventions for Oracle Databases

With Oracle8i databaseOracle8i, all mounted Oracle databases in a network must
have unique database names.

A name is associated with a database at database creation time and stored in its
control files. If the database keyword is provided in the CREATE DATABASE
statement or when prompted by the Oracle Database Configuration Assistant, that
value becomes the name for that database. If not, the program uses the value of the
DB_NAME parameter in the INIT.ORA file.

If you attempt to mount two Oracle8i databases with the same database name, you
receive the following error during the second mount:

(RA-01102: cannot nount dat abase i n EXQLUS VE node

If there are two or more Oracle8i databases on the same computer, but located in
different Oracle homes, the following rules apply:

» Each database name must be unique
« Each SID must be unique

To change the name of an existing database, you must use the CREATE
CONTROLFILE statement to recreate your control file(s) and specify a new
database name. This restriction only exists for Oracle8i instances. Any Oracle7
instances running simultaneously with an Oracle8i instance are not subject to this
restriction.

Note: The directory path examples in this chapter follow Optimal
Flexible Architecture (OFA) guidelines (for example, ORACLE _
BASE\ORACLE_HOME\RDBMS\ADMIN). If you specified
non-OFA compliant directories during installation, your directory
paths will differ. See "OFA and Multiple Oracle Home
Configurations" on page 3-22 for information.
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Creating a Database Using Tools

You can choose either of the following tools to create a database:

Oracle Database Configuration Assistant
BUILD_DB.SQL script

Use Oracle Database Configuration Assistant to create a database, because it is the
easier method.

If you want to create a database using command line tools, you can use the BUILD _
DB.SQL script located in ORACLE_BASE\ORACLE_HOME\RDBMS\ADMIN.

Using Oracle Database Configuration Assistant

Oracle Database Configuration Assistant enables you to:

Create a Database

Create a Database

Delete a Database

Note: This chapter describes running Oracle Database
Configuration Assistant in standalone mode (that is, after
installation). See Chapter 4 of Oracle8i Installation Guide for Windows
98 for information on running Oracle Database Configuration
Assistant during installation to create a database.

Note: If you use Oracle Database Configuration Assistant to
create a new database in a new multiple Oracle home, the
LISTENER.ORA file located in ORACLE_
HOME\NETWORK\ADMIN is updated with the SID information.
Also a new TNS entry is generated in the TNSNAMES.ORA file
located in ORACLE_HOME\NETWORK\ADMIN.
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To create a database using Oracle Database Configuration Assistant:
1.

Choose Start > Programs > Oracle - HOME_NAME > Database Administration
> Database Configuration Assistant.

The Oracle Database Configuration Assistant Welcome page appears.
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2. Select Create a database, then click Next.

The following page appears:
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Option Description

Typical Consists of two suboptions:

«  Copy existing database files from the CD

Automatically installs a starter database with the
default initialization parameter settings

. Create new database files

Asks you several database environment questions
before dynamically creating a database
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Option Description

Custom Enables you to customize the creation of your database.
This option is only for Oracle database administrators
(DBAs) experienced with advanced database creation
procedures, such as customizing:

Data, control, and redo log file settings
Tablespace sizes

Extent sizes

Database memory parameters
Archiving formats and destinations
Trace file destinations

Character set values

3. Respond to instructions on each Oracle Database Configuration Assistant page,
then click Next when you are ready to continue to the next page. When you get
to the last page, click Finish to start the creation of the Oracle8i database.

Delete a Database

The Delete a Database option of Oracle Database Configuration Assistant lets you
quickly and easily delete all database files including the initialization parameter file.

Using BUILD_DB.SQL

This section describes how to create a new database manually using a SQL script.
There are a number of ways to create a database depending on if you want to:

« Make a copy of an existing database and remove the old database.

« Make a copy of an existing database and keep the old database.

« Create a new database when no database exists on your system that you can

copy.

The following table summarizes the steps involved in creating a new database for
each of these database creation scenarios. Each step is explained in detail in the

following subsections.
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Perform these tasks...

If you want to...

Copy an existing
database to a new
database, then remove
the old database

Copy an existing
database to a new
database, then keep
the old database

Create a new database
when no other
database exists on
your system

Exporting an Existing Database Yes Only if you want to Not applicable
copy data from the
existing database to the
new database
Deleting Database Files Yes No Not applicable
Modifying the INIT.ORA File Yes Yes Yes
Creating and Starting an Oracle Instance | No Yes Yes
Putting the CREATE DATABASE Yes Yes Yes
Statement in a Script
Creating a Database Yes Yes Yes
Importing a Database Yes Only if you want to Not applicable
import tables and other
objects exported from
the existing database
Updating the ORACLE_SID in the No Only if you want to Yes
Registry change the default SID
Backing Up the New Database Yes Yes Yes

How to Create a Database
An example is used in the following sections to demonstrate how to create a

database.

In this example, you will copy an existing database (the starter database with a SID
of ORCL located in the C:\ORACLE\ORADATA\ORCL directory) to a new
database with a database name and SID of PROD located in the
C\ORACLE\ORADATA\PROD directory.

You will delete the starter database ORCL after you have created the PROD

database.

Note:

In this example, ORACLE_BASE is C:\ORACLE. See

Chapter 3, "Multiple Oracle Homes and Optimal Flexible
Architecture” for more information on ORACLE_BASE.
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Creating Directories

Create the following directories in which to put the administration and database
files for the new database PROD:

« C\ORACLE\ADMIN\PROD

« C\ORACLE\ADMIN\PROD\BDUMP
« C\ORACLE\ADMIN\PROD\PFILE

« C\ORACLE\ADMIN\PROD\UDUMP
« C\ORACLE\ORADATA\PROD

Exporting an Existing Database
You only need to export an existing database if you want to copy its contents to a
new database.

You can invoke the Export Utility by using either parameter mode or interactive
mode. However, parameter mode is the recommended mode. Interactive mode
provides less functionality than parameter mode and exists for backward
compatibility only.

Example 6-1 Parameter Mode
C\> BEXP SYSTEM PASSWRD Fl LEEMYEXP. DWP FULL=Y LOG-MYEXP. LG5

Example 6-2 Interactive Mode
C\> BEXP SYSTEM PASSWRD

Enter only the command EXP SYSTEM/PASSWORD to begin an interactive session
and let the Export Utility prompt you for the information it needs.

See Oracle8i Utilities for more information on using the Export Utility.
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Note: If you use parameter mode, the Export Utility considers file names
and directory names to be invalid if a blank space is present. Enclose the
full path in the FILE= parameter in triple quotes. For example:

FI LE=""" C: \ PROGRAM FI LES\ EXPORT. DMVP" " "
or
FI LE=""" C: \ PROGRAM FI LES\ EXPORT FI LE. DMP" " "

If the Export Utility is used in interactive mode, the file name or directory
name can contain a space without quotes.

To export all data from an existing database to a new database:

1. Set ORACLE_SID to the database service of the database whose contents you
want to export. For example, if the database you want to export is the starter
database ORCL, enter the following at the MS-DOS command prompt. Note
that there are no spaces around the equal sign (=) character.

C\> SET (RACLE S| D=CRQL
2. Start the Export Utility from the MS-DOS command prompt:
C\> BEXP SYSTEM PASSWRD Fl LEEMYEXP. DWP FULL=Y LOG-MYEXP. LG5

You now have a full database export of the starter database ORCL in the file
MYEXP.DMP. All messages from the Export Utility are logged in the file
MYEXP.LOG.

Deleting Database Files

Deleting database files is only required when you want to copy an existing database
to a new database to replace the old database. In the following example, you delete
the database files of the starter database ORCL.

To delete database files:
1. Shut down the starter database ORCL using OSTOP
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2. Delete the following database files located in the
C:\ORACLE\ORADATA\ORCL directory:

» CONTROLO1.CTL
« CONTROLO02.CTL
» CONTROLO3.CTL
« INDXO01.DBF

« DRO1.DBF

« RBSO01.DBF

« SYSTEMO1.DBF

« TEMPO1.DBF

« USERSO01.DBF

« REDOO01.LOG

« REDO02.LOG

« REDOO03.LOG

« TOOLSO01.DBF

Modifying the INIT.ORA File

If you are using the starter database ORCL as the basis for your new database, copy
INIT.ORA file:

C\CRAQ.E\ ORACLE_HOMENADM N CROL\PFILEAIN T. GRA
to

C\GRAA.B ORACLE_HOMENADM N PRI PFILEAIN T. GRA
and modify the file as described in this section.

If you do not have an existing database on your system, you cannot copy an
initialization parameter file to use as the basis for your new INIT.ORA file.
However, you can use the sample initialization parameter file INITSMPL.ORA
provided in the ORACLE_BASE\ORACLE_HOME\NADMIN\SAMPLE\PFILE
directory as the basis for the INIT.ORA file for the PROD database.
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If you use INITSMPL.ORA as the basis for the INIT.ORA file, you must modify the
following initialization parameters in the INIT.ORA file, or you will not be able to
start the PROD database:

DB_NAME
INSTANCE_NAME
SERVICE_NAMES
CONTROL_FILES
BACKGROUND_DUMP_DEST
USER_DUMP_DEST

Modifying the DB_FILES initialization parameter is recommended to optimize
performance.

Initialization Parameter Modification Instructions.

DB_NAME This parameter indicates the name of the database, and

must match the name used in the CREATE DATABASE
statement in "Putting the CREATE DATABASE
Statement in a Script" on page 6-13. You give a unique
database name to each database. You can use up to
eight characters for a database name. The name does
not need to match the SID of the database service.

Set this parameter to:
DB_NAME=PRCD. DOVAI N

INSTANCE_NAME Set this parameter to:

I NSTANCE_NAME=PROD. DOVAI N

SERVICE_NAMES Set this parameter to:

SERVI CE_NAMES=PROD. DOVAI N
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Initialization Parameter

Modification Instructions.

CONTROL_FILES

This parameter lists the control files of the database.
You do not have the control files on your file system at
this point, because the control files are created when
you run the CREATE DATABASE statement. Ensure
that you specify the complete path and file name,
including drive letter.

Set this parameter to:

CONTROL_FI LES =

(" C: \ ORACLE\ ORADATA\ PROD\ CONTROLO1. CTL",
" C: \ ORACLE\ ORADATA\ PROD\ CONTROLO2. CTL",
" C: \ ORACLE\ ORADATA\ PROD\ CONTROL03. CTL")

BACKGROUND_DUMP_DEST

Set this parameter to:

BACKGROUND_DUVP_DEST =
C: \ ORACLE\ ADM N\ PROD\ BDUVP

USER_DUMP_DEST

Set this parameter to:

USER DUVP_DEST =
C: \ ORACLE\ ADM N\ PROD\ UDUVP

DB_FILES

Set this parameter to the same number as the value of
the MAXDATAFILES option of the CREATE
DATABASE statement. The value of 100 is used for this
example.

DB_FI LES=100

See Also:  Appendix B, "Oracle8i Database Specifications for
Windows 98" and Oracle8i Reference for information on other
initialization parameters that you may want to add or modify.

Creating and Starting an Oracle Instance
You only need to create and start an Oracle instance if you want to do one of the

following:

« Copy an existing database to a new database and keep the old database

« Create a new database when no other database exists on your system that you

can copy
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To create an Oracle instance:

1.

Run ORADIM from the MS-DOS command prompt:
C\> CRADOM-NEW-S D PRD - | NTPAD PASSWRD - STARTMIDE MANUAL
-PFILE C\CRAALE ADMNPRID PFILEINT. GRA - GRA REQ HOME HOME NAMVE

Note that the previously-created INIT.ORA file is specified, with complete path,
including drive name.

Set ORACLE_SID to equal PROD. Note that there are no spaces around the
equal sign (=) character:

C\> SET (RACLE Sl D=PRD

Putting the CREATE DATABASE Statement in a Script

The CREATE DATABASE statement is a sequence of SQL statements that creates the
database. Create a script containing this statement that you can reuse anytime you
want to create a database.

Open the BUILD_DB.SQL script located in C:\ORACLE\ORA81I\RDBMS\ADMIN
and save itas BUILD_PROD.SQL.

This file becomes the basis for your script.

Note: The following example uses the BUILD_DB.SQL script to
create a database. You can also use the BUILDALL.SQL script to
create a database. BUILDALL.SQL not only creates the database by
calling BUILD_DB.SQL but also runs many other scripts such as
CATALOG.SQL, CATSNMP.SQL, SCOTT.SQL, and
COMDEMO.SQL.

To prepare the CREATE DATABASE script:
Make the following changes to the BUILD_PROD.SQL script.

1.

Set PFILE so it points to the C:\ORACLE\ADMIN\PROD\PFILE\INIT.ORA
initialization file.

Change CREATE DATABASE SAMPLE to CREATE DATABASE PROD.

Change all occurrences of SAMPLE to PROD. For example, change
C\ORACLE\ORADATA\SAMPLE\REDOO01.LOG to
C\ORACLE\ORADATA\PROD\REDOO01.LOG
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The following is the sample BUILD_DB.SQL script. Areas that you must modify to
create a database called PROD are highlighted.

-- This file nust be run out of the directory containing the
-- initialization file.

startup nomount pfile=C\Qacle\ADMN SAMPLE\pfile\initsnpl.ora
-- QCeate database

create dat abase SAMPLE
controlfile reuse
logfile C\Qacl e\ CRADATA SAMPLE\redo0l.10g' size 1Mreuse,
" C\ O acl e\ CRADATA SAMPLE\redo02. | og’ size 1Mreuse,
" C\ O acl e\ CRADATA SAMPLE\ redo03.1 0g' size 1Mreuse
datafile ' C\Qacl e\ RADATA SAMPLE\ syst en®l. dbf’ si ze 10Mreuse
aut oextend on
next 10M nmaxsi ze 200M
character set WES|I SCB859PL;

create rol | back segnent rb tenp storage (initial 100 k next 250 k);
-- Create additional tabl espaces ...

-- WSERs: Qreate user sets this as the default tabl espace
-- TEW. Ceate user sets this as the tenporary tabl espace
-- RBS For rollback segnents

create tabl espace users
datafile ' C\Qacl e\ CRADATA SAMPLE\ user sO1. dbf’ size 3Mreuse aut oextend on
next 5M naxsi ze 150M
create tabl espace rbs
datafile ' C\Qacl e\ CRADATA SAMPLE\rbs01. dbf’ size 5Mreuse aut oextend on
next 5M naxsi ze 150M
create tabl espace tenp
datafile ' C\Qacl e\ GRADATA SAMPLE\t enpO1. dbf’ size 2Mreuse aut oextend on
next 5M naxsi ze 150M
create tabl espace oemrepository
datafile ' C\Qacl e\ GRADATA SAMPLE\ centep0l. dbf’ si ze 3Mreuse aut oextend on
next 5M nmaxsi ze 150M
create tabl espace indx;
datafile ' C\Qacl e\ GRADATA SAMPLE\i ndx01. dbf’ size 2Mreuse aut oextend on
next 5M nmaxsi ze 150M
-- next 5M naxsi ze 150M
alter rollback segnent rb_tenp online;

-- Change the SYSTEMusers’ password, default tabl espace and
-- tenporary tabl espace.
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alter user systemtenporary tabl espace tenp;
alter user systemdefault tabl espace users;

-- Oeate 16 rol I back segnents. Allows 16 concurrent users wth open
-- transactions updating the database. This shoul d be enough.

create public rollback segnent rbl storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rb2 storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rb3 storage(initia 50K next 250K)
t abl espace rbs;

create public rollback segnent rb4 storage(initial 50K next 250K)
t abl espace rbs;

create public roll back segnent rb5 storage(initial 50K next 250K)
t abl espace rbs;

create public roll back segnent rb6 storage(initia 50K next 250K)
t abl espace rbs;

create public rollback segnent rb7 storage(initia 50K next 250K)
t abl espace rbs;

create public rollback segnent rb8 storage(initial 50K next 250K)
t abl espace rbs;

create public roll back segnent rb9 storage(initia 50K next 250K)
t abl espace rbs;

create public rollback segnent rbl0 storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rbll storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rbl2 storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rbl3 storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rbl4 storage(initial 50K next 250K)
t abl espace rbs;

create public roll back segnent rbl5 storage(initial 50K next 250K)
t abl espace rbs;

create public rollback segnent rbl6 storage(initial 50K next 250K)
t abl espace rbs;

You will run this script at the SQL*PIus prompt in "Creating a Database" on
page 6-16.
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Creating a Database
To use the BUILD_PROD.SQL script to create a database:

1. Make PROD the current SID:
C\> SET CRACLE S D=PRD

2. Start SQL*Plus from the MS-DOS command prompt, and connect to the
database as INTERNAL:

C\> SQPLUS
SQA> GONNECT | NTERNAL/ PASSWRD

The password is the one that you used to create the service, with the ORADIM
-NEW command in "Creating and Starting an Oracle Instance” on page 6-12.

The message Connected appears.
3. Turn on spooling to save the messages:
Q> SPOQL BUI LD_PROD. LGG

4. Runthe BUILD_PROD.SQL script that you created in "Putting the CREATE
DATABASE Statement in a Script” on page 6-13:

SQ> @ \ CRACLE\ CRAS1\ RDBVB\ ADM N BUI LD_PROD. SQL;

If the database is created successfully, the instance is started and the message
Statement processed appears numerous times.
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If you receive any errors, there are three possible causes, as illustrated below.

Cause

Solution

The BUILD_PROD.SQL script
contains syntax errors.

Correct them.

Some of the files to be created by
the BUILD_PROD.SQL script
already exist in the file system.

Make sure you are not using any file names already used by another
database on the system.

An error occurred at the operating
system level, such as a file or
directory permission problem.

You should have received a series of errors in SQL*Plus, the last one of
which should have the OSD- prefix. At the end of the OSD error, you
typically see an operating system error number in parentheses.

To see what the error means, do either of the following:
From the MS-DOS command prompt, enter:

C.\> NET HELP n

or

From the SQL*Plus prompt, enter:

SQL> HOST NET HELP n

where n is the operating system error number.

You must correct these problems before making another attempt to create a

database.

5. Runthe CATALOG.SQL script to create the data dictionary:
SA> @\ CGRACLE\ CRAS1\ RDBIVB\ ADM N\ CATALGG S

Note:

You may see messages such as ORA-01432: public synonym

to be dropped does not exist while the CATALOG.SQL,
CATPROC.SQL, and CATREP.SQL scripts are running. These are
information messages and are intended to occur while creating a
new database.

6. Runthe CATPROC.SQL script to install the objects used by the Oracle8i
database’s PL/SQL functionality:

Q1> @ \ GRACLE\ CRAS1\ RDB\VB\ ADM N\ CATPROC. SQL;

7. Turn off spooling:
Q> SPOL GFF
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8. Examine the BUILD_PROD.LOG file for any unusual errors.

IMPORTANT: The new database contains two users, SYS and
SYSTEM, with passwords CHANGE_ON_INSTALL and
MANAGER, respectively. For security reasons, change the
passwords now. Use the ALTER USER statement to change the
passwords:

SA> ALTER USER SYS | DENTI H BED BY NEWSYS PASSWRD
SA> ALTER USER SYSTEM | DENTI Fl ED BY NEW SYSTEM PASSWRD

9. Exit SQL*Plus:
SA>EXT

Importing a Database
You can import the full export created in "Exporting an Existing Database” on
page 6-8 into the new database.

You can also invoke the Import Utility, using parameter mode or interactive mode.
Parameter mode is recommended, because interactive mode provides less
functionality. Interactive mode exists solely for backward compatibility.

Example 6-3 Parameter Mode
C\> | MP SYSTEM PASSWIRD F LE=EWEXP. DWP FULL=Y LOGMYEXP. LOG

Example 6-4 Interactive Mode
C\> | P SYSTEM PASSWFRD

Enter only the command IMP SYSTEM/PASSWORD to begin an interactive session
and let the Import Utility prompt you for the information it needs.

See Oracle8i Utilities for more information on using the Import Utility.
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Note: If you use parameter mode, the Import Utility considers file names
and directory names to be invalid if there is a blank space. Enclose the full
path in the FILE= parameter in triple quotes. For example:

FI LE=""" C: \ PROGRAM FI LES\ EXPORT. DWVP" " "
or
FI LE=""" C: \ PROGRAM FI LES\ EXPORT FI LE. DMP" " "

If you use the Import Utility in interactive mode, the file name or directory
name can contain a space without quotes.

To import a database:

Run the Import Utility:
C\> | MP SYSTEM PASSWIRD F LE=EWEXP. DWP FULL=Y LOG=MY1 MP. LG

IMPORTANT: If the original database from which the export file
was generated contains tablespaces that are not in the new
database, the Import Utility tries to create those tablespaces with
associated data files.

The easy solution is to ensure that both databases contain the same
tablespaces. The data files do not have to be identical. Only the
tablespace names are important.

Updating the ORACLE_SID in the Registry

If this is the first database on the system or if you want to make the new database
the default database, you must make a change in the registry.

1.

Start the registry editor at the MS-DOS command prompt:
C\>REEDT
The registry editor window appears.

Choose the \HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEO
subkey for the first Oracle home on your computer. For subsequent installations
to different Oracle homes on the same computer, the path is \HKEY_LOCAL _
MACHINE\SOFTWARE\NORACLE\HOMEID, where ID is the unique number
identifying the Oracle home.
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See Also: See Appendix C, "Oracle8i Configuration Parameters
and the Registry” for more information on the subkey locations for
multiple Oracle homes.

3. Locate the ORACLE_SID parameter on the right side of the registry editor
window.

4. Double-click the parameter name and change the data to the new SID, which is
PROD in this example.

If you do not yet have the ORACLE_SID parameter, because this is the first
database on your system, you must create it.

Additional Information: To create the ORACLE_SID parameter,
see Appendix C "Adding a Registry Parameter with REGEDIT"
on page C-9:

Backing Up the New Database

WARNING: If anything goes wrong while operating the new
database without a backup, you must repeat the database creation
procedure. Back up your database now to prevent loss of data.

To back up the new database:
1. Shut down the database instance using OSTOP

See "Starting and Shutting Down a Database Using OSTART and OSTOP" on
page 7-3 for more information on how to use OSTART and OSTOP.

2. Using the tool of your choice, back up the database files.

Database files consist of the initialization parameter file, control files, online
redo log files, and data files.

When the backup is complete, you can start the database again, create users and
objects, if necessary, make any other changes, and use the database.

Be sure to back up the database backup after making any significant changes to
the database, such as switching the ARCHIVELOG mode, or adding a
tablespace or data file.

6-20 Oracle8i Personal Edition Administrator's Guide for Windows 98



Using BUILD_DB.SQL

See Also: Chapter 9, "Backing Up and Recovering Database
Files", Oracle8i Concepts, Oracle8i Backup and Recovery Guide, and
Oracle8i Administrator’s Guide for more information on archiving
and backup/recovery.

Warning: Do not store database files on a compressed drive. This
can result in write errors and decreased performance.
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Administering a Database

This chapter describes how to administer Oracle8i Personal Edition for Windows
98.

Specific topics discussed are:

« Starting and Shutting Down a Database with SQL*Plus
« Starting and Shutting Down a Database Using OSTART and OSTOP
= Running Multiple Instances

» Creating Password Files

« Deleting Password Files

« Connecting as INTERNAL with a Password File

« Changing the INTERNAL Password

« Encrypting Database Passwords

« Archiving Redo Log Files

« Using the ORADEBUG Utility
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Starting and Shutting Down a Database with SQL*Plus

These instructions assume that a database instance is created.

Note: The directory path examples in this chapter follow Optimal
Flexible Architecture (OFA) guidelines (for example, ORACLE_
BASE\ORACLE_HOME\RDBMS\ADMIN). If you specified
non-OFA compliant directories during installation, your directory
paths will differ. See section "OFA and Multiple Oracle Home
Configurations" on page 3-22 for information.

To start or shut down an Oracle8i database:

1. Go to your Oracle8i database server.

2. Start SQL*Plus at the MS-DOS command prompt:
C\> SQP.Ws

3. Connect to the Oracle8i database with the INTERNAL user name:
S > CGONNECT | NTERNAL

4. Follow the instructions below:

If You Want to... Then Enter...

Start a database with the SQ.> STARTUP

default parameterfile e o) imand uses the default INIT.ORA file located in the ORACLE_BASE\
ADMIN\DB_NAME\PFILE directory.

Start a database with a SQ.> STARTUP PFI LE=PATH FI LENANVE

f';i;ﬂ;;trr}%g the default This command uses the INIT.ORA file specified in PATH\FILENAME. This example
P starts the database using a file named INIT2.0ORA in C:\ORA81\ADMIN\ORCL\
PFILE:

SQ.> STARTUP PFI LE=C:\ ORA81\ ADM N\ ORCL\ PFI LE\ I NI T2. ORA

Stop the database SQ.> SHUTDOWN [ MODE]
where MODE is one of the following:

. Normal
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If You Want to...

Then Enter...

The database waits for all currently-connected users to disconnect and disallows
any new connections before shutting down. This is the default mode.

. Immediate

The database terminates and rolls back active transactions, disconnects clients, and
shuts down.

« Abort

The database terminates active transactions and disconnects users; it does not roll
back transactions. The database performs automatic recovery and rollback the next
time it is started. Use this mode only in emergencies.

Note: See "Choosing a Database Tool" on page 2-2 for a list of
other tools that can start the database and the Oracle8i
Administrator’s Guide for information on options you can specify
when starting your database.

Starting and Shutting Down a Database Using OSTART and OSTOP

Using OSTART:

Choose Start>Programs>QOracle_Home_Name>Database Administration>Start
Database.

At MS-DOS Prompt execute :

c: \ >CBTART SCREEN
Select the instance you want to start by choosing the SID from the combo box, then
press OK.

If you are executing OSTART from command prompt, the SID list displayed will be
of the Oracle Home which comes frist in the PATH. To get the SID list of another
Oracle Home, go to the BIN directory of that Home and execute OSTART SCREEN.
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Using OSTORP:

Choose Start>Programs>Oracle_ Home_Name>Database Administration>Stop
Database.

OR
At MS-DOS Prompt execute :
c:\> CBTCP SCREEN

OSTOP will stop the instance whose SID is found in HKEY_LOCAL _
MACHINE\SOFTWARE\ORACLE\HOME_NAME\ORACLE_SID if ORACLE_
SID is not set in the environment.

To stop any other instance started from the same Home, User, can do:

1. Set the SID of that instance to ORACLE_SID either in the registry or in the
environment and then run OSTOP or right click on the database icon on the
systray and select "shutdown".

2. Run KNLSTOP from the same Home with the SID of the instance to be stopped,;
c:\> KNLSTCP <9 D Nane>

Running Multiple Instances

To run multiple instances, ensure that you have already created each instance. You
then run multiple instances by starting each of the instances using SQL*Plus.

To run multiple instances:
1. Ensure that you have already created each instance.

2. Set the ORACLE_SID configuration parameter at the MS-DOS command
prompt to the SID for each instance you want to run:

C\> SET (RACLE SID=9 D

where SID is the name of the Oracle8i database instance.
3. Start SQL*Plus:
C\> SQPLLS

4. Connectas INTERNAL:
SQA> CONNECT | NTERNAL
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5. Start up the database with the new instance:
SQ > STARTUP PFl LEEQRAAQE BASEIADM N LB NMAVE PRI LEVI N T. GRA

where ORACLE_BASE is C:\ORACLE by default (unless you changed it during
installation) and DB_NAME is the name of the instance.

Creating Password Files

Use the Password Utility ORAPWD to create password files. ORAPWD is
automatically installed with the Oracle8i Utilities. Password files are located in the
ORACLE_BASE\ORACLE_HOME\DATABASE directory and are named
PWDSID.ORA, where SID identifies the Oracle8i database instance. Password files
can be used for local or remote connections to an Oracle8i database. The example
below describes how to perform a local connection.

To create a password file:
1. Create a password file with ORAPWD:
C\> CRAPWD FI LEEPVDSI D ORA PASSWIRD=PASSWRD ENTR ES=MAX_USERS

The essential elements of a password file are:

Element Description
SID Identifies the database instance.
FILE Specifies the password file name.

PASSWORD  Sets the password for the INTERNAL and SYS accounts.

ENTRIES Sets the maximum number of entries in the password file. This
corresponds to the maximum number of distinct users allowed to
connect to the database with the SYSDBA and SYSOPER DBA
privileges simultaneously.

2. Set the INIT.ORA file parameter REMOTE_LOGIN_PASSWORDFILE to
EXCLUSIVE or SHARED. Definitions for all possible values are described
below:
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Element Description

EXCLUSIVE Specifies that only one instance can use the password file and that the
password file contains names other than SYS and INTERNAL. Oracle8i
looks in the registry for the value of the ORA_SID_PWFILE parameter.
If a value is unspecified, it looks in the registry for the value of the
ORA_PWFILE parameter, which points to a file containing the
INTERNAL password as well as user names, passwords, and
privileges. If that is not set, it uses the default of ORACLE_
BASE\ORACLE_HOME\DATABASE\PWDSID.ORA.

SHARED Specifies that multiple instances can use the password file (for example,
a parallel server environment). However, the only users recognized by
the password file are SYS and INTERNAL. You cannot log in with
SYSOPER or SYSDBA privileges even if those privileges are granted in
the password file. The SHARED value of this parameter affords
backward compatibility with earlier releases. The Oracle8i database
looks for the same files as it does when the value is EXCLUSIVE, but
only the INTERNAL account is available for privileged access. This is
the default value.

NONE Specifies that the Oracle8i database ignores the password file and that
privileged users are authenticated by the Windows NT operating
system. NONE is the default setting.

Start SQL*Plus:

C\> SQPLUS

Connect as INTERNAL:
SQA> CONNECT | NTERNAL
Start the Oracle8i database:
SQA> STARTWP

Grant appropriate privileges to each user who needs to perform database
administration. For example:

SQ> GRANT SYSDBA TO SQOTT;
If successful, the following message displays:
S atenent Processed.

This adds SCOTT to the password file and enables SCOTT to connect to the
database with SYSDBA privileges. Use SQL*Plus to add or delete user names,
user passwords, and user privileges in password files.

Connect to the Oracle8i database with DBA privileges for SCOTT:
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SQ> GONNECT SCOTT/ Tl GER AS SYSDBA

You are connected to the Oracle8i database.

Viewing Password Files

The password file is automatically hidden. This section describes two ways of
viewing the password file:

« To see the password file from the MS-DOS command prompt:
« To see the password file from Windows 98 Explorer:

To see the password file from the MS-DOS command prompt:

To... Enter...

See the password file C: \ ORACLE\ ORA81\ DATABASE> ATTRI B
The password file displays:
A H C: \ ORACLE\ ORA81\ DATABASE\ PWDS/ D. ORA

Make the password file visible C: \ ORACLE\ ORA81\ DATABASE> ATTRI B - H
PWDS D CRA

Note: The password file must be visible before you can
move or copy it.

Hide the password file again C:. \ ORACLE\ ORA81\ DATABASE> ATTRIB +H
PWDS O CRA

To see the password file from Windows 98 Explorer:
1. Open Windows 98 Explorer.

2. Open the folder to view.

3. Click Folder Options from the View main menu.
4. Click the View tab.
5

Follow the instructions below:

To... Click...
See the password file Showv all files.
Hide the password file Do not show hidden files.
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Deleting Password Files
This section describes how to delete a password file.
To delete a password file:

1. Make the password file visible at the MS-DOS command prompt or in
Windows 98 Explorer by following the instructions in section "Viewing
Password Files" on page 7-7.

2. Delete the password file based on whether you made it visible at the MS-DOS
command prompt or in Windows 98 Explorer.

Connecting as INTERNAL with a Password File

You can connect as INTERNAL with a password file. The password for INTERNAL
is ORACLE if you installed your database through the Typical or Minimal
installation types.

To connect as INTERNAL with a password file:

1. Follow the procedures in "Creating Password Files" on page 7-5 to create a
password file with ORAPWD.

2. Setthe INIT.ORA file parameter REMOTE_LOGIN_PASSWORDFILE to
EXCLUSIVE or SHARED.

Note: When REMOTE_LOGIN_PASSWORDFILE is set to NONE,
connecting remotely to a database as INTERNAL is prohibited even if the
correct password is supplied.

3. Connect to your Oracle8i database as follows:
SQ > QONNECT | NTERNAL/ PASSWRD
where PASSWORD is the password created with ORAPWD.

Changing the INTERNAL Password

Change the INTERNAL user account password with either ORAPWD or SQL*Plus.
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To change the password with ORAPWD:

1. See section "Deleting Password Files" on page 7-8 for instructions on deleting
the password file.

2. See section "Creating Password Files" on page 7-5 for instructions on creating a
password file.

To change the password with SQL*Plus:

The section assumes the password file is already created and the INIT.ORA file
parameter REMOTE_LOGIN_PASSWORDFILE is set to SHARED or EXCLUSIVE.

1. Start SQL*Plus:
C\> SQAPLWB

2. Connect with the INTERNAL user name:
SQA > QONNECT SYS passwor d

3. Change the password for the SYS user name, for which INTERNAL is an alias:
SA> ALTER USER SYS | DENTI Fl ED BY NEWPASSWRD
INTERNAL is now also identified by NEW_PASSWORD.

Encrypting Database Passwords

With the Oracle8i database, you can encrypt the password used to verify a remote
database connection.

To enable password encryption:

1. Add DBLINK_ENCRYPT_LOGIN to the initialization parameter INIT.ORA file
on the server computer.

2. Set DBLINK_ENCRYPT_LOGIN equal to TRUE.

3. Setthe ORA_ENCRYPT_LOGIN configuration variable on the client computer
to TRUE. See Appendix C, "Oracle8i Configuration Parameters and the
Registry" for instructions on adding and setting configuration parameters in the
registry.

Once these parameters are set to TRUE, whenever a user attempts a remote login,
the Oracle8i database encrypts the password before sending it to the remote
database. If the connection fails, the failure is noted in the audit log. The Oracle8i
database then checks if either of these parameters is set to FALSE. If so, the Oracle8i
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database attempts the connection again using an unencrypted version of the
password. If the connection is successful, the success is noted in the audit log, and
the connection proceeds.

Note: Releases prior to Release 7.1 do not support encrypted passwords. If
you are connecting to an earlier version of the Oracle database, you must
set the initialization parameter DBLINK_ENCRYPT_LOGIN to FALSE for
the connection to succeed.

Archiving Redo Log Files

Your Oracle8i database is created in NOARCHIVELOG mode if you installed your
database through the Typical or Minimal installation. If you created your databas
through the Custom option of Database Configuration Assistant, you had the
choice of either ARCHIVELOG or NOARCHIVELOG.

In NOARCHIVELOG mode, redo logs are not archived. This protects the database
from instance failure, but not from disk failure. Setting your archive mode to
ARCHIVELOG and enabling automatic archiving causes redo log files to be
archived. This protects the database from both instance and disk failure.

This section describes how to change the archive mode to ARCHIVELOG and
enable automatic archiving. See the chapter "Archiving Redo Information” of the
Oracle8i Administrator’s Guide for complete descriptions of the ARCHIVELOG and
NOARCHIVELOG modes.

Step 1: Change the Archive Mode to ARCHIVELOG
To change the archive mode to ARCHIVELOG:

1. Start SQL*Plus at the MS-DOS command prompt:
C\> SQAPLWB

2. Connect to the Oracle8i database with the INTERNAL user name:
S > GONNECT | NTERNAL

3. If the database is open, shut it down:;
SQA> SHUTDOM
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Mount the database:

Q> STARTUP MOUNT

Enter the following command:
Q> ARCH \VE LGG LI ST

The following output indicates the database is not in archive mode:

Dat abase | og node No Archi ve Mbde
Aut onati c archival D sabl ed

Archi ve destination %LBVE%

Qdest online | og sequence 34

Qurrent | og sequence 37

Change the archive mode to ARCHIVELOG:
SQA> ALTER DATABASE ARCH VELG3

Enter the following command:

SA> ARCH VE LGG LI ST

The following output indicates the database is now in archive mode:

Dat abase | og node Archi ve Mbde
Automati c archival D sabl ed
Archive destination %DBVE%

Q dest online | og sequence 34

Qurrent | og sequence 37

Open the database:

SQA> ALTER DATABASE CPEN

Continue to "Step 2: Enable Automatic Archiving" on page 7-12.
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Step 2: Enable Automatic Archiving
To enable automatic archiving:
1. Open the ORACLE_BASE\ADMIN\DB_NAME\INIT.ORA file.
2. Find the following three parameters:
# LOG ARCH \E_START = TRUE
# LOG ARCH VE DEST_1 = 9%ERACLE HOVEYb DATABASE\ ARCH VE
# LOG ARCH VE_FCRWAT = "98ERACLE S DAGYVISYS. ARC!

3. Remove the # sign from in front of each.

Note: The double quotes around LOG_ARCHIVE_FORMAT do
not need to be removed.

4. Editthe LOG_ARCHIVE_DEST_n value to identify an existing drive and
directory in which to archive your filled redo logs.

5. Editthe LOG_ARCHIVE_FORMAT value to indicate the appropriate archiving
format:

Format Description Example

%%ORACLE_SIDY%%:%T.ARC Specifies the thread number. This SID0001.ARC
number is padded to the left by
zeroes. The default value is one with
a range of up to three characters.

%%ORACLE_SIDY%%%S.ARC Specifies the log sequence number. SID0001.ARC
This number is padded to the left by
zeroes. The default value is one with
a range of up to five characters.

%%ORACLE _SID%%%tARC Specifies the thread number. The SID1.ARC
number is not padded. The default
value is one with no range limit on
characters.

Y% %ORACLE _SID%%6%sARC Specifies the log sequence number. SID1.ARC
The number is not padded. The
default value is one with no range
limit on characters.
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6. Save your changes.

7. Exit the file.

8. Shut down the database:
SQ > SHUTDOM

9. Restart the database
Q> STARTLP

10. Enter the following command:
SA> ARCH VE LGG LI ST

The following output indicates that automatic archiving of redo log files is
enabled and an archiving destination is specified:

Dat abase | og node Archi ve Mde
Automati c archival Enabl ed
Archive destination C \ BAKWP
Qdest online | og sequence 34

Qurrent | og sequence 37

Using the ORADEBUG Utility

The ORADEBUG utility is a debugging tool that sends debug commands through
SQL*Plus to Oracle processes. It is primarily for use by developers and Oracle
Support Services personnel. Only use this utility when instructed to do so by Oracle
Support Services. Note that you must have database administrator privileges to use
ORADEBUG.

To start ORADEBUG:

1. Start SQL*Plus from the MS-DOS command prompt and connect to the
database as INTERNAL. For example:

C\> SQPLWS
SQL> GONNECT | NTERNAL
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2.

Enter the following at the SQL*Plus prompt:
Q> CRADEBUG

ORADEBUG runs and prompts you for parameters. To obtain a list of these
parameters, enter the following at the SQL*Plus prompt:

SA> CRADEBUG HALP

The output from most debug commands is written to a trace file. Trace files are
created in the directory specified by the INIT.ORA initialization parameters
BACKGROUND_DUMP_DEST and USER_DUMP_DEST. By default, these
parameters are set to ORACLE_BASE\ADMIN\DB_NAME\BDUMP and
ORACLE_BASE\NADMIN\DB_NAME\UDUMP, respectively. If you want to
find the location of your trace file, enter the following at the SQL*Plus prompt:

SA > CRADEBUG TRACEH LE_NAME

If the output from a debug command produces more than one line of output,
the result is sent to a trace file, and a message indicating that the command has
completed is relayed to SQL*Plus. If the output from a debug command
produces only one line of output, the output is relayed directly to SQL*Plus.

Note: There is currently a limitation when using ORADEBUG that
can cause SQL*Plus to hang if you attempt to debug a thread that is
blocking on input/output (1/0) until that 1/0 completes.
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Monitoring a Database

This chapter describes how to monitor Oracle8i Personal Edition for Windows 98.
Specific topics discussed are:
« Database Monitoring Overview

« Using Trace and Alert Files
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Database Monitoring Overview

The following tools enable you to monitor your Oracle8i database:

This Tool Enables You To...
Trace Files Record occurrences and exceptions of database operations.
Alert Files Record important information about error messages and

exceptions during database operations.

Each tool is described in the following sections.

Additional Information: See Oracle8i Tuning and Performance for
general tuning information.

Using Trace and Alert Files

Oracle8i Personal Edition for Windows 98 background threads use trace files to
record occurrences and exceptions of database operations, as well as errors.
Background thread trace files are created regardless of whether the
BACKGROUND_DUMP_DEST parameter is set in the INIT.ORA initialization
parameter file. If BACKGROUND_DUMP_DEST is set, the trace files are stored in
the directory specified. If the parameter is not set, the trace files are stored in the
ORACLE_BASE\ADMIN\DB_NAME\BDUMP directory.

Oracle8i database creates a different trace file for each background thread. The
name of the trace file contains the name of the background thread, followed by the
extension. TRC. Sample trace file syntax includes:

« SIDDBWR.TRC
« SIDSMON.TRC
where SID represents the name of the instance.

Trace files are also created for user threads if the USER_DUMP_DEST parameter is
set in the initialization parameter file. The trace files for the user threads have the
form ORAXxxxx.TRC, where xxxxx is a 5-digit number indicating the Windows 98
thread ID.

The alert file contains important information about error messages and exceptions
that occur during database operations. Each Oracle8i Personal Edition for Windows
98 instance has one alert file; information is appended to the file each time you start
the instance. All threads can write to the alert file.
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For example, when automatic archiving of redo logs is halted because no disk space
is available, a message is placed in the alert file. The alert file is the first place to
check if something goes wrong with the database and the cause is not immediately
obvious.

The alert file is named SIDALRT.LOG and is found in the directory specified by the
BACKGROUND_DUMP_DEST parameter in the INIT.ORA initialization parameter
file. If the BACKGROUND_DUMP_DEST parameter is not set, the SIDALRT.LOG
file is generated in ORACLE_BASE\ADMIN\DB_NAME\BDUMP. Alert files
should be deleted or archived periodically.
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Backing Up and Recovering Database Files

This chapter provides information on backing up and recovering your database.
Specific topics discussed are:

« Selecting a Backup and Recovery Tool

« Backing Up Files with OCOPY

= Recovering Files with OCOPY
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Selecting a Backup and Recovery Tool

Backing up and recovering your Oracle8i database is one of the most critical
operations that a database administrator (DBA) performs. For this reason, it is
extremely important to choose the correct tools. The table below describes available
backup and recovery tools and makes recommendations on which tool to use with

your Oracle8i database:

Tool Description Analysis of Tool To Use this Tool,
See...
Recovery Recovery Manager in command line mode Command line usage Chapter 2, "Database
Manager is an Oracle8i tool that manages the process only. Must clearly Tools Overview" for
(RMAN) in of backing up, restoring, and recovering understand the instructions on
command line files. Recovery Manager is automatically command line syntax ~ accessing this tool
mode installed with Oracle Utilities. Recovery described in Oracle8i and Oracle8i Recovery
Manager uses a special PL/SQL interface Recovery Manager User’s  Manager User’s Guide
to the server for invoking backup Guide and Reference and Reference for
functions. The user is unaware of this before using. Backing instructions on using
interface and instead interfaces only with a up to tape requiresan this tool.
command line. optional MML from a

third-party vendor.

Third-party
vendor products

Third-party vendors provide tape backup  Can back up to tape.

software that works with Backup Wizard  Contact your

and RMAN. third-party vendors for
additional information.

Third-party vendor
documentation.

OCOPY

OCOPY is needed when performing a hot Command line usage

backup manually (that is, backing up a only. Can back up only

tablespace that is in offline backup mode).  to disk. Can only
perform local backups.

"Backing Up Files
with OCOPY" and
"Recovering Files
with OCOPY" in this
chapter.

Note: Before performing a cold backup, and regardless of the
backup tool you use , stop the Oracle Instance in order to clear
locks on the database files. If you do not stop Oracle Instance, some

database files may not be backed up.
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Backing Up Files with OCOPY

Use OCOPY for both hot and raw database file backups of the following file types:

File

Description

File Allocation Table (FAT) files

File allocation table (FAT) files you want to back up.

Logical raw files:

A logical drive (accessed with the direct 1/0) identified
by the name:

WX

where x: is the logical drive designator.

Physical raw files

A physical hard drive (accessed with direct 1/0)
identified by a device name of the form:

\\.\ physical driveN

where N is 0, 1, 2, and so on, representing each of the
physical drives in the system.

This table describes the two copy modes in which to use OCOPY:

Copy Mode OCOPY is used to...

Hard disk Copy hot files to a new name and location on a hard disk where you
can use an archive utility to back them up.

Multiple diskettes  Back up large hot files directly to multiple diskettes.
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This table describes the syntax to use when backing up all file types to hard disk or
multiple diskettes:

Copy Mode File Type Syntax
Hard disk FAT files C\> OCOPY old file newfile
Logical raw C\> OCOPY \\.\C. newfile
Physical raw C.\> OCOPY \\.\physicaldriveN new_
file
Multiple diskettes  FAT files C\> OCOPY /B hot_file a:
Logical raw C\> QOCorY /B\W.\C a:
Physical raw C.\> OCOPY /B \\.\physicaldriveN a:

Where...

Indicates the...

old_file
new_file

C:

physical drive
N

hot_file

a.

/B

Name and location of the hot file you want to back up.

Name and location of the backup copy.

Raw drive that holds a single RAW database file.

Physical drive that holds a single RAW database file.

Number(s) representing each of the physical drives in the system.
Path and filename of the hot file you want to back up.

Diskette drive containing the diskette on which to save the backup copy.
If the file is too large to fit on one diskette, OCOPY prompts you to insert
new diskettes as needed. OCOPY catalogs the parts of the file
automatically so that it can be reconstructed at a later time.

Large files must be split over multiple diskettes.

Note: Always use a fresh diskette for each OCOPY procedure; do not use
OCOPY to back up a file onto a diskette that contains part or all of another
file backed up using OCOPY.
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Recovering Files with OCOPY

The table below describes the syntax to use when recovering all file types from hard
disk or multiple diskettes.

Restore
From... File Type to Restore Syntax
Hard Disk! FAT files Use the Windows 98 COPY command.
Logical raw C.\> OCOPY new file \\.\c:
Physical raw C.\> OCOPY new file \\.\physicaldriveN
Multiple FAT files C\> OCOPY /R a: restore_dir
diskettes?

Note: First insert the diskette containing the initial part
of the backed up file.

Logical raw C\> OCoPY /R a: \\.\c:
Physical raw C\> OCOPY /R a: \\.\physicaldriveN

1 These are files originally backed up without the /B option.
2 These are files originally backed up with the /B option.

Where... Indicates the...

C: Raw drive, which holds a single RAW database file. If you use a different
drive as your raw drive, substitute it for C:. OCOPY prompts you to insert
diskettes as needed.

new_file File name to which to restore the file.

physicaldrive  Physical drive that holds a single RAW database file.

N Number(s) representing each of the physical drives in the system.

/R Restore option.

a Drive containing the diskette with the backed up file.

restore_dir Directory on the server in which to place the file. (The restored file has the

same name as the original file.)
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Developing Applications

This chapter describes topics of interest to application developers.
Specific topics discussed are:

« Finding Information on Application Development for Windows 98
« Building External Routines

« Accessing Web Data with Intercartridge Exchange
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Finding Information on Application Development for Windows 98

The following table describes where to find the information on developing
applications specifically for Windows 98. These products are included on the
CD-ROM.

To find information on... Look in the guide...

Oracle JServer «  Supplied Java Packages Reference

Oracle8i includes Oracle JServer, the integrated Java «  Oracle8i Java Developer’s Guide
Virtual Machine, and provides Java2 support
(JDK1.2), an embedded JDBC driver, a SQLJ
translator.

«  Oracle8i Java Stored Procedures Developer’s Guide

XML Oracle8i Application Developer’s Guide - XML

Oracle’s XML products include the XML Parser for
Java - Version 1 and Version 2 (which includes an
XSLT processor), the XML Class Generator, and the
XML Parsers for C, C++, and PL/SQL as well as
demos, utilities and sample code designed to
illustrate the simplest and most powerful ways to
work with XML-formatted data.

OLE Automation Feature «  Oracle COM Automation Developer’s Guide for
Windows NT
«  Oracle Objects for OLE (online Help) for Windows
NT
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To find information on... Look in the guide...

Writing external routines and the call specification «  Thischapter.
«  PL/SQL User’s Guide and Reference
«  Oracle8i Java Stored Procedures Developer’s Guide

«  Oracle8i Application Developer’s Guide - Fundamentals,
Chapter 10 "External Routines."

«  The following files in ORACLE_BASE\ORACLE_
HOME\RDBMS\EXTPROC:

EXTERN.C (code example shown in "Step 2:
Writing an External Routine™)

MAKE.BAT (batch file that builds the dynamic link
library)

EXTERN.SQL (automates the instructions described
in "Step 4: Registering an External Routine" and
"Step 5: Executing an External Routine™)

README.DOC (explains how to run the sample
and provides debugging advice)

OLE DB Oracle Provider for OLE DB

Additional Information: Oracle ODBC Driver Release 8.1.6 is
included on your CD-ROM. This driver is updated on a regular
basis. To download the latest release of this driver, visit the
following Web site:

http://technet.oracle.conlsoftware/utilities/software_
i ndex. ht m
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Building External Routines

This section describes how to create and use external routines on Windows 98.

External Routines Overview

External routines, previously referred to as external procedures, are functions
written in a third-generation language (3GL), such as C, and callable from within
PL/SQL or SQL as if they were a PL/SQL routine or function. External routines let
you take advantage of the strengths and capabilities of a 3GL programming
language in a PL/SQL environment.

Note: Oracle also provides a special purpose interface, the call
specification, that lets you call external routines from other
languages, as long as it is callable by C.

The main advantages of external routines consist of the following:

« Performance, because some tasks are performed more efficiently in a 3GL
language than in PL/SQL, which is better suited for SQL transaction processing

« Code re-usability, because dynamic link libraries (DLLs) can be called directly
from PL/SQL programs on the server or in client tools such as SQL*Forms

You can use external routines to perform specific processes, such as the following:
« Solving scientific and engineering problems
« Analyzing data

« Controlling real-time devices and processes
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Creating and using an external routine would involve the following sequential
tasks:

« Step 1: Installing and Configuring

« Step 2: Writing an External Routine

« Step 3: Building a DLL

« Step 4: Registering an External Routine

« Step 5: Executing an External Routine

Attention: You can combine the instructions described in the
fourth and fifth tasks into one SQL script that automates the
process of registering and executing your external routine. For an
example of a SQL script that combines these steps, see ORACLE _
BASE\ORACLE_HOME\RDBMS\EXTPROC\EXTERN.SQL.

Step 1: Installing and Configuring

This section describes the installation and configuration of the Oracle8i Personal
Edition database and Net8.

Installing the Oracle8i database
Follow the steps in the Oracle8i Personal Edition Installation Guide for Windows 98 to
install these products on your Windows 98 workstation:

« Oracle8i Personal Edition contains PL/SQL, from which external routines are
called, and the PL/SQL external routine program (EXTPROC), which executes
external routines.

« Net8 Client, Net8 Server, and Oracle Protocol support

Note: You must also have a C compiler and linker installed on
your system to build DLLs.

Configuring Net8

If you install Net8 Server from your CD-ROM, your server network files are
automatically configured to use external routines.
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When PL/SQL calls an external routine, the Net8 listener launches a session-specific
process called EXTPROC. Through Net8, PL/SQL passes the following information
to EXTPROC:

« DLL name

« External routine name

« Parameters (if necessary)

EXTPROC then loads the DLL and invokes the external routine.

If you copy your Oracle7 server network files into your Oracle8i network files
directory, you must manually configure the following files for the external routine
behavior described previously to occur:

« ORACLE_BASE\ORACLE_HOME\NETWORK\ADMIN\LISTENER.ORA
« ORACLE_BASE\ORACLE_HOME\NETWORK\ADMIN\TNSNAMES.ORA

See Chapter 8 of the Net8 Administrator’s Guide for instructions.

Note: The SQLNET.ORA file requires no changes. By default, the
values for the parameters NAMES.DEFAULT_DOMAIN and
NAME.DEFAULT_ZONE are set to WORLD. These values match
with the WORLD extension on the end of EXTPROC _
CONNECTION_DATA in the TNSNAMES.ORA file.

Step 2: Writing an External Routine

Using a 3GL programming language, such as C, you can write functions to be built
into DLLs and invoked by EXTPROC. The following is a simple Microsoft Visual
C++ example of an external routine:

Note: Since external routines are built into DLLs, they must be
explicitly exported. In this example, the dllexport storage class
modifier exports the function find_max from a dynamic link library.

#i ncl ude <w ndows. h>
#define NUl | Value -1
/*
This function sinply returns the larger of x and vy.
*
/
long __decl spec(dl | export) find max(long x,
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short x_indi cator,

longy,
short y_indicator,

short *ret_indicator)
{
/* 1t can be tricky to debug DLL's that are being called by a process
that is spawned only when needed, as in this case.
Therefore try using the DebugBreak(); cormmand.
This will start your debugger. Uncomment the Iine w th DebugBreak();
init and you can step right into your code.
*/
/* DebugBreak(); */

/* first check to see if you have any nulls */
/* Just return a null if either x or y is null */

if ( x_indicator==NullValue || y_indicator=NillValue) {
*ret _indicator = Null Val ue;
return(0);
} else {
*ret_indicator = 0; [* dgnify that return value is not null */
if (x >=y) return x;
else return y;

}
}

Step 3: Building a DLL

After writing your external routine(s) in a 3GL programming language, use the
appropriate compiler and linker to build a DLL, making sure to export the external
routines, as noted above. See your compiler and linker documentation for
instructions on building a DLL and exporting its functions.

After building the DLL, you can move it to any directory on your system. For the
example above, you can build the external routine find_max into a DLL called
EXTERN.DLL. To build the above example, go to ORACLE_BASE\ORACLE_
HOME\RDBMS\EXTPROC and type MAKE.

Step 4: Registering an External Routine

Once you have built a DLL containing your external routine(s), you must register
your external routine(s) with the Oracle8i database:

1. Create a PL/SQL library to map to the DLL.

Developing Applications 10-7



Building External Routines

2. Start SQL*Plus:
C\> SQAPLWB

3. Connect to the database with the appropriate user name and password.
4. Create the PL/SQL library using the CREATE LIBRARY command:
SQ > CREATE LI BRARY externProcedures AS ' C\ CRACLE (RAB1\ RDBVB

EXTPROO EXTERN DLL ;

Where...

Represents the...

ext er nProcedur es

C: \ ORACLE\ ORA81\ RDBMS\ EXTPROC\ EXTERN. DLL

Alias library (essentially a
schema object in the
database)

Path to the Windows 98
operating system DLL
EXTERN.DLL. This
example uses
C:\ORACLE as your
Oracle base and \ORA81
as your Oracle home.

Note: The DBA must grant EXECUTE privileges on the PL/SQL
library to users who want to call the library’s external routine from

PL/SQL or SQL.

5. Create a PL/SQL program unit specification.

Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause
instead of declarations and a BEGIN...END block. The EXTERNAL clause is the
interface between PL/SQL and the external routine. The EXTERNAL clause
identifies the following information about the external routine:

« Name
« DLL alias
« Programming language in which it was written

« Calling standard (defaults to C if omitted)
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CREATE OR REPLACE FUNCTI ON PLS_MAX(
x Bl NARY_| NTEGER,
y Bl NARY_| NTEGER)

RETURN BI NARY_| NTEGER AS

privileges for this library.
EXTERNAL LI BRARY ext er nProcedur es 4—/

External routine to call. If enclosed in

DLL alias. You need EXECUTE

NAME "fi nd_max" <
double quotes, it becomes case-sensitive.
LANGUAGE C <
PARAVETERS ( Language in which the external routine
was written.
x | ong, -- stores value of x
X_|I NDI CATOR short, ~-- used to determine if x is a NULL val ue
y long, -- stores value of y
y_I NDI CATOR short, -- used to deternmine if y is a NULL val ue

RETURN INDICATOR short ); -- need to pass pointer to return value’s indicator
-- variable to determine if NULL.
-- This means foattion will be defined as:
- long max(long x, short x_indicator,
- long y, short y_indicator, short * ret_indicator)
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Step 5: Executing an External Routine

To execute an external routine, you must call the PL/SQL program unit (that is, the
alias for the external function) that registered the external routine. These calls can
appear in any of the following:

« Anonymous blocks

« Standalone and packaged subprograms

« Methods of an object type

« Database triggers

«  SQL statements (calls to packaged functions only)

In "Step 4: Registering an External Routine”, the PL/SQL function PLS_MAX
registered the external routine find_max. Follow the steps below to execute fi nd_
max:

1. Call the PL/SQL function PLS_MAX from a PL/SQL routine named Uselt:

CREATE (R REPLACE PROCEDURE Wselt AS
a integer;
b integer;
c integer;

BEAQN

1

2,

PLS MAX(a, b);

bns_out put . put _| i ne(’ The maxi numof '||al|’ and "||b]|" is '||c);

a
b :
c

d
END,

2. Run the routine:
A > EXEQUTE Wsel t;

Accessing Web Data with Intercartridge Exchange
This section discusses the following topics:
« Configuring Intercartridge Exchange
« Using Intercartridge Exchange
« UTL_HTTP Exception Conditions
« Exception Conditions and Error Messages

« Troubleshooting
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Configuring Intercartridge Exchange
You must add a parameter to the registry before using Intercartridge Exchange.
To configure Intercartridge Exchange:
1. Start the registry editor from the MS-DOS command prompt:
C\>REET

The Registry Editor window appears.

2. Add HTTP_PROXY to the registry subkey of the Oracle home directory that
you are using. The location of this parameter is determined by how many
Oracle home directories are on your computer:

If you have... Add HTTP_PROXY to...

One home directory HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEOQ
Additional HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ HOMEID
directories

where ID is incremented for each additional Oracle home
directory on your computer.

3. Choose Add String Value from the Edit menu(Edit -> New -> String Value).

4. Type HTTP_PROXY in the Name field and press 'Enter’. Data field is empty
now.

5. Double click on HTTP_PROXY, Edit String dialog box will pop up.

6. Type www-proxyyoursite in the value data text box, e.g.,
www-proxy.marketing.com, where marketing.com is an example of a Web site.
(Type the domain name of your real Web site.)

Note: See Appendix C "Adding a Registry Parameter with
REGEDIT" on page C-9 for more instructions on adding a key.

Using Intercartridge Exchange

Intercartridge Exchange enables you to use a stored package called UTL_HTTP to
make Hypertext Transfer Protocol (HTTP) calls from PL/SQL, SQL, and SQL*Plus
statements.
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UTL_HTTP can do both of the following:
« Access data on the Internet
« Call Oracle Web Application Server cartridges

UTL_HTTP contains two similar entry points, known as packaged functions, that
turn PL/SQL and SQL statements into HTTP callouts:

« UTL_HTTP.REQUEST

« UTL_HTTP.REQUEST_PIECES

Both packaged functions peform the following tasks:

« Take astring universal resource locator (URL) of a site

« Contact that site

« Return the data (typically HTML) obtained from that site

The declarations to use with both packaged functions are described in the following
subsections.
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Packaged Function UTL_HTTP.REQUEST

UTL_HTTP.REQUEST uses a URL as its argument and returns up to the first 2000
bytes of data retrieved from that URL.

Specify UTL_HTTP.REQUEST as follows:

FUNCTI ON REQUEST (URL | N VARCHAR?) RETURN VARCHARZ;
Touse UTL_HTTP.REQUEST from SQL*Plus, enter:

SQ.> SELECT UTL_HTTP. REQUEST(’ HTTP: / / WWVCRACLE. GOM’ )  FROM DUAL;
which returns:

UTL_HTTP. REQUEST(’ HTTP: / / WWVCRACLE. GOM )

<ht nt >

<head><title>Qacl e Qorporation Hne Page</title>
<!--changed Jan. 16, 19

1 row sel ect ed.

Packaged Function UTL_HTTP.REQUEST_PIECES

UTL_HTTP.REQUEST_PIECES uses a URL as its argument and returns a PL/SQL
table of 2000 bytes of data retrieved from the given URL. The final element may be
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a
PL/SQL table of type UTL_HTTP.HTML_PIECES.

UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is
specified as:

type htm _pieces is table of varchar2(2000) index by binary_integer;
function request _pieces (url in varchar2,

nmax_pi eces natural default 32767)
return htm _pi eces;

A call to REQUEST_PIECES can look like the example below. Note the use of the
PL/SQL table method COUNT to discover the number of pieces returned; this may
be zero or more:

decl are pieces utl_http. htm _pi eces;
begi n
pieces := utl_http.request _pieces(’ http://wwn oracl e.com’);
for i in1 .. pieces.count |oop
.... -- process each piece
end | oop;
end;
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The second argument to UTL_HTTP.REQUEST_PIECES, (MAX_PIECES) is
optional. MAX_PIECES is the maximum number of pieces (each 2000 characters in
length, except for the last, which may be shorter) that UTL_HTTP.REQUEST _
PIECES returns. If provided, that argument is usually a positive integer.

For example, the following block retrieves up to 100 pieces of data (each 2000 bytes,
except perhaps the last) from the URL. The block prints the number of pieces
retrieved and the total length, in bytes, of the data retrieved.

set serveroutput on
/

decl are
x utl _http. ht M _pi eces;

begi n
X 1= utl_http.request_pieces(’ http://ww oracle.com’, 100);
dbns_out put . put_|ine(x.count || ' pieces were retrieved.');

dbns_output.put_line("wth total length ');
if x.count <1
then dbns_output.put_line(’0);
el se dbns_out put . put _| i ne

((2000 * (x.count - 1)) + length(x(x.count)));
end if;

end;

/

which outputs:

S at enent  pr ocessed.

4 pieces were retrieved.

with total length

7687
The elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are
successive pieces of data obtained from the HTTP request to that URL.

UTL_HTTP Exception Conditions

This subsection describes the exceptions (errors) that can be raised by packaged
functions UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.

UTL_HTTP.REQUEST
PRAGMA RESTRICT_REFERENCES enables the display of exceptions:

create or replace package utl_httpis
function request (url in varchar2) return varchar2;
pragna restrict_references (request, wnds, rnds, wips, rnps);
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UTL_HTTP.REQUEST_PIECES
PRAGMA RESTRICT_REFERENCES enables exceptions to be displayed:

create or repl ace package utl _httpis
type htm _pieces is table of varchar2(2000) index by binary_integer;
function request_pi eces (url in varchar2,
nmax_pi eces natural default 32767)
return htm _pi eces;
pragna restrict_references (request_pi eces, wnds, rnds, wips, rnps);

Exception Conditions and Error Messages
The following table describes error messages that may appear.

If... Then...

Initialization of the HTTP callout subsystem fails Exception UTL_HTTP.INIT_FAILED is raised:
for environmental reasons such as lack of
available memory

init_failed exception;

The HTTP call fails due to failure of the HTTP Exception UTL_HTTP.REQUEST_FAILED is raised:
daemon or because the argument to REQUEST or
REQUEST_PIECES cannot be interpreted as a

URL, because it is NULL or has non-HTTP syntax

request _failed exception;
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If... Then...
No response is received from a request to the A formatted HTML error message may be returned:
given URL, because the function made no contact <HTML>
with a site corresponding to that URL
<HEAD>
<TlI TLE>Error Message</ Tl TLE>
</ HEAD>
<BODY>

<Hl1>Fatal Error 500</H1>

Can’t Access Docurment:
http://hone. not hi ng. conm

<p>

<B>Reason: </ B> Can’'t |ocate renpte host:
horne. not hi ng. conm

<pP>

<P><HR>

<ADDRESS><A HREF="ht t p: / / www. W3. or g" >
CERN- HTTPD3. 0A</ A></ ADDRESS>

</ BCDY>

</ HTM.>

Note: The first two exceptions in the preceding table, unless
explicitly caught by an exception handler, are reported by this
generic message:

ORA-06510: PL/SQ.: unhandl ed user-defi ned
exception

that shows them as "user-defined" exceptions, although they are
defined in this system package.

If any other exception is raised during the processing of the HTTP
request (for example, an out-of-memory error), then function UTL _
HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES reraises that
exception.
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Troubleshooting

Do not expect UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES to succeed
in contacting a URL unless you can contact that URL by using a browser on the
same computer (and with the same privileges, environment variables, and so on).

If UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES fails (that is, if it raises
an exception or returns an HTML-formatted error message, yet you believe that the
URL argument is correct), try contacting that same URL with a browser to verify
network availability from your computer.
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Directory Structures

This appendix describes the default directory structures created when you install
Oracle8i Personal Edition components.

Specific topics discussed are:
« Oracle8i Personal Edition Directory Structure

= Filename Extensions

See:

Chapter 3, "Multiple Oracle Homes and Optimal Flexible
Architecture” for more information on Oracle homes and OFA. See
especially "Directory Tree of a Sample OFA-Compliant Database"
on page 3-18 for a depiction of how the default OFA-compliant
directory tree is organized.
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Oracle8i Personal Edition Directory Structure
ORACLE_BASE is the root of the Oracle directory tree.

Oracle Universal Installer places Oracle products into the \ORACLE_HOME,
\ADMIN, and \ORADATA directories of ORACLE_BASE.

The \ADMIN and \ORADATA directories contain one or more \DB_NAME
directories. DB_NAME is the unique name for a database and has the same value as
the DB_NAME parameter in the INIT.ORA file. Database files are stored in
ORACLE_BASE\ORADATA\DB_NAME.

See: Oracle8i Installation Guide for Windows 98 for the database
files stored in ORACLE_BASE\ORADATA\DB_NAME.

The following sections describe these directories in ORACLE_BASE:
« ORACLE_HOME
« ADMIN

ORACLE_HOME

If you install Oracle8i Personal Edition with the Typical installation type, the
following directories are created. If you install additional Oracle products, other
directories are also created.

Directory Contents
\ASSISTANTS Oracle assistants. \ASSISTANTS contains the following
subdirectories:
\DBCA «  Oracle Database Configuration Assistant files
\DBMA «  Oracle Data Migration Assistant files
\IFA «  Oracle INTYPE File Assistant files
\JLIB « Java files used by the assistants
\BIN Executable files
\COM Oracle COM Automation feature files
\DEMOS «  Sample SQL File
\MESG «  Message Files
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Directory Contents
\DATABASE This is a legacy directory from previous releases. It
contains an initialization parameter file that points to the
new directory location for initialization parameter files.
\DOC HTML documentation library
\JAVAVM Java Virtual Machine files.
\ADMIN . DLLs for JAVAVM
\DOC «  Readme files
\IDL « Interface Definition Language files
\INSTALL «  SQL files for JAVAVM
\LIB « Library Class files
\JDBC Java Database Connectivity (JDBC) drivers files. \JDBC
contains the following subdirectories:
\DOC «  Documentation
\LIB « Library class files
\DEMO «  Sample programs
\JLIB Java files used by various applications
\LDAP Directory Server files
\LIB Library Class files
\MSHELP Help files
\NAV81 Navigator project files
\NETWORK Net8 files. \NETWORK contains the following
subdirectories:
\ADMIN «  Configuration files
\DOCS « Release notes
\INSTALL «  Contains response file template for silent
installation.
\JLIB « Java files used by Net8 assistants
\LOG « Log files (default location)
\MESG «  Message files
\TNSAPI «  Net8 Open API-related files
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Directory Contents
\TOOLS = Net8 assistant files
\TRACE «  Trace files (default location)
\OCI Oracle Call Interface files. \OCI contains the following
subdirectories:
\INCLUDE = Header files
\LIB « Library files
\SAMPLES «  Sample files
\OCOMMON Oracle common files
\NLS NLS files
\ODBC Oracle ODBC files
\OLEDB Oracle OLEDB files. \OLEDB contains the following
subdirectories:
\DOC = User’s Guide and Readme files
\INCLUDE « Header files
\LIB « Library files
\MESG «  Message files
\SAMPLES «  Sample Files
\O040 Oracle Objects for OLE files. \OO40 contains the
following subdirectories:
\CPP « Header files, library files, and sample files
\EXCEL «  Microsoft Excel sample files
\IIS « Internet Information Server sample files
\MESG «  Message files
\VB « Visual Basic sample files
\ORACORE Message files
\ORAINST Sample Registry export
\OTRACE Oracle Trace files. \OTRACE contains the following
subdirectories:
\ADMIN « Administration files, including SQL scripts
\DEMO « Sample programs
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Directory Contents

\LIB « Library files

\MESG «  Message files

\PUBLIC « Header files

\PLSQL SQL scripts, sample files, and message files for PL/SQL

\DEMO « Demofiles

\MESG «  Message files

\PRECOMP Object Type Translator (OTT)

\ADMIN «  OTT configuration log file

\DEMO « Demo SQLs

\DOC «  OTT Readme files

\MESSG «  Message files

\PUBLIC = Header files

\RDBMS Oracle Server files. \RDBMS contains the following
subdirectories:

\ADMIN «  Oracle database SQL scripts (including
CATALOG.SQL and CATPROC.SQL). Use SQL
scripts to create data dictionary tables and views,
and other views used by Oracle software.
Additional Information: See Chapter 5, "SQL
Scripts" in Oracle8i Reference.

\DEMO « Demo files

\JLIB « Library files

\TRACE «  Oracle Trace and Log files

\EXTPROC «  External procedure sample files

\MESG «  Message files

\XA «  Oracle XA files

\RELNOTES Release notes and Readme files
\COM « Readme file of COM Automation Feature Support
\JAVAVM = Readme file of JavavVM
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Directory Contents
\0040 «  Release notes of Oracle Objects for OLE
\PRECOMP « Readme file for Object Type Translator
\SQLJ « Readme file for SQLJ and JPublisher
\SLAX Oracle SLAX files. \SLAX contains the following
subdirectory:
\MESG «  Message file of SLAX
\SQLJ Oracle SQLJ Translator files. \SQLJ contains the
following subdirectories:
\DEMO «  Sample programs
\DOC «  Release notes, white papers, package descriptions,
the SQLJ specification, and the Oracle SQLJ
Developer’s Guide and Reference
\LIB « Class files and a SQL script
\SQLPLUS SQL*Plus files. \SQLPLUS contains the following
subdirectories:
\ADMIN «  SQL scripts for administering SQL*Plus
\DEMO «  SQL scripts for sample tables
\DOC = Release notes
\MESG «  Message files
\SVRMGR Oracle Server Manager files. \SVRMGR contains the
following directory:
\ADMIN «  Server Manager files

ADMIN

Database administration files are stored in subdirectories of ORACLE_

BASEN\ADMIN\DB_NAME.

The following table describes these subdirectories.

Directory Contents
\ADHOC Ad hoc SQL scripts
\BDUMP Background process trace files (default location)
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Directory Contents

\CDUMP Core dump files

\CREATE Database creation files

\EXP Database export files

\PFILE Initialization parameter files

\UDUMP User process trace files (default location)

Filename Extensions

A description of filename extensions is shown below.

Extension Description

. aud Oracle audit file

. bmp bitmap file

.C C source file

.ctl SQL*Loader control file; Oracle Server control file
. dat SQL*Loader datafile

. dbf Oracle Server tablespace file

.dnp Export file

. doc ASCII text file

.h C header file; also, sr. h is a SQL*Report Writer help file
Lidl Interface Definition Language files

Jar Java class archive

lis output of SQL*Plus scripts

.l og installation log files; Oracle Server redo log files
. nk make files

. msb NLS message file (binary)

. NBg NLS message file (text)

.0 object module

.ora Oracle configuration files

.rsp Response file for slient installation

. sql SQL* script files

.tab SQL* script file
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.trc trace files
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Oracle8/ Database Specifications for
Windows 98

Oracle8i Personal Edition uses initialization parameters on Windows 98 to enable
various features of the database every time an instance is started.

Specific topics discussed are:
« Initialization Parameter File (INIT.ORA) Overview
« Initialization Parameters Without Windows 98-Specific Values

« Calculating Database Limits
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Initialization Parameter File (INIT.ORA) Overview

An initialization parameter file is an ASCII text file containing parameters. By
changing the parameters and values in an initialization file, you can specify, for
example:

« the amount of memory the database uses
«  Whether to archive filled online redo logs
« which control files currently exist for the database

Every database instance has a corresponding initialization parameter file and
ORACLE_SID registry parameter that points to the system identifier (SID) for the
instance.

The initialization parameter file name takes the form INIT.ORA. A single instance
might have several initialization parameter files, each having some differences that
affect system performance.

See:

= Your INIT.ORA file for initialization parameters set by Oracle
Universal Installer during an Oracle8i Personal Edition typical
installation type. These parameters may vary, depending on
your hardware configuration.

= Oracle8i Reference for descriptions of all initialization
parameters and instructions for setting and displaying their
values.

Location of the Initialization Parameter File

By default, Oracle8i Personal Edition uses the initialization parameter files located
in ORACLE_BASE\ADMIN\DB_NAMEN\PFILE, unless you specify a different
initialization file with the PFILE option at database startup.

Editing the Initialization Parameter File

To customize Oracle8i database functions, you may need to edit the initialization
parameter files. Only use an ASCII text editor to modify the file.
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Sample File

A sample file called INITSMPL.ORA is located in the ORACLE_BASE
\ADMIN\SAMPLEN\PFILE directory.

Note: If you create a database manually using the BUILD_DB.SQL
script, you need to create an INIT.ORA file or copy an existing
INIT.ORA file and modify the contents. If you use Oracle Database
Configuration Assistant to create a database, the INIT.ORA file is
automatically created for you.

If you want to use the sample INITSMPL.ORA file as part of database creation:
1. Rename the file INIT.ORA.

2. Edit this file to reflect the correct location of your database control files and the
name of your database, as a minimum.

If you installed a starter database, the initialization parameter file INIT.ORA used
by the starter database is located in ORACLE_BASE\ADMIN\DB_NAME\PFILE.
You can use either INITSMPL.ORA or the starter database INIT.ORA as a basis for
creating a new Oracle8i database initialization parameter file.

The annotated, sample initialization parameter file contains alternative values for
the initialization parameters. These values and the annotations are preceded by
comment signs (#), which prevent them from being processed. To activate a
particular parameter, remove the preceding # sign. When you no longer want to use
a particular parameter, edit the initialization parameter file to add a comment sign.

For example, several initialization parameters are specified with three different
values to create small, medium, or large System Global Areas (SGAS), respectively.
The parameter that creates a small SGA is active in the following example:

db_bl ock buffers = 200 # SVALL
# db_bl ock_buffers = 550 # MED UM
# db_bl ock_buffers = 3200 # LARGE

To create a medium-sized SGA, comment out the small parameter definition and
activate the medium parameter definition. Edit the initialization parameter file as
follows:

# db_bl ock _buffers = 200 # SMALL
db_bl ock buffers = 550 # MED UM
# db_bl ock _buffers = 3200 # LARGE
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Initialization

Parameters Without Windows 98-Specific Values

Oracle8i Reference describes the default values for many initialization parameters as
being operating system-specific. However, not all the parameters that Oracle8i
Reference describes as having operating system-specific values affect Windows 98. In
these cases, Windows 98 uses either the default value set in the Oracle8i kernel or
does not use the parameter. This table describes these initialization parameters:

Parameter

Description

AUDIT_FILE_DEST

Not supported on Windows 98 and should not be added to the
initialization parameter file.

DB_WRITER_PROCESSES Not applicable or necessary on Windows 98.

COMPATIBLE_NO_RECOVERY Uses default value set in Oracle8i kernel (no Windows 98-specific value).

CORE_DUMP_DEST

Not applicable to Windows 98.

CPU_COUNT Oracle8i automatically sets value to number of CPUs available for your
Oracle instance.

HI_SHARED_MEMORY_ADDRESS Not applicable to Windows 98.

SHARED_MEMORY_ADDRESS Not applicable to Windows 98.

LARGE_POOL_SIZE

Uses maximum value limited by available memory.

LOG_BUFFER Starter database uses value set in Oracle8i kernel (no Windows 98-specific
value). The Custom database creation option of the Oracle Database
Configuration Assistant enables you to customize the value for this
parameter.

ORACLE_TRACE_COLLECTION_PATH Uses default value set in Oracle8i kernel (no Windows 98-specific value).

ORACLE_TRACE_FACILITY_NAME Uses default value set in Oracle8i kernel (no Windows 98-specific value).

ORACLE_TRACE_FACILITY_PATH Uses default value set in Oracle8i kernel (no Windows 98-specific value).

Displaying Initialization Parameter Values

Windows 98-specific parameter values can be viewed by using an ASCII editor to
open the ORACLE_BASE\NADMIN\DB_NAME\PFILE\INIT.ORA file. To display
all parameter values (whether set in the INIT.ORA file or the Oracle8i kernel), enter
the following command at the SQL*Plus command prompt:

SQA> SHON PARAMETER PARAVETER NAVE
where PARAMETER_NAME is the name of a specific initialization parameter.

The value for this parameter, whether defined in the ORACLE_BASE\ADMIN\DB _
NAME\PFILENINIT.ORA file or the Oracle8i kernel, displays on-screen.
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Database Initialization Parameters

Check the following initialization parameters when creating a new database. They
cannot be modified after you have created the database. See Chapter 6,
"Post-Installation Database Creation” for details on creating a new database,
including the part of the procedure when you modify these parameters.

Parameter Description

CHARACTER SET! Specifies the database l_\lational Language Support (NLS)
character set to use. This parameter can be set only when you
create the database.

DB_BLOCK_SIZE Specifies the size in bytes of Oracle database blocks.

DB_NAME Specifies the name of the database to be created. The database
name is a string of eight characters or less. You cannot change
the name of a database.

! Not an initialization parameter, but rather a clause in the CREATE DATABASE statement. See
Chapter 6, "Post-Installation Database Creation" for an example of using this clause.

Calculating Database Limits

Use the size guidelines in the following table to calculate Oracle8i database limits
using the equations given in the Oracle8i Administrators Guide.

Type Size
Maximum block size 16,384 bytes or 16 kilobytes (KB)
Maximum blocks per file 4,194,304 blocks

Maximum possible file 64 Gigabytes (GB)

size with 16 K sized (4,194,304 * 16,384) = 64
blocks gigabytes (GB)

Maximum number of

files per database

(depends on block size):
2 K sized blocks 20,000 files
4 K sized blocks 40,000 files
8 K sized blocks 65,536 files

16 K sized blocks 65,536 files
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Type Size

Maximum file size fora 4 GB
FAT file!

Maximum database size 65,536 * 64 GB equals
approximately 4 Petabytes (PB)

Maximum number of

extents per database

(depends on block size).

Typical values are:
2 KB sized blocks 121 extents
4 KB sized blocks 255 extents
8 KB sized blocks 504 extents
16 KB sized blocks 1032 extents

32 KB sized blocks 2070 extents

Shadow Process

Memory:
Release 8.1.6 335 K
Release 8.0.4 254 K

1 Maximum file size for a 16 bit FAT partition is 2 GB

See: To calculate the space required by an index, use the
equations given in Oracle8i Administrator’s Guide.
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Oracle8/ Configuration Parameters and the

Registry

This appendix describes use of the registry for various Oracle8i Personal Edition for
Windows 98 components. It also lists the recommended values and ranges for
configuration parameters.

Specific topics discussed are:

About Configuration Parameters

Registry Overview

Registry Parameters

Adding a Registry Parameter with REGEDIT

Adding or Modifying Initialization File Parameters and Registry Parameters
with Oracle8i Navigatior’s "Parameter Configurer”
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About Configuration Parameters

Oracle8i Personal Edition for Windows 98 uses configuration parameters to locate
files and specify runtime parameters common to all Oracle products. When an
Oracle program or application requires a translation for a particular configuration
variable, Oracle8i Personal Edition for Windows 98 uses the associated parameter.
All Oracle parameters are stored in the registry.

Registry Overview

Oracle8i Personal Edition for Windows 98 stores its configuration information in a
database (the registry) that is organized in a tree format. The tree format consists of
keys in the registry and parameter values for the keys. Keys and parameter values
can be viewed and modified in the Registry Editor.

Keys are folders that appear in the left pane of a Registry Editor window. A key
contains subkeys or parameters.

WARNING: Although the Registry Editor lets you view and
modify registry keys and parameter values, you normally do not
need to do so. In fact, you may render your system useless if you
make incorrect changes. Therefore, only advanced users should
edit the registry! Back up your system before making any changes
in the registry.

Parameters in the Registry Editor appear as a string, consisting of two components:
« Parameter name

« Value itself

For example, parameter ORACLE_SID can have the following entry in the registry:
QRACLE SID QROLL

Most Oracle8i Personal Edition for Windows 98 parameter values are string types.
Use Oracle Universal Installer defaults when a type is not given.

Registry Parameters

This section describes the Oracle8i Personal Edition for Windows 98 registry
parameters for the following keys. Other products may have additional keys and
parameters that are not described in this appendix.
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« HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

« HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

« HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES
« HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet

To modify the registry values described below, see "Modifying a Registry Value
with REGEDIT" on page C-8.

Note: This appendix describes how to use REGEDIT to edit your
registry.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

Each time you install Oracle products into a new Oracle home on your computer,
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID is created and ID is
incremented. This subkey contains parameter values for most Oracle products.

Additional Information: See Chapter 3, "Multiple Oracle Homes
and Optimal Flexible Architecture" for details on the PATH
variable and registry values when you are working with multiple
Oracle homes.

This figure shows the parameter subkeys created with two Oracle home directories
on the same computer.
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The first Oracle installation
on a computer creates
parameter subkey HOMEQ.

The second installation of a "Multiple Oracle
Homes" enabled product (e.g. SQL*PIlus) on a
computer creates parameter subkey HOME1. With
each installation into a new Oracle home, HOMEID
is created and incremented.

HKEY_LOCAL_MACHINE\ASOFTWARE\ORACLE\HOMEID includes the
following parameters for an Oracle home directory on a computer. Depending on
the products you install, additional parameters can also be created.

Parameter Description Default Value

MSHELP_TOOLS Specifies the location of the Windows help files. ORACLE_BASE\ORACLE_

HOME\MSHELP
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Parameter Description Default Value
NLS_LANG Specifies the supported language, territory, and During installation, Oracle
character set. This parameter specifies the Universal Installer sets this value
language in which the messages are displayed, the based on the language setting of
territory and its conventions for calculating week  the operating system. See Oracle8i
and day numbers, and the character set displayed. Installation Guide for Windows 98 for
a list of commonly used values.
Note: If this parameter is deleted at
a later time, Oracle uses the value
AMERICAN_
AMERICA.US7ASCII.
ORA_CWD Specifies the current working directory. This The value for this parameter must

ORA_SID_PFILE

ORACLE_BASE

ORACLE_GROUP_
NAME

ORACLE_HOME

ORACLE_HOME_
KEY

ORACLE_HOME_
NAME

NAVS1

PO8

parameter must be manually set.

The full path to the initialization parameter file.

The top-level Oracle directory (for example,
C:\ORACLE) that contains ORACLE_HOME,
\ADMIN, and \ORADATA.

Specifies the name of the group containing icons of
the Oracle products installed. The parameter is
added to your registry when you first install
Oracle products, even if Oracle Universal Installer
does not create a program group for the Oracle
products you have installed (for example, if you
have installed only Net8 software).

Specifies the Oracle home directory in which
Oracle products are installed. This directory is
immediately beneath the Oracle base directory in
the Oracle directory hierarchy.

The HKEY_LOCAL_MACHINE location of Oracle
parameters.

Specifies the home name of the Oracle home
directory in which Oracle products are installed.

Specifies Oracle8i Navigator files

Specifies that the Oracle8i Navigator be used

be set manually.

ORACLE_BASE\ADMIN\DB_
NAMEN\PFILE\INIT.ORA

ORACLE_BASE

Oracle - HOME_NAME

The drive letter and name that you
specify during installation

SOFTWARE\ORACLE\HOMEID

The name that you specify during
installation

ORACLE_BASE\ORACLE_
HOME\NAVS1

YES
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Parameter Description Default Value
DATABASE_ Specifies whether the database should be AUTO
STARTUP mounted, if not star_ted and mounted already, (If it is set to NOAUTO, database
when connected using Server Manager/ il b d if
SQL*Plus/ Oracle8i Navigator will not be mounted even If not
already mounted when connected
using Server Manager/
SQL*Plus/Oracle8i Navigator)
ORACLE_SID Specifies the name of the Oracle database instance  The default value is specified by
on the host machine. The value of this parameter is  the entry in the Database
the SID for the instance. Identification window of Oracle
Universal Installer.
RDBMS _ Specifies the location of the backup database files. ORACLE_BASE\ORACLE_
ARCHIVE HOME\DATABASE
\ARCHIVE
RDBMS _ Specifies the location of the backup database ORACLE_BASE\ORACLE_
CONTROL control files. HOME\DATABASE
SQLPATH Specifies the location of SQL scripts. ORACLE_BASE\ORACLE_

HOME\DBS

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

This subkey contains the following parameters:

Parameter Description Default Value Entry

INST_LOC Specifies the location of Oracle Universal Installer System Drive:\Program
files. Files\Oracle\Inventory

0040 Specifies the location of Oracle Objects for OLE ORACLE_BASE\ORACLE_

message files.

HOMEN\OO40\MESG

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES

This subkey provides general information on each Oracle home directory on a
computer. This subkey contains the IDx subkey(s) and its parameters, described
below, as well as other parameters listed on page C-7.

IDx

This subkey corresponds to the HOMEID of the same number (for example, HOMEQ
for the first installation, HOMEL1 for the second installation, and so on). IDx contains
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the following parameters. The values that display are determined by what you
enter during installation in the File Locations dialog box of Oracle Universal

Installer.
Parameter Description Default Value Entry
NAME Specifies the home name of the Oracle home for The name that you specify during
IDx. This is the value that you specify when installation.
prompted for an Oracle home name.
PATH Specifies the Oracle home directory for IDx. ORACLE_BASE\ORACLE_HOME

HKEY LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES Parameters
This subkey contains the following parameters.

Parameter Description Default Value
DEFAULT_HOME  Specifies the default Oracle home name (that is, the The name that you specify during
first Oracle home installed on your machine). installation.

HOME_COUNTER  Specifies the number of installed Oracle homes. 1
LAST_HOME Displays the ID number of the most recently 0

installed Oracle home. For example, if HOMEO was
the most recently installed Oracle home, the
number 0 appears.
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Modifying a Registry Value with REGEDIT

CAUTION: Do not edit your registry unless absolutely necessary.
If an error occurs in your registry, Oracle8i Personal Edition for

Windows 98 can stop functioning and the registry itself can
become unusable.

To edit the Oracle-related settings:
1. Start the registry in one of two ways:

« From the command prompt, enter:
C\>REEDT

« Choose Start > Run, enter REGEDIT in the Open field, and click OK.
The Registry Editor window appears.
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2. Navigate to the values you want to view or modify by double-clicking the
appropriate keys.

The left-hand side of the window shows the hierarchy of registry keys, and the
right-hand side of the window shows various values associated with a key.

3. Double-click the parameter to edit.

The String Editor dialog box appears:

Wik e
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4. Make any necessary edits.
5. Click OK.

6. Choose Exit from the Registry menu.

Adding a Registry Parameter with REGEDIT
To add a parameter to the registry:
1. Start the registry in one of two ways:
« From the MS-DOS command prompt, enter:
C\>REEDT

« Choose Start > Run, enter REGEDIT in the Open field, and click OK.
The Registry Editor window appears.
2. Navigate to the key to which you want to add the new value.

3. Choose New-> String Value from the Edit menu. You can select either of the
following three types of values

« String Value

« Binary Value
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« DWORD Value (hexadecimal data)

4. Type the name that you want to assign to the currently created values for the
selected key.

5. To enter the data, select the ‘Value’ then select ‘Modify’ from ‘Edit’ menu.

A Edit dialog box appropriate for the data type appears:
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6. Type the value for the parameter.
7. Click OK.

The Registry Editor adds the parameter.
8. Choose Exit from the Registry menu.

9. The registry exits.

Adding or Modifying Initialization File Parameters and Registry
Parameters with Oracle8i Navigatior’s "Parameter Configurer"

Introducing Database Parameter Configuration Assistant

Database Parameter Configuration Assistant provides an easy to use interface to
manipulate the parameters in the database initialization files (for example,

i nit.orafile). These parameters are also called the Database Initialization
Parameters. It also provides a user interface for safe manipulation of the registry
parameters used by the Oracle8i Database Server. These parameters in the registry
are called Oracle8i Configuration Parameters.
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Introduction to Manipulating Database Initialization Parameters

The Initialization Parameter file is a text file that contains a list of parameters and a
value for each parameter. The name of the parameter file varies depending on the
operating system. For example, it can be in mixed case or lowercase, or it can have
a logical name or a variation of the namei ni t. ora.

Database administrators can use initialization parameters to:

«  Optimize performance by adjusting memory structures, such as the number of
database buffers in memory

« Set some database-wide defaults, such as the amount of space initially allocated
for a context area when it is created

« Set database limits, such as the maximum number of database users
«  Specify names of files

For more details on the Initialization Parameter file and individual parameters in
this file refer to the Oracle8i Reference documentation available under Oracle 8i
Server in the documentation accompanying the CD.

On opening an already existing database initialization file, you will see a list of
parameters present in that file and all the files included therein as shown in the
following figure:
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Note: 1. The parameters specified in the initialization
files are used by the database to initialize
itself when starting up. Hence any changes
that you make to this file will take effect only
after you restart the database.

2. Alter Session and Alter System commands
are not supported by the Parameter
Configuration Assistant.

3. The Parameter Configuration Assistant will
not list parameters whose value is dependent
on other parameters.

4. The system will maintain a backup of
initialization file being modified. For
example, if you are modifying a file init.ora in
the directory c:\oracle\ora81\database, then
a backup of the file named as
init.ora.<timestamp> in the same directory
location will be kept.

Opening a window to manipulate database initialization files
1. Click on menu option View.

2. Under the Parameter Configuration menu option, a menu will pop up

3. Click on the initialization file and a window to manipulate the database
parameters will be opened.

Creating a new initialization file
1. Click on menu File -> New

2. Afile dialogue will pop up. Choose the file into which the parameters have to
be saved.

3. Start adding parameters.

4. After you are done, save the file.

To open an already existing parameter file
1. Click on menu File -> open
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2.
3.

From the popped up file dialogue, choose the parameter file to open.

If the parameter file is successfully opened, then you should see the list of
parameters and their values on the window.

To add a parameter

1. Before adding a parameter, you should either have opened an already existing
parameter file or created a new parameter file.

2. Click on menu Edit -> Add or right-click in the window and select Add from
the menu.

3. Adialogue box will pop up containing the following fields.

Name The name of the parameter.

Value The value of that parameter.

Range The valid range of the parameter, if

any.

Save in File The file in which the parameter has to

be saved.

4. Select the parameter you want to add from the available list present against
Name.

5. Enter the value of the parameter in the Value field. (The range of the chosen
parameter is shown in the Range field. The Range field is not editable.)

6. In Save in File field, you will see a filename where the parameter will be saved.
This filename will be same as the filename you provided while creating a new
parameter file or opening an already existing file. In case you want to organize
the parameters across many files and include the files from one file using IFILE
parameter, change the Save in File to a suitable file name.

7. Click OK to reflect the change on the window, click Cancel to discard the

change.

Deleting a Parameter

1.

Click on the parameter to be deleted.
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2. Click Edit -> Delete or right click on the parameter to be deleted and select
Delete from the menu.

Modifying a Parameter Value

1. Double-Click on the parameter to be modified or right click on the parameter to
be modified and select Modify from the menu.

2. Change the value of the parameter in the Dialogue box that appears.

3. Click OK to reflect the change on the window, click Cancel to discard the
change.

Note:

For using parameter IFILE, to include an initialization file in a nested initialization
file, you should also specify the filename in which the value of the ifile has to be
placed.

For example, if you have ai ni t 1. or a file including init2.ora file which in turn
includesi ni t 3. or a file, then the GUI will show the value for the parameter IFILE
as:

initl.ora::init2.ora, init2.ora::init3.ora.
initl. ora

+---->jnit2.ora

+---->init3.ora
If you want to include another filei ni t 4. oraintoi ni t 2. or a, the value of IFILE
shown in the GUI has to be modified to:

initl.ora::init2.ora, init2.ora::init3.ora, init2. ora::init4. ora.
Now the structure of the files included will be:

initl. ora

+---->jnit2.ora

+----->jnit3.ora
+----->init4d.ora

Saving the parameters
1. Click on menu File -> Save.

The parameters will be saved into the files that appears in the "Save in File" field of
the respective parameters.
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Introduction to Manipulating Oracle8i Configuration Parameters

Oracle 8i Personal Edition uses configuration parameters to locate files and specify
run time parameters common to all Oracle products. All Oracle parameters are
stored in the registry. Database Parameter Configuration Assistant provides a user
interface for safe manipulation of the registry parameters used by the Oracle8i
Database Server.

The following is a short description of the window used to modify the
configuration parameters.
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1. On opening a window to manipulate the Oracle 8i configuration parameters
(and if you have Oracle Server installed in any of the Oracle Home locations),
you will see a tree of Oracle Homes in the left window.

2. Each Oracle Home has a list of predefined number of SID-independent
parameters i.e., the parameters that are common to all SIDs like DBA _
AUTHORIZATION, DATABASE_STARTUP etc., and a list of SIDs belonging to
that Home.
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3. Each SID has a list of predefined number of SID-specific parameters i.e.,
parameters that are specific for different SIDs like ORA_SID_PFILE, ORA_SID _
PWFILE.

4. On expanding each of the Oracle Home that appears in the tree, you will see
two folders, one for SID-independent parameters; another for SID specific
parameters.

5. On expanding the SID-Independent Parameters folder, you will see the list of
SID-independent parameters and their corresponding values for that Oracle
Home in the right window.

6. On expanding the SID List folder, you will see a list of available SIDs under that
Home. Clicking on any of the SID folders will show a list of SID specific
parameters and their corresponding values in the right window.

Opening a window to manipulate configuration parameters
1. Click on menu option View.

2. Under the Parameter Configuration menu option, a menu will pop up.

3. Click on the Configuration Parameters and a window to manipulate the registry
parameters will pop up.

Note:
1. You will see a tree of installed Oracle Homes in the left window.

2. Each Oracle Home has a list of predefined number of SID-independent
parameters and a list of SIDs belonging to that Home.

3. Each SID has a list of predefined number of SID specific parameters.

4. On expanding each of the Oracle Home that appears in the tree, you will see
two folders, SID Independent and SID List.

5.  On expanding the SID Independent folder, you will see the list of SID
independent parameters and their corresponding values for that Oracle Home
in the right window.

6. On expanding the SID List folder, you will see a list of available SIDs under that
Home.

7. Clicking on any of the SID folders will show a list of SID specific parameters
and their corresponding values in the right window.
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Modifying a parameter value

1. By clicking on the appropriate tree elements in the left window, have the
parameter -- that needs to be changed -- to appear in the right window.

2. For example, if you want to change the ORA_ORCL_PFILE parameter for SID =
ORCL in Home_0, then expand Home_0, expand SID List that is present under
Home_0, click on ORCL, that should appear on the left window on expanding
the SID List. You should see the parameter ORA_ORCL_PFILE on the right
window.

3. Double click on the parameter to be modified or right click on the parameter to
be modified and select Modify from the menu.

4. A dialogue box will pop up. Enter the new value for the parameter in the
dialogue box.

5. Click OK to reflect the change, click Cancel to discard the change.

Deleting a particular parameter

The parameters cannot be deleted. If you want to avoid writing the parameter into
the registry then modify the parameter and make that parameter value as NULL.

For example, to delete ORA_ORCL_PFILE for the SID ORCL , modify ORA_ORCL_
PFILE and clear the string that appears on the modify dialogue box and click on
OK. You should see a " against the value for ORA_ORCL_PFILE after this
modification. Or right click on the parameter you want to delete and select Clear.

Note: Saving the registry parameter value changes, Click on menu
File -> Save.

Reload the parameter values from the registry, Click on menu View
-> Refresh.
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Net8 Configuration

This appendix describes Net8 configuration for Windows 98. For an overview of
Net8 configuration in general, see the Net8 Administrator’s Guide.

Specific topics discussed are:

Unsupported Net8 Features

Understanding Net8 Registry Parameter and Subkeys
Listener Requirements

Understanding Optional Configuration Parameters
Net8 Port Numbers
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Unsupported Net8 Features

The following Net8 features are currently unsupported on Windows 98 platform.

Feature Description
TRCROUTE Client application not supported.
SPAWN SPAWN command in the listener control

utility is not supported.

Pre-SPAWNED dedicated Not supported by the listener. Therefore, do

server processes not include the following parameters in the
SID_DESC'’s of the LISTENER.ORA file:
PRESPAWN_MAX, PROTOCOL, POOL_SIZE,
and TIMEOUT.

Understanding Net8 Registry Parameter and Subkeys

Net8 contains the registry entries for Net8 parameters and Net8 service subkeys. To
successfully add or modify Net8 configuration parameters, you must understand
where they are located and the rules that apply to them.

Net8 Parameters
The location of the Oracle Net8 registry parameters is:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

where ID is incremented for each additional Oracle home directory on your
computer (for example, HOMEQ is for a first directory, HOMEL is for a second
directory, and so forth).

Listener Requirements

A release 8.1.6 listener is required for the Oracle8i release 8.1.6 database. Previous
versions of the listener are not supported with the Oracle8i release 8.1.6 database.
However, the release 8.1.6 listener is supported with previous versions of the
database.

Once Oracle8i is installed, Oracle Corporation recommends that you use the release
8.1.6 listener for all of your Oracle release 8.1 databases and previous releases (such
as an Oracle8 8.0 database). Even if you install Oracle8i in multiple Oracle homes on
the same computer, you should only use one listener for all your databases on the
same computer.
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If you must use multiple listeners (such as a Net8 8.0 listener and Net8 8.1 listener)
on the same computer, see the Net8 Administrator’s Guide and Chapter 5 for more
information.

You can start your 8.1.6 listener by using the LSNRCTL control utility:
To start the listener using LSNRCTL:
C\> LSNRCTL START LI STENER NAME

where LISTENER NAME is the listener name for typical install or a name given
during custom install.

To exit the utility:

LS\RCTL> EX T

In past releases, information about instances was configured manually in the
LISTENER.ORA file. Instance registration is now automatic. Instances register
themselves with the listener when they are started.

Understanding Optional Configuration Parameters

LOCAL

You can use the following parameters on Windows 98:
« LOCAL

« TNS_ADMIN

« USE_SHARED_SOCKET

Net8 first checks for the parameters as environment variables, and uses the values
defined. If environment variables are not defined, it searches for these parameters
in the registry.

Additional Information: See Appendix C, "Oracle8i Configuration
Parameters and the Registry" for instructions on editing Windows
registry keys.

You can add the LOCAL parameter to make a connection without specifying a
connect string service name. The value for LOCAL is the service name in the
TNSNAMES. CRA file located in the ORACLE_BASE\ORACLE_
HOMEN\NETWORK\ ADM N directory.
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TNS_ADMIN

For example, if the LOCAL parameter is specified as finance, you connect to a
database from SQL*Plus with the following command:

SQA> GONNECT SQOTT/ Tl GRR

Net8 checks if LOCAL is defined as an environment variable or as a parameter in
the registry, and uses finance as the service name. If it exists, Net8 connects.

You can add the TNS_ADMIN parameter to change the directory name for
configuration files from the default location. For example, if you set TNS_ADMIN
to ORACLE_BASE\ORACLE_HOMEN\TEST\ADMIN, the configuration files are
used from ORACLE_BASE\ORACLE_HOME\TEST\ADMIN.

USE_SHARED_SOCKET

You can set the USE_SHARED_SOCKET parameter to TRUE to enable the use of
shared sockets. If this parameter is set to TRUE, the network listener passes the
socket descriptor for client connections to the database thread. As a result, the client
does not need to establish a new connection to the database thread and database
connection time improves. Also, all database connections share the port number
used by the network listener, which can be useful if you are setting up third-party
proxy servers.

This parameter only works in dedicated server mode in a TCP/IP environment. If
this parameter is set, you cannot use the 8.1.6 listener to spawn Oracle 7.x
databases. To spawn an Oracle 8.0.x database from an 8.1.6 listener with the shared
socket enabled, you must also set the variable USE_SHARED_SOCKET for the 8.0.x
Oracle home.
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Net8 Port Numbers

The following table describes the port numbers used by Net8.

Default

Port
Product Number How do | change the port number?
Listener 1521 Modify the LISTENER.ORA and

TNSNAMES.ORA files, using Net8
Assistant. These files are located in the
ORACLE_BASE\ORACLE_
HOME\NETWORK\ADMIN directory, or
in the directory specified by the TNS_
ADMIN environment variable or registry
value.
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Error Messages

This appendix lists the error messages, causes, and corrective actions that are
specific to the operation of Oracle8i Personal Edition for Windows 98. This
appendix also includes database connection issues.

Specific topics discussed are:
« Logging Error Messages
« Codes 04000-04999: Windows 98/NT-Specific Oracle Messages

« Database Connection Issues

Note: The ORA.HLP file, which was shipped in previous releases,
is no longer available. See this Appendix and Oracle8i Error
Messages for information on error messages.
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Logging Error Messages

Keep a log of error messages you receive by redirecting the messages to a file. You
can record the contents of normal utility messages by using the LOGFILE parameter
discussed in Oracle8i Utilities. You can separately record the error message portion
by using standard Windows 98 file redirection. For example, use the following
syntax to redirect the output from the Export Utility:

C\> BEXP USERVAME PASSWIRD PARF LE=F LENAME >H LEL. LGG 2>H LE2. BRR

In this command line, FILEL1.LOG receives the standard output from Export, while
FILE2.ERR receives the standard error messages.

Codes 04000-04999: Windows 98/NT-Specific Oracle Messages

The error messages in this section are Oracle operating system-dependent (OSD)
messages issued in response to an error condition in Windows 98/NT. Each
message in this section triggers an Oracle8i database error message.

« File 170 Errors: OSD-04000 to OSD-04099

« Memory Errors: OSD-04100 to OSD-04199

« Process Errors: OSD-04200 to OSD-04299

= Loader Errors: OSD-04300 to OSD-04399

« Semaphore Errors: OSD-04400 to OSD-04499

« Miscellaneous Errors: OSD-04500 to OSD-04599

Note: In the description of the error codes (in "cause" and "action")
you might observe the mention of "Windows NT" only. This should
be read as Windows NT/98 where applicable. There is no Windows
98 specific error messages which is not there for Windows NT.

File I/O Errors:

OSD-04000 to OSD-04099

4000
4001
4002

logical block size mismatch
invalid logical block size
unable to open file
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File I/O Errors: OSD-04000 to OSD-04099

4003 unable to read file header block

4004 invalid file header

4005 SetFilePointer() failure, unable to read from file
4006 ReadFile() failure, unable to read from file

4007 truncated read

4008 WriteFile() failure, unable to write to file

4009 truncated write

4010 <create> option specified, file already exists

4011 GetFileInformationByHandle() failure, unable to obtain file info
4012 file size mismatch

4013 unable to read line from file

4014 unable to close file

4015 An asynchronous 1/0 request returned an error
4016 Error queuing an asynchronous 170 request
4017 Unable to open the specified RAW device

4018 Unable to access the specified directory or device
4019 Unable to set file pointer

4020 Unable to set eof file marker

4021 Unable to read file

4022 Unable to write file

4023 SleepEx() failure, unable to Sleep

4024 Unable to delete file

4025 Invalid question asked

4026 Invalid parameter passed

Memory Errors: OSD-04100 to OSD-04199

4100 malloc() failure, unable to allocate memory

4101 invalid SGA: SGA not initialized

4102 Unable to open/create file for shared memory objec
4103 unable to attach to SGA: SGA does not exist
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Memory Errors: OSD-04100 to OSD-04199

4104 Unable to map shared memory (SGA) into the address space
4105 Shared memory (SGA) mapped to wrong address

4106 Unable to allocate memory with VirtualAlloc

4107 Unable to deallocate memory with VirtualFree

4108 Unable to protect memory with VirtualProtect

Process Errors: OSD-04200 to OSD-04299

4200 unable to begin another thread

4201 no pid structure supplied to spdcr()

4202 DosSetPriority() failure, unable to set process priority

4203 DosKillProcess() failure, unable to kill process

4204 invalid pid

4205 CreateProcess() failure, unable to spawn process

4207 invalid priority specified in CONFIG parameter ORACLE_PRIORITY
4208 OpenProcess() failure, unable to open process handle

4209 Incorrect or unknown backgound image name given to spdcr()
4210 Timeout waiting for thread semaphore

4211 Thread information not found

4212 Maximum number of ORACLE threads reached

4213 ORACLE thread unable to DuplicateHandle()

4214 ORACLE thread unable to CreateEvent()

4215 Bad function code supplied to ssthreadop

4216 Unable to find file handle for that thread

4217 Unable to retrieve system user name for current user

4218 Can not post thread

4219 Bad thread list semaphore

4221 Target thread is currently busy

4222 Unable to get the threads context

4223 Unable to set the threads context

4224 Unable to suspend the target thread
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Process Errors: OSD-04200 to OSD-04299

4225 Unable to resume the target thread

Loader Errors: OSD-04300 to OSD-04399

4300 unable to read complete record from data file

4301 record size too large

4302 invalid record type and/or load options

Semaphore Errors: OSD-03400 to OSD-03499

4400 unable to acquire internal semaphore for process

4401 WaitForSingleObject() failure, unable to obtain semaphore

Miscellaneous Errors: 0OSD-04500 to OSD-04599

4500 illegal option specified

4501 internal buffer overflow

4502 translations nested too deep

4503 text contains no translatable elements

4505 stdin not responding

4506 unable to spawn process via system()

4507 password for 'internal’ is incorrect

4508 no password given

4509 no password found

4510 operating system roles are not supported

4511 unable to get date and time from the operating system
4512 unable to translate the 'USERNAME’ config.ora variable on server
4513 ‘remote_os_authent’ init.ora variable not set to true
4514 The NT Group name is too long for internal buffer
4515 This command is not implemented at this time

File 1/0 Errors: OSD-04000 to OSD-04099

OSD-04000
Logical block size mismatch

Cause: The database block size specified in the initialization parameter file
does not match the block size of the actual database files.
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Action; Use matching logical block sizes.

OSD-04001
Invalid logical block size
Cause: The logical block size is not a multiple of 512 bytes, or it is too large.

Action: Change the value of DB_BLOCK_SIZE in the initialization parameter
file.

OSD-04002
Unable to open file
Cause: The specified path or file name is invalid, or the destination device is
full. This error can also be caused by insufficient Windows NT file handles.

Action: Make sure the path and file exist, and the device has free space. If this
fails, increase the number of Windows NT file handles.

OSD-04003
Unable to read file header block
Cause: The media has been damaged.

Action:; Recover the file if necessary, and verify that Windows NT is
functioning correctly.

OSD-04004
Invalid file header
Cause: The file is corrupted.

Action: Recover the file.

OSD-04005
SetFilePointer() failure, unable to read from file
Cause: There was an unexpected return from the Windows NT system service,
SetFilePointer().
Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04006
ReadFile() failure, unable to read from file

Cause: There was an unexpected return from the Windows NT system service,
ReadFile().
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Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04007
Truncated read

Cause: The system encountered an unexpected end-of-file, which is due to
damaged media.

Action: Verify that the file is not damaged.

OSD-04008
WriteFile() failure, unable to write to file

Cause: There was an unexpected return from the Windows NT system service,
WriteFile().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04009
Truncated write
Cause: The destination device is full or the media is damaged.

Action: Verify that the device has free space and the file is not damaged.

OSD-04010
<create> option specified, file already exists
Cause: The file you attempted to create already exists.

Action: Delete the existing file or use the REUSE option in the SQL statement.

OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info

Cause: There was an unexpected return from the Windows NT system service,
GetFileInformationByHandle().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04012
File size mismatch
Cause: The file to be re-used is either too large or too small.

Action: Specify the correct file size or delete the existing file.
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0OSD-04013
Unable to read line from file
Cause: This error is caused by an operating system error or by damaged media.

Action: Check the operating system error code (if available) and consult the
Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

0OSD-04014
Unable to close file
Cause: The media has been damaged.

Action: Recover the file, if necessary, and verify that Windows NT is
functioning correctly.

OSD-04015
Asynchronous 1/0 request returned an error
Cause: There was an unexpected return from the Windows NT system service.

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04016
Error queuing an asynchronous 1/O request
Cause: There was an unexpected return from the Windows NT system service.

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04017
Unable to open the specified RAW device
Cause: An invalid path or file name was specified or the device is full.

Action: Make sure the file exists and/or device is not full; verify that the
operating system is functioning correctly.

OSD-04018
Unable to access the specified directory or device
Cause: An invalid path name was specified.

Action: Make sure the directory or device exists and is accessible.
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OSD-04019
Unable to set file pointer
Cause: This error is caused by an operating system error or by damaged media.
Action: Check the operating system error code (if available) and consult the

Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

0OSD-04020
Unable to set eof file marker
Cause: This error is caused by an operating system error or by damaged media.
Action: Check the operating system error code (if available) and consult the

Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

OSD-04021
Unable to read file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check the operating system error code (if available) and consult the

Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

OSD-04022
Unable to write file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check the operating system error code (if available) and consult the

Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

OSD-04023
SleepEXx() failure, unable to Sleep
Cause: There was an unexpected return from the Windows NT system service.

Action: Check the operating system error code and consult the Windows NT
documentation.
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OSD-04024
Unable to delete file
Cause: This error is caused by an operating system error or by damaged media.

Action: Check the operating system error code (if available) and consult the
Windows NT documentation. If no operating system error code is presented,
verify that the media is not damaged.

0OSD-04025
Invalid question asked
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04026
Invalid parameter passed
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

Memory Errors: OSD-04100 to OSD-04199

OSD-04100
Malloc() failure, unable to allocate memory
Cause: The program is out of memory.
Action: Shut down all unnecessary processes or install more memory in the
computer.

OSD-04101
Invalid SGA: SGA not initialized
Cause: The System Global Area (SGA) has been allocated but not initialized.

Action: Wait until the STARTUP has completed before attempting to connect.

OSD-04102
Unable to open/create file for shared memory object
Cause: There was an unexpected return from the Windows NT system service,
CreateFile().
Action: Check the operating system error code and consult the Windows NT
documentation.
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0OSD-04103
Unable to attach to SGA: SGA does not exist
Cause: The SGA does not exist.

Action: Start up an Oracle instance.

OSD-04104
Unable to map shared memory (SGA) into the address space
Cause: There was an unexpected return from the Windows NT system service,
MapViewOfFileEx().
Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04105
Shared memory (SGA) mapped to wrong address
Cause: There was an unexpected return from the Windows NT system service,
MapViewOfFileEx().
Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04106
Unable to allocate memory with VirtualAlloc
Cause: The program is out of memory.

Action: Shut down all unnecessary processes or install more memory in the
computer.

OSD-04107
Unable to deallocate memory with VirtualFree
Cause: There was an unexpected return from the Windows NT system service,
VirtualFree().
Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04108
Unable to protect memory with VirtualProtect
Cause: There was an unexpected return from the Windows NT system service,
VirtualProtect().

Action: Check the operating system error code and consult the Windows NT
documentation.
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Process Errors: OSD-04200 to OSD-04299

OSD-04200
Unable to begin another thread
Cause: The program has run out of system resources.

Action: Shut down all unnecessary processes; install more memory in the
computer.

OSD-04201
No pid structure supplied to spdcr()
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04202
DosSetPriority() failure, unable to set process priority
Cause: There was an unexpected return from the Windows NT system service,
DosSetPriority().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04203
DosKillProcess() failure, unable to kill process

Cause: There was an unexpected return from the Windows NT system service,
DosKillProcess().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04204
Invalid pid
Cause: Process ID not recognized by system, process previously terminated.
Action: Verify that process ID is correct and that process is active.
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OSD-04205
CreateProcess() failure, unable to spawn process

Cause: There was an unexpected return from the Windows NT system service,
CreateProcess().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause: The priority specified is invalid or out of range.

Action: Specify a valid setting for ORACLE_PRIORITY.

OSD-04208
OpenProcess() failure, unable to open process handle

Cause: There was an unexpected return from the Windows NT system service,
OpenProcess().

Action: Check the operating system error code and consult the Windows NT
documentation.

OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause: There was an unexpected background name given to spdcr().

Action: Contact Oracle Support Services.

OSD-04210
Timeout waiting for thread semaphore
Cause: An Oracle8 database thread died holding the semaphore.

Action: Restart Oracle8 database instance.

OSD-04211
Thread information not found
Cause: An Oracle8 database thread died without deleting its information.

Action: Restart Oracle8 database instance.
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0OSD-04212
Maximum number of Oracle threads reached

Cause: The maximum number of Oracle8 database threads for the instance is
reached.

Action: Wait until some connections exit before trying again.

OSD-04213
Oracle thread unable to DuplicateHandle()
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04214
Oracle thread unable to CreateEvent()
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04215
Bad function code supplied to ssthreadop
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04216
Unable to find file handle for that thread
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04217
Unable to retrieve system username for current user
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

0OSD-04218
Cannot post thread
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.
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OSD-04219
Bad thread list semaphore

Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

0OSD-04221
Target thread is currently busy

Cause: The target thread is processing an oradebug command.

Action: Wait and re-issue command.

OSD-04222
Unable to get the threads context
Cause: Check OS error code.

Action: Remedy OS error.

0OSD-04223
Unable to set the threads context
Cause: Check OS error code.

Action: Remedy OS error.

OSD-04224
Unable to suspend the target thread
Cause: Check OS error code.

Action: Remedy OS error.

OSD-04225
Unable to resume the target thread
Cause: Check OS error code.

Action: Remedy OS error.
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Loader Errors: OSD-04300 to OSD-04399

OSD-04300
Unable to read complete record from data file
Cause: The data file ended in the middle of a record. This error occurs when
loading files with a fixed record length.

Action: Verify that the data file is of the correct length and contains complete
records.

OSD-04301
Record size too large
Cause: The specified record size is too large to load.

Action: Reduce record size and reload the data.

OSD-04302
Invalid record type and/or load options
Cause: The control file’s Windows NT file processing options string contains an
invalid option or keyword.

Action: Set the Windows NT file processing options string to an acceptable
value.

Semaphore Errors: OSD-04400 to OSD-04499

0OSD-04400
Unable to acquire internal semaphore for process
Cause: Oracle8 database has exceeded the maximum number of connections.

Action: Delete any unused connections and try again.

OSD-04401
WaitForSingleObject() failure, unable to obtain semaphorex
Cause: There was an unexpected return from the Windows NT system service,
WaitForSingleObject().

Action: Check the operating system error code and consult the Windows NT
documentation.
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Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500
Illegal option specified
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04501
Internal buffer overflow
Cause: This is an internal error, not normally expected to occur.

Action: Contact Oracle Support Services.

OSD-04502
Translations nested too deep

Cause: The program encountered too many intermediate translations while
attempting to translate a configuration variable.

Action: Simplify the values of configuration parameters to include fewer
intermediate translations.

OSD-04503
Text contains no translatable elementsx
Cause: The program cannot recognize variables in the text to be translated.

Action: Check and, if necessary, correct the text to be translated.

OSD-04505
Stdin not responding
Cause: The system is unable to receive input from the standard input stream.

Action: Verify that the process has access to an input device.

OSD-04506
Unable to spawn process via system()
Cause: The system is out of memory or the executable is invalid.

Action: Shut down unnecessary processes; install more memory in the
computer. Verify the name of the executable.
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OSD-04507
Password for *internal’ is incorrect
Cause: An attempt was made to connect as ’internal’ with an invalid password.

Action: Verify that the password is correct and try again.

OSD-04508
No password given
Cause: An attempt was made to connect as ‘internal’ without a password.

Action: Enter a valid password when connecting as internal.

OSD-04509
No password found
Cause: Oracle was unable to locate and retrieve the password for ’internal’.

Action: Verify that Oracle is installed and configured correctly.

OSD-04510
Operating system roles are not supported
Cause: An attempt was made to use an operating system role.

Action: Only use roles that were created 'IDENTIFIED BY PASSWORD’ as
opposed to 'IDENTIFIED EXTERNALLY".

OSD-04511
Unable to get date and time from the operating system
Cause: There was an unexpected return from GetLocalTime() call.

Action: Verify that the system time is correct on the computer.

OSD-04512
Unable to translate the "'USERNAME’ configuration variable on server
Cause: The 'USERNAME’ configuration parameter variable on the host is not
properly set.

Action: Verify the 'USERNAME’ variable is set.

OSD-04513
"REMOTE_OS_AUTHENT’ variable not set to TRUE’
Cause: For remote operating system log on to function, the ' REMOTE_OS _
AUTHENT’ parameter must be set to TRUE.

Action: Shut down and start up the instance with 'REMOTE_OS_AUTHENT =
TRUE’ in the initialization parameter file.
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0OSD-04514

The Windows NT Group name is too long for internal buffer
Cause: The Windows NT Group name is too long.

Action: Use a shorter Windows NT group name.

Database Connection Issues

This table lists and provides answers to common Oracle8i database connection

issues:

If You Receive This Error...

Ensure Your...

TNS- 12203 TNS: unable to connect to
destination

Oracle Instance and OracleHome_

NameTNSListener! are started. See the
Net8 Administrator’s Guide.

ORA- 12547 TNS: | ost contact

Oracle Instance and OracleHome_
NameTNSListener! are started. You receive this
error if you attempt to use any of the Oracle8i
Utilities, such as SQL*Plus.

Note: This error is analogous to the following
Oracle7 error:

ORA- 09352: W ndows 32-bit Two- Task
driver unable to spawn new ORACLE
task

ORA- 28575: unabl e to open RPC connection to
external procedure agent

ORA- 06512: at "APPLI CATI ONS. OSEXEC', line 0O
ORA- 06512: at "APPLI CATI ONS. TEST", line 4
ORA-06512: at line 2

TNSNAMES.ORA and LISTENER.ORA files
have been correctly configured to use external
routines. See Chapter 8 of Net8 Administrator’s
Guide.

1 Ensure that OracleHOME_NAMETNSListener is started if you are using an Oracle8i database that has a home name.
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alert file

A file that contains important information and error messages that are generated
during database operations.

authenticate

To verify the identity of a user, device, or other entity in a computer system, often as
a prerequisite for allowing access to resources in a system.

authorization

Permission given to a user, program, or process to access an Oracle database or
operating system.

backup

A representative copy of data. This copy includes important parts of your database
such as the control file, redo log files, and data files.

A backup is a safeguard against unexpected data loss; if you lose your original data,
you can use the backup to make the data available again. A backup is also a
safeguard against an application error; if an application makes incorrect changes,
you can restore the backup.

connect string
See "net service name".
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control file

A file that records the physical structure of a database and contains the database
name, the names and locations of associated databases and online redo log files, the
timestamp of the database creation, the current log sequence number, and
checkpoint information.

data dictionary

A set of read-only tables that provide information about a database.

database alias
See "net service name".

downgrade

To transform an installed version of an Oracle database from a later release back
into an earlier release.

Dynamic Link Library (DLL)

An executable file that a Windows application can load when needed.

external routine

A function written in a third-generation language (3GL), such as C, and callable
from within PL/SQL or SQL as if it were a PL/SQL function or procedure.
HOMEID

Represents a unique registry subkey for each Oracle home directory in which you
install products. A new HOMEID is created and incremented each time you install
products to a different Oracle home directory on one computer. Each HOMEID
contains its own configuration parameter settings for installed Oracle products.

HOME_NAME
Represents the name of an ORACLE_HOME. In Release 8.1.6, all Oracle homes have
a unique HOME_NAME.

initialization parameter file

An ASCII text file that contains information needed to initialize a database and
instance.



instance

Every running Oracle database is associated with an Oracle instance. When a
database is started on a database server (regardless of the type of computer), Oracle
allocates a memory area called the System Global Area (SGA) and starts one or
more Oracle processes. This combination of the SGA and the Oracle processes is
called an instance. The memory and processes of an instance manage the associated
database’s data efficiently and serve the one or more users of the database.

instantiate, instantiation

Producing a more defined version of some object by replacing variables with values
(or other variables).

In object-oriented programming, producing a particular object from its class
template. This involves allocation of a structure with the types specified by the
template, and initialization of instance variables with either default values or those
provided by the constructor function of the class.

listener

The server process that listens for and accepts incoming connection requests from
client applications. Oracle listener processes start up Oracle database processes to
handle subsequent communications with the client.

LISTENER.ORA

A configuration file that describes one or more Transparent Network Substrate
(TNS) listeners on a server.

migrate

To transform an installed version of an Oracle database from a major release to
another major release, for example, from Oracle8 to Oracle8i.

mount
To associate a database with an instance that has been started.

multiple Oracle homes
The capability of having more than one ORACLE_HOME on a computer.

National Language Support (NLS)

The Oracle architecture that ensures that database utilities, error messages, sort
order, date, time, monetary, numeric, and calendar conventions automatically adapt
to the native language and locale.
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net service name

The name used by clients to identify a Net8 server. A net service name is mapped to
a port number and protocol. Also known as a connect string, database alias, or
service name.

Net8

The Oracle network interface that enables Oracle tools running on network
workstations and servers to access, modify, share, and store data on other servers.
network listener

A listener on a server that listens for connection requests for one or more databases
on one or more protocols. See "listener".

network service

In an Oracle application network, a service performs tasks for its service consumers.
For example, a Names Server provides name resolution services for clients.

NLS

See "National Language Support (NLS)".

Optimal Flexible Architecture (OFA)
A set of file naming and placement guidelines for Oracle software and databases.

Oracle Call Interface (OCI)

An application programming interface that enables you to manipulate data and
schemas in an Oracle database. You compile and link an Oracle Call Interface
program in the same way that you compile and link a non-database application.
There is no need for a separate preprocessing or precompilation step.

ORACLE_HOME

Corresponds to the environment in which Oracle products run. This environment
includes the location of installed product files, the PATH variable pointing to the
products’ binary files, registry entries, net service names, and program groups.

If you install an OFA-compliant database, using Oracle Universal Installer defaults,
Oracle home (known as \ORACLE_HOME in this guide) is located beneath
X:\ORACLE_BASE. It contains subdirectories for Oracle software executables and
network files.



Oracle JServer

Oracle8i Personal Edition includes Oracle JServer, the integrated Java Virtual
Machine. Oracle JServer provides Java2 support (JDK1.2), an embedded JDBC
driver and a SQLJ translator.

Oracle Protocol Support

A product that maps the functions of a given network protocol into Oracle
Transparent Network Substrate (TNS) architecture. This process translates TNS
function calls into requests to the underlying network protocol. This allows TNS to
act as an interface among all protocols. Net8 requires Oracle protocol support.

ORACLE_BASE

Oracle base, known as ORACLE_BASE in this guide, is the root of the Oracle
directory tree.

If you install an OFA-compliant database using Oracle Universal Installer defaults,
ORACLE_BASE is X:\ORACLE where X is any hard drive (for example,
C:\ORACLE).

PL/SQL
Oracle Corporation’s procedural language extension to SQL.

PL/SQL enables you to mix SQL statements with procedural constructs. You can
define and execute PL/SQL program units such as procedures, functions, and
packages.

precompiler

A programming tool that enables you to embed SQL statements in a high-level
source program.

privilege

A right to execute a particular type of SQL statement or to access another user’s
object.

process

A mechanism in an operating system that can run an executable. (Some operating
systems use the terms job or task.) A process normally has its own private memory
area in which it runs.
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quota

A limit on a resource, such as a limit on the amount of database storage used by a
database user. A database administrator can set tablespace quotas for each Oracle
user name.

recovery

To restore a physical backup is to reconstruct it and make it available to the Oracle
server. To recover a restored backup is to update it using redo records (that is,
records of changes made to the database after the backup was taken). Recovering a
backup involves two distinct operations: rolling forward the backup to a more
current time by applying redo data, and rolling back all changes made in
uncommitted transactions to their original state.

redo log file

A file that contains a record of all changes made to data in the database buffer
cache. If an instance failure occurs, the redo log files are used to recover the
modified data that was in memory.

redo log buffer

A circular buffer in the System Global Area (SGA) that contains information about
changes made to the database.

registry
A Windows repository that stores configuration information for a computer.

remote computer
A computer on a network other than the local computer.

remote database
A database on a computer other than the local database.

replication

The process of copying and maintaining database objects in multiple databases that
make up a distributed database system.

role
A named group of related privileges. You can grant a role to users or other roles.



schema

A named collection of objects, such as tables, views, clusters, procedures, and
packages, associated with a particular user.

service name

See "net service name".

SID
See "system identifier (SID)".

snapshot

(1) Information stored in rollback segments to provide transaction recovery and
read consistency. Rollback segment information can be used to recreate a snapshot
of a row before an update.

(2) A read-only copy of a master table located on a remote node. Snapshots can be
queried, but not updated; only the master table can be updated. Snapshots are
periodically refreshed to reflect changes made to the master table.

starter database

A preconfigured, ready-to-use database that requires minimal user input to create.

synonym
An alias for a table, view, sequence, or program unit. A synonym is not actually an
object itself; rather, it is a direct reference to its base object.

SYSDBA

A special database administration role that contains all system privileges with the
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits
CREATE DATABASE actions and time-based recovery.

SYSOPER

A special database administration role that permits a database administrator to
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER
DATABASE BACKUP, ARCHIVE LOG, and RECOVER, and includes the
RESTRICTED SESSION privilege.
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System Global Area (SGA)

A group of shared memory structures that contain data and control information for
an Oracle instance.

system identifier (SID)

A unique name for an Oracle instance. To switch between Oracle databases, users
must specify the desired SID. The SID is included in the CONNECT DATA parts of
the connect descriptors in a TNSNAMES.ORA file, and in the definition of the
network listener in a LISTENER.ORA file.

SYSTEM user name

One of two standard DBA user names automatically created with each database.
(The other user name is SYS.) SYSTEM is created with an initial password of
MANAGER. The SYSTEM user name is the preferred user name for DBAs to use for
database maintenance.

tablespace

A database is divided into one or more logical storage units called tablespaces.
Tablespaces are divided into logical units of storage called segments, which are
further divided into extents.

thread

An individual path of execution within a process. Threads are objects within a
process that execute program instructions.

TNSNAMES.ORA

A file that contains connect descriptors mapped to net service names. The file may
be maintained centrally or locally, for use by all or individual clients.

trace file

Each server and background process can write to an associated trace file. When a
process detects an internal error, it dumps information about the error to its trace
file. Some of the information written to a trace file is intended for the database
administrator, while other information is intended for Oracle Support Services.
Trace file information is also used to tune applications and instances.

upgrade

To transform an installed version of an Oracle database major release into another
major release of the same version. Compare with "migrate”.



user name
A name that can connect to and access objects in a database.

view
A selective presentation of the structure of, and data in, one or more tables (or other
views).
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Symbols

" SQL*Loader parameter, 2-10

"FIX n", SQL*Loader parameter, 2-10
"RECSIZE", SQL*Loader parameter, 2-10
"VAR xxxx", SQL*Loader parameter, 2-11

Numerics

1521 port, D-5
1526 port, D-5

A

ADMIN directory, explained, 3-20
alert files, 8-2
for monitoring a database, 8-2
using, 8-2
alias, creating, 5-3
ALL_HOMES, registry subkey for multiple Oracle
homes, C-6
ALTER DATABASE ARCHIVELOG command, 7-
11
ALTER DATABASE CONVERT command, 4-27
ALTER DATABASE OPEN RESETLOGS
command, 4-28
application development
finding information, 10-2
ARCHIVE LOG LIST command, 7-11
ARCHIVELOG mode, 7-11
archiving mode
custom database, 7-10
starter database, 7-10
archiving procedures, 7-12

Index

for redo log files, 7-10

specifying an archive destination, 7-12
AUDIT_FILE_DEST parameter, B-4
authentication

using a password file, 7-5
automatic startup/shutdown

on Windows 98, NT and UNIX, 1-7

B

BACKGROUND_DUMP_DEST parameter, 6-12
using with trace files, 8-2
backslash (\), defined, xxv
backup
databases, 6-20
OCOPY file types, 9-3
stopping services to perform cold backups, 9-2
backup and recovery tools
OCOPY, 09-2
Recovery Manager (RMAN.EXE), 9-2
selecting, 9-2
third-party backup and recovery vendors, 9-2
block size, maximum, B-5
blocks per file, maximum, B-5
BUILD_DB.SQL script, 6-6, 6-13
location of, 6-3
BUILDALL.SQL script, 6-13

C

C:\>, defined, xxv

C:\ORACLE, defined, 3-16
C:\ORAWINB95, defined, xxvi, 3-16
CAT8004.SQL, 4-32
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CATALOG.SQL script, 4-37, 6-17

location of, A-5
CATEXP.SQL script

location of, A-5
CATOUT.LOG file, 4-28
CATPROC.SQL script, 4-37,6-17

location of, A-5
changing passwords, 5-2
Choose Start >, defined, xxv
code conventions, used in this guide, xxv
cold backups, performing, 9-2
COMPATIBLE parameter, 4-27, 4-34, 4-39
COMPATIBLE_NO_RECOVERY parameter, B-4
configuration parameters

defined, C-2
LOCAL, D-3
registry, C-1

TNS_ADMIN, D-4
USE_SHARED_SOCKET, D-4
CONNECT INTERNAL, 7-8
changing the INTERNAL password, 7-8
password, 7-8
using, 7-2,7-8,7-10
connect string, 5-3
connecting
LOCAL parameter, D-4
Oracle8 Client Release 8.0/0racle7 Client to
Oracle8i Database Release 8.1, 4-7
Oracle8i Client Release 8.0/SQL*Net to Oracle8i
database Release 8.1, 4-7
Oracle8i Client Release 8.1 to Oracle Database
Version 7 and Release 8.0, 4-9
to a database, 7-2,7-10
connectingOracle8i Client Release 8.1 to Oracle8i da-
tabase Release 8.1, 4-7
contacting
Oracle Support Services, Xi
Oracle Technical Publications, xi
CONTROL_FILES parameter, 4-25,6-12
copy modes, for OCOPY, 9-3
CORE_DUMP_DEST parameter, B-4
CPU_COUNT parameter, B-4
CREATE DATABASE command, 6-13
CREATE LIBRARY command, 10-8
creating

database connections, 5-3
custom database
archiving mode, 7-10

D

database backup and recovery tools
OCOPY, 9-2
Recovery Manager (RMAN), 9-2
third-party vendors, 9-2
database coexistence
issues, 4-6
overview, 4-3
database files
deleting, 6-9
database monitoring
with alert files, 8-2
with trace files, 8-2
database release coexistence issues, 4-7
database tools
operating system support, 2-2
starting, 2-5
databases
backing up, 6-20
BUILD_DB.SQL script, 6-6
BUILDALL.SQL, 6-13
changing passwords, 6-18
coexistence, 4-3
connecting to, 7-2,7-10
connections, creating, 5-3
deleting, 6-9
exporting, 6-8
file names, 3-16
importing, 6-18
installation in multiple homes, 4-11
maximum size possible, B-6
migration, 4-4,4-11
monitoring, 8-1, 8-2
multi-versioning, 4-10
naming conventions, 6-2
Optimal Flexible Architecture, 3-22, 3-23, 3-24
Oracle Database Configuration Assistant, 6-3
password encryption, 7-9
shutting down, 7-2,7-3
starting, 7-2
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upgrading, 4-4,4-11,4-30

what to do with existing databases, 4-2
DB_FILES parameter, 6-12
DB_NAME directory, explained, 3-21
DB_NAME parameter, 6-11
DB_WRITER_PROCESSES parameter, B-4
DBLINK_ENCRYPT_LOGIN parameter, 7-9
DBVERIFY

operating system compatibility, 2-3

starting, 2-7
DEFAULT_HOME parameter, C-7
deleting

password file, 7-8
developing applications

for Windows 98, 10-2
differences

between Windows 98, NT and UNIX, 1-2
direct writes to disk

on Windows 98, NT and UNIX, 1-4
directory names, convention used, Xxxv
directory structures

OFA-compliant directory tree, 3-18

Oracle8i Personal Edition, A-2
DISK_ASYNCH_IO parameter, 4-26
DLLs

differences on Windows 98, NT and UNIX, 1-5

external routines, 10-7
documentation conventions, used in this

guide, xxv

E

encrypting, database passwords, 7-9
environment variables
ORACLE_HOME, 3-11
TNS_ADMIN, 3-13
error messages
Intercartridge Exchange, 10-15
logging, E-2
ORA-01102, 6-2
ORA-12547, E-19
OSD-04000 to OSD-04099, E-5
OSD-04100 to OSD-04199, E-10
OSD-04200 to OSD-04299, E-12
OSD-04300 to OSD-04399, E-16

OSD-04400 to OSD-04499, E-16
OSD-04500 to OSD-04599, E-17
exception conditions, Intercartridge Exchange, 10-
14
EXECUTE privileges, on a PL/SQL library, 10-8
existing databases, installation types, 4-2
Export Utility
databases, 6-8
interactive mode, 6-8
operating system compatibility, 2-3
parameter mode, 6-8
redirecting output, E-2
starting, 2-8
extents
maximum number per database, B-6
EXTERNAL clause, 10-8
external routines
buildinga DLL, 10-7
creating a PL/SQL library, 10-8
EXTERNAL clause, 10-8
granting EXECUTE privileges, 10-8
registering with Oracle database, 10-7
using EXTPROC, 10-6
writing, 10-6
EXTPROC
responsibilities, 10-6

F

file names
convention used, xxv
file sizes
maximum possible, B-5
on Windows 98, NT and UNIX, 1-3
files
alert, 8-2
database file names, 3-16
LISTENER.ORA, 10-5
maximum number per database, B-5
maximum size possible, B-5
ORACLE.KEY, 3-11
sample INIT.ORA, B-3
trace, 8-2
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G

generic documentation references

calculating index size, B-5

CREATE DATABASE, 6-13

custom database archiving mode, 7-10

earliest releases that can be migrated, 4-5

install test databases in a separate Oracle
home, 3-3

location of initialization parameter file, B-2

LOG parameter use, E-2

maximum number of data files, 6-12

multi-versioning, 4-10

name and location of convert file, 4-27

PL/SQL sample programs, location of, A-5

running CATPROC.SQL, 6-17

starter database archiving mode, 7-10

Windows 98/NT-specific error messages, E-2

Windows 98-specific archiving procedures, 7-12

Windows 98-specific control file
specifications, 6-10

Windows 98-specific database creation
procedures, 6-3

Windows 98-specific database migration
instructions, 4-12

Windows 98-specific initialization parameter
file, B-2

Windows 98-specific instance startup file
names, 7-2

Windows 98-specific location of SQL scripts, A-
5

Windows 98-specific migration instructions, 5-1

Windows 98-specific parameter file name and

location, B-2
Windows 98-specific password file name and
location, 7-5

Windows 98-specific trace file names, 8-2
Windows 98-specific upgrading instructions, 5-
1

H

HI_SHARED_MEMORY_ADDRESS parameter, B-
4
HOME_COUNTER parameter, C-7

HOMEID, defined, xxvii
host string, 5-3

ICX. See Intercartridge Exchange
Import Utility
databases, 6-18
interactive mode, 6-18
operating system compatibility, 2-3
parameter mode, 6-18
starting, 2-8
index size, calculating, B-5
initialization parameter file

defined, B-2
editing, B-2
location, B-2

modifying, 6-10
using PFILE option for database startup, 7-2
using the default file for database startup, 7-2
initialization parameters
COMPATIBLE_NO_RECOVERY, B-4
CORE_DUMP_DEST, B-4
CPU_COUNT, B-4
DB_WRITER_PROCESSES, B-4
HI_SHARED_MEMORY_ADDRESS, B-4
LARGE_POOL_SIZE, B-4
LOG_BUFFER, B-4
on Windows 98, NT and UNIX, 1-4
ORACLE_TRACE_COLLECTION_PATH, B-4
ORACLE_TRACE_FACILITY_NAME, B-4
ORACLE_TRACE_FACILITY_PATH, B-4
SHARED_MEMORY_ADDRESS, B-4
INITSID.ORA file
CONTROL_FILES parameter, 4-25
INST_LOC parameter, C-6
install accounts
on Windows 98, NT and UNIX, 1-4
installation
differences on Windows 98, NT and UNIX, 1-5
INSTANCE_NAME parameter, 6-11
instances
running multiple instances, 7-4
interactive mode
Export Utility, 6-8
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Import Utility, 6-18

Intercartridge Exchange
accessing Web data, 10-10
configuring, 10-11
error messages, 10-15
exception conditions, 10-14
packaged functions, 10-12
stored packages, 10-12
troubleshooting, 10-17
using, 10-11

INTERNAL
changing the INTERNAL password, 7-8
connecting as, 7-8
password, 7-8

italic letters, defined, xxv

L

LARGE_POOL_SIZE parameter, B-4
LAST_HOME parameter, C-7
listener

1521 port, D-5

1526 port, D-5
LOCAL parameter, D-3
LOG parameter

use of, E-2
LOG_ARCHIVE_DEST_n parameter, 7-12
LOG_ARCHIVE_FORMAT parameter, 7-12
LOG_ARCHIVE_START parameter, 7-12
LOG_BUFFER parameter, B-4
logging error messages, E-2

M

memory resources
on Windows 98, NT and UNIX, 1-4
migrating
creating PO8 user account, 5-2
DISK_ASYNCH_IO parameter for Windows

98, 4-26
Windows 98, editing INITSID.ORA file, 4-25
migration

instructions, 4-16
multiple Oracle homes, 4-4
Optimal Flexible Architecture, 4-41

overview, 4-4

SQL*Net, 4-14,4-41

U0703040.SQL script, 4-28

using appropriate tool versions, 4-18
Migration Utility

operating system compatibility, 2-3

starting, 2-8

using, 4-16
MIGSID.ORA file, 4-24, 4-27
monitoring

alert files, 8-2

databases, 8-1

trace files, 8-2
MSHELP_TOOLS parameter, C-4
multiple instances, running, 7-4
multiple Oracle home products, 3-7
multiple Oracle homes

ALL_HOMES registry subkey, C-6

before Release 8.0.4, 3-3

benefits, 3-3

classification of products, 3-6

defined, xxvi

environment, 3-5

for Releases 8.0.4t0 8.0.5, 3-3

for Releases 8.1.3and 8.1.4, 3-3

functionality in different releases, 3-3

introduction, 3-2

migration, 4-4

on Windows 98, NT and UNIX, 1-6

overview, 3-2

program groups, 3-5, 3-6

registry entries, 3-5, 3-6

system identifier, 3-5, 3-6

upgrading, 4-4

use of one listener for spawning, 3-4
multi-versioning, 4-10

N
NAME parameter, C-7
Navigator

POS8 user account, 5-2
Net8

configuring for external routines, 10-5
unsupported features, D-2
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Net8 Assistant
operating system compatibility, 2-3
starting, 2-7
Net8 Configuration Assistant
operating system compatibility, 2-3
starting, 2-7
Net8 Easy Config, using, 5-3
NET8 parameter, D-2
NLS_LANG environment variable, 4-18
NLS_LANG parameter, C-5
NOARCHIVELOG mode, 7-11
non-multiple Oracle home products, 3-7
non-Oracle home products, 3-7

O

OCOPY
backup file types, 9-3
capabilities, 9-2
copy modes, 9-3
operating system compatibility, 2-3
recovery file types, 9-5
starting, 2-8
syntax for backing up files, 9-4
syntax for recovering files, 9-5
0040 parameter, C-6
Optimal Flexible Architecture
benefits, 3-14
characteristics of a database, 3-15
default OFA database, 3-22
differences since previous releases, 3-16
introduction, 3-2
moving database files, 4-41
non-default OFA database 1, 3-23
non-default OFA database 2, 3-24
OFA-compliant directory tree, 3-18
overview, 3-13
ORA_CWD parameter, C-5
ORA_ENCRYPT_LOGIN parameter, 7-9
ORA_SID_PFILE parameter, C-5
ORA-12547 error, E-19
Oracle Data Migration Assistant
starting, 2-7
using, 4-15,4-31
Oracle Database Configuration Assistant

deleting databases, 6-6
starting, 2-7
Oracle home
new-style, defined, 3-13
old-style, defined, 3-7
Oracle Home Selector
changing PATH value, 3-9
Oracle Objects for OLE
single Oracle home product, 3-7
Oracle Open Database Connectivity Driver
single Oracle home product, 3-7
Oracle Services
shutting down a database by stopping a
service, 7-3
Oracle SQLJ Translator
directory structure, A-6
ORACLE.KEY file, 3-11
ORACLE_BASE
changing the value, 3-19
explained, xxvi, 3-16, 3-19
ORACLE_BASE parameter, C-5
ORACLE_GROUP_NAME parameter, C-5
ORACLE_HOME
directory structure, A-2
explained, xxvi
ORACLE_HOME directory
explained, 3-20
specifying, 3-22
ORACLE_HOME environment variable
consequences of setting, 3-12
how itisset, 3-11
ORACLE_HOME parameter, C-5
ORACLE_HOME_KEY parameter, C-5
ORACLE_HOME_NAME parameter, C-5
ORACLE_SID parameter, 6-19, 7-4, C-6
ORACLE_TRACE_COLLECTION_PATH
parameter, B-4
ORACLE_TRACE_FACILITY_NAME
parameter, B-4
ORACLE_TRACE_FACILITY_PATH
parameter, B-4
Oracle7 database, migrating, 4-12
Oracle8i database
connecting to, 7-2,7-10
password encryption, 7-9
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selecting a backup and recovery tool, 9-2
shutting down, 7-2,7-3
specifications, B-5
starting, 7-2
using User Manager, 2-13
Oracle8i database backup and recovery tools
OCOPY, 09-2
Recovery Manager (RMAN.EXE), 9-2
third-party vendors, 9-2
Oracle8i Navigator
changing passwords, 5-2
PO8 user account, 5-2
Oracle8i Personal Edition
directory structure, A-2
ORADATA directory, explained, 3-21
ORADEBUG
debugging utility, 7-13
starting, 7-13
ORADIM
changing the INTERNAL password, 7-8
ORAPWD
creating password files, 7-5
operating system compatibility, 2-3
starting, 2-9
OSD-04000 to OSD-04099 error codes, E-5

OSD-04100 to OSD-04199 error codes, E-10, E-12

OSD-04300 to OSD-04399 error codes, E-16
OSD-04400 to OSD-04499 error codes, E-16
0OSD-04500 to OSD-04599 error codes, E-17

P

packaged functions
Intercartridge Exchange, 10-12
UTL_HTTP.REQUEST, 10-13
UTL_HTTP.REQUEST_PIECES, 10-13
parameter mode
Export Utility, 6-8
Import Utility, 6-18
parameters
DISK_ASYNCH_IO for Windows 98, 4-26
PARFILE, using, E-2
password
changing user account passwords, 5-2
password file

authenticating database administrators,
connecting as INTERNAL, 7-8

creating, 7-5
deleting, 7-8
hiding, 7-5
viewing, 7-7
passwords

changing for SYS user name, 7-9
changing for SYSTEM user name, 7-9
changing the INTERNAL password, 7-8
encryption, 7-9
for databases, 6-18
for INTERNAL user name, 7-8
PATH parameter, C-7
PATH, changing the value of, 3-8
performance utilities
on Windows 98, NT and UNIX, 1-7
PFILE option, 7-2
PL/SQL
sample programs, location of, A-5
PO8 user, 4-42,5-2

7-5

PRAGMA RESTRICT_REFERENCES, with Intercar-

tridge Exchange, 10-14

Pre-SPAWNED dedicated server processes

Net8 unsupported feature, D-2
processes

on Windows 98, NT and UNIX, 1-3
products

multiple Oracle home products, 3-7

non-multiple Oracle home products, 3-7

single Oracle home products, 3-7

supporting multiple Oracle homes, 3-7
program groups

multiple Oracle homes, 3-5, 3-6
PWDSID.ORA file, 7-5

R

raw partition

on Windows 98, NT and UNIX, 1-9
RDBMS_ARCHIVE parameter, C-6
RDBMS_CONTROL parameter, C-6
recovering, an Oracle8i database, 9-2
recovery file types, OCOPY, 9-5
Recovery Manager
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capabilities, 9-2
operating system compatibility, 2-3
overview, 9-2
starting, 2-9
redo log files
archiving, 7-10
REGEDIT command, 6-19
registering, an external routine, 10-7
registry
adding parameters, C-9
ALL_HOMES subkey, C-6
configuration parameters, C-1
DEFAULT_HOME, C-7
HOME_COUNTER, C-7
INST_LOC, C-6
keys, C-2
LAST_HOME, C-7
modifying values, C-8
MSHELP_TOOLS, C-4
NAME, C-7
NET8 parameter, D-2
NLS_LANG, C-5
0040, C-6
ORA_CWD, C-5
ORA_SID_PFILE, C-5
ORACLE_BASE, C-5
ORACLE_GROUP_NAME, C-5
ORACLE_HOME, C-5
ORACLE_HOME_KEY, C-5
ORACLE_HOME_NAME, C-5
ORACLE_SID, C-6
parameter values, C-2
PATH, C-7
RDBMS_ARCHIVE, C-6
RDBMS_CONTROL, C-6
REGEDIT, C-8
starting, 2-10
update ORACLE_SID, 6-19
Registry Editor, C-2
registry entries
multiple Oracle homes, 3-5, 3-6
remote database, creating alias to, 5-3
REMOTE_LOGIN_PASSWORDFILE parameter, 7-
5,7-8
resources, Xi

S

scripts
location of, A-5

Server Manager
running multiple instances, 7-4
shutting down the database, 7-2
starting, 7-2
starting the database, 7-2
using appropriate version, 4-18
using ORADEBUG, 7-13

service
how to start and stop, D-5
listed, D-5

service name, creating, 5-3
SERVICE_NAME parameter, 6-11
services

on Windows 98, NT and daemons on UNIX, 1-2

shutting down a database by stopping a

service, 7-3

starting, 6-12
SET ORACLE_SID=SID, 7-4
shadow process memory, B-6
SHARED_MEMORY_ADDRESS parameter, B-4
SHUTDOWN command

options, 7-2

using, 7-2
shutting down

databases, 7-2,7-3
single Oracle home products, 3-7
SPAWN

Net8 unsupported feature, D-2
specifying an archiving file format, 7-12
SQL scripts

location of, A-5
SQL*DBA, using appropriate version, 4-18
SQL*Loader

control file conventions, 2-11

direct path option, 2-11

operating system compatibility, 2-3

starting, 2-9

using, 2-10
SQL*Net

appropriate versions, 4-14, 4-41
SQL*Plus
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operating system compatibility, 2-3
starting, 2-9
square brackets, defined, xxv
starter database
archiving mode, 7-10
starting
databases, 7-2
Server Manager, 7-2
STARTUP command, 7-2
stored packages, Intercartridge Exchange, 10-12
SVRMGR versions, 4-18
symbols, list of, xxvii
syntax
for backing up files with OCOPY, 9-4
for recovering files with OCOPY, 9-5
SYS user name
changing the password, 7-9
system identifier
multiple Oracle homes, 3-5, 3-6
SYSTEM user name
changing the password, 7-9

T

third party applications, 4-8
third-party backup and recovery vendors, 9-2
threads

on Windows 98, NT and UNIX, 1-3
TKPROF

operating system compatibility, 2-3

starting, 2-9
TNS_ADMIN parameter, D-4

setting in the environment, 3-13
TNSNAMES.ORA file, 10-5
top-level directory, explained, 3-16
trace files, 8-2

creating with ORADEBUG, 7-13

for monitoring a database, 8-2

using, 8-2

using BACKGROUND_DUMP_DEST

parameter, 8-2

using USER_DUMP_DEST, 8-2
TRCROUTE

Net8 unsupported feature, D-2
troubleshooting

Intercartridge Exchange, 10-17
ORA-12547 error, E-19
ORA-28575 error, E-19
TNS-12203 error, E-19

with ORADEBUG, 7-13

U

U0703040.SQL script, 4-28
U0800040.SQL script, 4-37
UNIX

differences between UNIX and Windows 98,

NT, 1-2

unsupported features

Net8, D-2
upgrading

multiple Oracle homes, 4-4

Optimal Flexible Architecture, 4-41

overview, 4-4

tools, 4-30

U0800040.SQL script, 4-37
USE_SHARED_SOCKET parameter, D-4
User Manager

defined, 2-13

integration with Oracle8i database, 2-13
user names

changing passwords, 5-2

creating PO8, 5-2
USER_DUMP_DEST parameter, 6-12, 8-2
UTL_HTTP.REQUEST, Intercartridge

Exchange, 10-13
UTL_HTTP.REQUEST_PIECES, Intercartridge
Exchange, 10-13

UTLXPLAN.SQL script

location of, A-5

Vv

variables, convention used, xxv
viewing
password file, 7-7

\W

Web data, Intercartridge Exchange, 10-10
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Windows 98
directory structure for database, A-2
tools, 2-3

Windows 98 tools
operating system compatibility, 2-3

X

XAVIEW.SQL script
location of, A-5
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